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The Electronic Frontier Foundation is the leading nonprofit
organization defending civil liberties in the digital world.
Founded in 1390, EFF champions user privacy, free expres-
sion, and innovation through impact litigation, policy
analysis, grassroots activism, and technology development.
We work to ensure that rights and freedoms are enhanced
and protected as our use of technology grows.
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editorial

Guy
Cocker

FALLING DOWN
THE RABBIT HOLE

JUST WHEN it felt like we were seeing
the end of new graphics cards this
year, AMD surprised us by importing
its RX 7900 ‘Golden Rabbit Edition” from
China for a worldwide audience. True,
AMD’s gaming business is struggling
in the face of strong competition from
Intel and particularly Nvidia (see news
on [page 9, but that hasn't stopped
Team Red from releasing some stellar
products, helping keep the market
more competitive in the process.

The RX 7900 GRE, then, is the
star of this month’'s cover build, as
masterminded by our resident master
builder, Zak Storey. We reviewed the
card in our last issue, and gave it a
score of 8, leading me to ask Zak to
prioritize it for a build. The card sits
in between AMD’s RX 7800 XT and RX
7900 XT at what is now sadly the mid-
range price point of $550. That's the
same as an RTX 4070, and $50 lower
than the newer RTX 4070 Super. As
you'll read, those are comparisons
that work out quite favorably for AMD’s
bunny-themed card, even against the
more expensive Nvidia model. AMD is
still behind when it comes to ray tracing
and Al-based upscaling, but the raw
performance is there. It makes things
a lot more interesting if you have $550-
600 to spend on a graphics card.

As | write this, Computex in Taiwan is
just days away. Could Nvidia announce
new consumer graphics cards? If they
do, it'll undoubtedly be at the higher
end, possibly either a 5080 or 5090—
seelpage 10 for the latest speculation.
As for Intel, they’ll no doubt be falling
over themselves to talk more about Al,
but will they tell us more about the next
generation of desktop CPUs? You'll be
able to read all about it in these pages,
whatever happens.

The other theme running through
this issue is OLEDs. | saw lots of them
out at the Consumer Electronics
Show in January, but theyre now
here, storming the gates. We have
the Alienware 4K model leading this
month’s reviews section, plus a 1440p
screen from Acer. Next month, I'm
hoping for another OLED from Philips.
I've been effusive about OLED for
gaming for a while now, along with our
resident display specialist, Jeremy
Laird, but will your next monitor be an
OLED? Let me know by emailing me on
leditor([dmaximumpc.com]

In reviews, it's a real tale of beauty
and the beast for our reviewer, Zak.
He's found the best-value PCle 4.0 SSD
ever—good news for someone like me,
who's still not convinced by the benefits
of PCle 5.0 at current prices. He's also
taken a look at a foldable laptop that
isn't quite ready for primetime. I've
been a big fan of foldable phones, and
had been looking forward to similar
portable PCs, but it seems like we're
not quite there yet. Turn to [page 74
onwards to find out more.

A more efficient idea is probably
to use a tablet as a second screen for
your laptop, something you can do by
reading our how-to on[page 70l We also
show you how to back up everything,
stay private online, and choose the best
web browser, all for free.

Enjoy the issue!

Q%W

Guy is Maximum PC’s editor-in-chief.
He built his first gaming PC in 1997 to
play Tomb Raider on 3dfx, and has been
obsessed with all things PC ever since.

N submit your questions to:|
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, then
computers are obviously going
to be good at it. The basic idea
is nothing new, of course,
what with a paper published
in 1943 that outlined the first
model of a neural network.
Since then, we've been waiting
on hardware that can really
deliver on that notion. Well,
Al is suddenly everywhere, all
at once, and every technology
company is falling over
themselves to incorporate it
into every process imaginable.
Inevitably, that includes the
PC. Microsoft’'s partnership
with OpenAl is at the forefront
of the Al industry, and with
that comes not only a whole
slew of new Al features for
Windows, but a whole class
of machines—there is now an
official Microsoft Al PC.

Before we get too excited,
there is nothing terribly
revolutionary here. The Al
PC is a set of hardware and
software  specifications—
some utterly trivial, some a
little trickier to achieve. All you
need is an approved processor
capable of 40 TOPS of Al
processing [that's the tricky
bit, more on which later],
16GB of DDR5 and 256GB of
SSD storage. Oh, and you'll
also need a Copilot key on the

keyboard. Microsoft heralds
the result as the “fastest,
most intelligent Windows
PCs ever built”, a grandiose
piece of flummery. Arguably,
what is really being sold is the
integration of Al into Windows.
So far, the Al PC consists of
Surface, Surface Pro laptops,
and an army of new laptops
from the usual suspects: Acer,
ASUS, Dell, HP, Lenovo, and
Samsung. Microsoft expects
50 million Al PCs to be sold
over the next 12 months

If that's pretty predictable,
there’s a catch. All of those
systems are powered by the
Qualcomm Snapdragon X Elite
processor, an Arm-based chip.
There isn't an Intel or AMD
x86 CPU in sight. This is also
arguably the first truly serious
attempt to get Windows
running on Arm hardware.
That TOPS metric, Trillions
of Operations Per Second,
is used to measure the
performance of Al, specifically
the hardware NPU. It's the
NPU specifically that must
deliver 45 TOPS to qualify
for Microsoft's Al definition.
That's why AMD’s Phoenix
APU and Intel's Meteor Lake
laptop chips don’t qualify, with
their NPUs delivering 16 and
11 TOPS respectively. Nvidia's

For now, only laptops with
the new Snapdragon X Elite
SoC meet the standard

WEMIME | JUL 2024

Microsoft reckons the Copilot
keyis the Al-powered answer
to any question you may have.

latest RTX 40 GPUs, including
its mobile chips for laptops, all
far exceed 45 TOPS, but simply
do not qualify.

For now, only laptops with
the new Snapdragon X Elite
SoC meet the standard, and it
does rather seem like that was
intentional. Later this vyear,
AMD’s new Strix Point APU
and Intel’'s Lunar Lake chip
will meet the standard. There
have also been rumors about
Nvidia and AMD getting into
Arm-based PC processors.
In a recent interview, Michael
Dell was asked about an Al PC
with Nvidia hardware. He said,
“Come back next year” Jensen
Huang, Nvidia's CEO, added,
“Exactly”. Nvidia certainly
has most of the silicon it
would need, the engineers,
and funding, so Qualcomm’s
dominance is unlikely to
survive for long.

However, the question
remains whether the Al
PC is all marketing fluff or
something more substantial. In
a lengthy blog post, Microsoft
tries to explain that the
initiative is about pushing the
integration of Al, rather than
trying to invent a new class of
PC. Microsoft wants Copilot

front and center whenever
you use your Windows rig, and
with much of the Al running
locally. Every task will have Al
help at hand: searching, image
editing, writing, and more. With
that omnipresent approach,
however, come concerns.
For instance, ‘Recall’ is a
new Windows Al feature that
tracks nearly everything you
do, the sites you've visited, the
images you've viewed, and so
forth, taking snapshots as it
goes. This creates a digital
timeline you can explore and
search. Can't find that picture
of the cute cat you saw a few
weeks ago? Recall takes you
to it. Useful? Yes. Private? Not
really. It has been dubbed a
privacy nightmare by some,
and prompted calls for
regulation. The snapshots are
stored locally and encrypted,
but anybody with access
to your system can view
your activities for months,
including financial, personal,
embarrassing, and just plain
private stuff. At least you can
turn it off.

All of this makes Microsoft's
Al PC initiative a curious thing.
Thereare some usefulfeatures
being touted underneath the
marketing and hyperbole, but
equally, pretty soon every new
PC will have the qualifying
hardware, and it's yet to be
seen if there will be any truly
compelling applications that
run locally on those NPUs, as
opposed to the cloud. In the
meantime, the new Copilot+
PC starts at $999, and is
available to order. -CL

© MICROSOFT



AMD'S GAMING |
DIVISION

STRUGGLING AM D &

THE FIGURES FOR AMD'S earnings for the first quarter of the year have arrived, and the
gaming division doesn’'t make for happy reading. Numbers are down by 48 percent
year on year. Sales, in both discrete graphic cards and custom GPUs, have tanked.
Remember when we had trouble buying cards at all? No more. The market is flooded,
and most of them are wearing green badges. Nvidia currently has about 80 percent of
the discrete card market, while Intel has pinched a percentage or two in the bottom
tiers. This doesn’t leave much room for AMD. Nvidia is flush with cash and resources,
so0 going head to head in premium GPUs is a reach. The rumor is that AMD will abandon
the high-end graphic card market for its next-gen RDNA 4 GPUs, leaving Nvidia to play
alone. It’lL follow the money, meaning data centers, clouds, and Al. There is one weapon
left in its arsenal, though: drop prices until you can sell everything you make. -CL

GOOGLE AI IN
EVERYTHING

GOOGLE USES ITS annual I/0 event

to set out its plans, and this year

the theme was simple: whatever

the product, it was about how Al

can improve it. Like it or lump it,

you’ll be interacting with Gemini, Google’s brand for its LLM Al engine. There
are dozens of interconnected Al initiatives covering images, Gmail, and even
Workspace. The most obvious change is to Google search, which is shifting to
being a “search generative experience”, dubbed Al Overviews. This replaces
hard links with an Al-generated summary. Depending on the query, it can
return a completely Al-supplied reply. Not everybody is happy about this. The
results are far from infallible, and cite precious few original sources. Itisn’t
easy to disable, either. However, if you use the Web Search as the default, you
can return to a simpler time. Google has been talking about Al for years, but
in the last few months, actual application on a large scale has started. It’s all
going to get pretty interesting, pretty fast. -CL

Tech Triumphs and Tragedies

A monthly snapshot of what’s good and bad in tech

< IE l

© INTEL, GOOGLE, AMD

TRAGEDIES
af . NEW STANDARD FOR SILENT RUNNING
"4 TRACKERS LAUNCHED The silence of an electric car

Dubbed DULT, itwarns ifa
tracker is following you, so it’s
not used to stalk people.

that’s a billion gigabytes each.

MIND READING
Researchers have turned brain
activity into words, thanks to
electrodes. Well, certain words
ata 77 percent accuracy.

isn’t good for pedestrians: a
study shows that twice as many
people are hit by EVs over ICE.

| TAPEISN'T DEAD AI'S POWER PROBLEM
Shipments are up three percent By 2026, it’s estimated that
to 152.9 compressed exabytes— LLMs will burn through as

much power as Japan.

GOOGLE'S SEARCH SNAFUS
Using Al to search has a few
problems. Users have been told
that staring into the sun is safe,
and to eat a rock every day.

4 i ¢

ARROW LAKE
GETS 21 SKUS

Intel finally ready for a
major desktop launch

THE ARRIVAL of Intel’s Arrow Lake CPU is
a big deal. We have a new socket, process,
tile-based construction, features, core
architecture in Lion Cove, Al hardware,
and more. Intel plans to release 21 SKUs
(Stock Keeping Units). It's the biggest
launch since Alder Lake in 2021.

There’s new branding, too—no more
‘I', as Arrow Lake is to be the Core Ultra
200-series. The Ultra 100-series was the
mobile Meteor Lake, a tile-based design
that never made it to a desktop. Top dog
is expected to be the Core Ultra 9 285K
with 24 cores. That's eight performance
and 16 efficiency cores, or '8P+16E’ in Intel
speak. It has a base clock of 3.6Ghz, and
a maximum boost of 5.5GHz. Then there’s
Ultra 7 265K, with 8P+12E cores running
at a base clock of 2.8GHz, and the Ultra 5
245K with 6P+8E cores, on the same clock.

These are ‘leaks’, not official specs.
But with a launch expected later this year,
the odds are high that these are accurate.
Along with those are the usual mainstream
65W workhorses and 35W low-power
models. Partnered with Arrow Lake will
be a new mobile CPU: Lunar Lake. This
sports a 4P+4E configuration, and will face
competition from Snapdragon, Apple’s
new M3 chip, and AMD’s finest.

Notably, Arrow Lake will debut the
20A process, while 18A is due for volume
production next year. The catch is that only
the CPU die within Arrow Lake will be made
on Intel 20A silicon. Even then, it's rumored
that most Arrow Lake SKUs will use a
TSMC process for the CPU die. That would
mean a pure TSMC chip, as the other tiles
are already made by TSMC. As for Lunar
Lake, that's pure TSMC. Even with the
arrival of Arrow Lake and Lunar Lake, Intel
will be nowhere near the technological
driving seat in chip manufacturing. But
depending on how good those Lion Cove
cores are, it could still look decent when it
comes to performance. -CL
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APPLE’S
NEW M4 CHIP
ARRIVES

New SoC makes its
debut in the iPad Pro

MERE months after the M3 first appeared,
there's already a new Apple M chip—this
time in an iPad, the first time new silicon
hasn'tdebutedinaMac.The SoCusesa?2nd
gen 3nm process courtesy of TSMC, and is
the first time Apple has given its M silicon
CPU cores a major overhaul. Single-core
performance is improved thanks to both
improved IPC and higher clock speeds.
There’s improved branch prediction, and
wider decode and execution engines. You
also get two extra efficiency cores—six in
all, but the same four performance cores.
The GPU sticks to ten cores, albeit tweaked
with Dynamic Caching, and hardware-
accelerated ray tracing. In the new iPad
Pro, the new silicon is partnered with what
Apple claims is the world’'s most advanced
display: the Ultra Retina XDR, a dual-layer
OLED panel. There's also a ‘pro’ camera
system, including a LiDAR scanner, 12MP
still, and 4K video.

Apple claims the M4 can match the
M2’s performance while using half the
power, as well as the ‘leading’ laptop
chip, while consuming a quarter of the
power. That chip is the Intel Core Ultra 7
155H. Obviously, there is a strong Al angle.
The M4&’s neural engine is capable of 38
TOPS. Apple has the red and blue teams
comfortably beaten, although Qualcomm’s
45 TOPS Snapdragon X Elite is no slouch.
More immediately important is the single-
core Geekbench score—the M4 reached
over 3,700, leaving Intel’s Core i9-14900KS
behind at 3,300. That means the tablet is
now mightier than the desktop, sort of. If
we switch to multi-core, then the 32-core
Intel trashes it. Still, for a tablet, that's
impressive. The M4 iPad Pro starts at
$999, and if you play with the configuration,
ticking all options, it tops $3,000. -CL
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EVERY TIME WE THINK THE magnetic hard drive
is dead, new life is breathed into them. We
haven't seen a new 2.5-inch drive for years,
the format seemingly peaking at 5TB. However,
Western Digital has squeezed an extra terabyte
in. Its new 6TB versions are available across
WD's external My Passport range—four in all, as
well as ScanDisk’'s ArmorATD. Prices range from
$185 to $230, depending on the enclosure and
compatibility. This is, according to WD, enough to store 150 AAA gaming
titles. The drive is taller than the 5TB version, hence it's external rather
than internal, not that there are many laptops with spinning drives anymore.

More useful, perhaps, are big 3.5-inch drives, as the last three HDD
manufacturers fight for what’s left of the market by building the biggest
drives. Toshiba is planning drives of over 30TB, and claims to have
demonstrated working 32TB and 31TB drives using HAMR and MAMR (Heat
Assisted Magnetic Recording and Microwave Assisted Magnetic Recording).
The 32TB model has ten platters, while the 31TB uses 11—the first to do
so. It has plans for 35TB by 2025, and 40TB in 2026. Conventional magnetic
recording tops out at a capacity of around 22TB, and the three players are
in a race to get the new recording methods into drives for the data center
business. Seagate managed this with its 32TB HAMR drives last year, and
has plans for 30TB. Western Digital has a 28TB drive, and plans for 36TB
HAMR drives. If you want a consumer version, you'll have to wait, as the data
centers will take everything built for the foreseeable future. -CL

New
ChatGPT |

OpenAl has

released GPT- =

40. The ‘0’ is for omni, hinting that
this fast new multi-modal version
of the Al bot does a lot more than
chat. It uses the same LLM (Large
Language Model), but is a lot
more potent. The original has a
latency of about three seconds—
reasonable for text chat, but
too sluggish for speech. GPT-4o0
reduces that to a level suitable for

verbal and visual prompts in real

time, as the video demonstration
proved. The system is shown a
roomandthenaskedtoguesswhat
might be going on. It guesses that
the room is rigged for video work.
It was then told an announcement
was going to be made. It correctly
postulates that this might involve
OpenAl (the demonstrator is
wearing a branded top). This was
all pre-prepared, but still spooky.
OpenAl claims that it is better at
audio and visual translation than
allthe currentrivals. The speed of
Al development remains dizzying.
-CL

RTX 5080 to
come first?

Nvidia usually launches a new
GPU family with a bang. Its next
GPU architecture is Blackwell,
and is expected to appear this
year. Nvidia has shown a 2025
roadmap, but nobody appears
to believe that. The 4000-series
Lovelace cards were stunning,
but Nvidia’'s clumsy handling of
their price and configurations
knocked their appeal. Blackwell
is hotly anticipated, and we'd love
to see it before next year. But what
Blackwell cards could land first?
Earlyrumors suggested allwe may
get is an RTX 5090. More recently,
that’s changed to the RTX 5080,
with the biggest gun saved for next
year. Since AMD isn’t providing hot
competition at the top level, Nvidia
isn’t under any pressure to drop
the 5090 first, but we still wouldn’t
be surprised to see both 5090 and
5080 announced together. Indeed,
there is a small chance that by the
time you are reading these words,
Nvidia will have pulled the covers
off something at the Computex
trade show in Taiwan. -CL
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For Sale: Cheyenne

Jarred Walton

Supercomputer

about PC hardware, it's that it becomes
outdated. The Cheyenne supercomputer is testament to the rapid
iImprovements over the past decade in the world of extreme scalability,
coupled with a warning about things not always going as planned.
Apparently, ongoing reliability, repair, and maintenance issues reached
the point where the best option was to pull the plug and start afresh.

Deployed in 2016, Cheyenne was the year’'s 21st
fastest supercomputer, with a score of 4.79
petaflops. Today, it's number 160 on the Top500
list—or was prior to being decommissioned. While
it's not clear how much it cost, it replaced one
that was around $25-$30 million, and its Derecho
replacementisan HP-built setup that cost $35-$40
million. It seems reasonable, then, that Cheyenne
fellin the $20-$40 million range. Eight years later,
it sold at auction for $480,085.

It's interesting to read the auction notes, which
state that “the system is currently experiencing
maintenance limitations due to faulty quick
disconnects causing water spray.” This on its own
wouldn’t be terrible, except that approximately
one percent of the 4,032 nodes were experiencing
ECC memory errors. Washing its hands in the
150 gallons or so of propylene glycol coolant, the
NCAR-WY Supercomputer Center decided to let
someone else worry about parting things out.

The 32 petabytes of storage that the system
used aren’t included, but there are 14 E-cells, each
containing two racks of quad-node server blades.
There are 8,064 Intel Xeon E5-2697 v4 processors,
4,890 64GB DIMMs, plus power supplies, cooling,
motherboards, networking switches, and more.
There are also two management racks that added
52 1U servers and 8TB of DRAM. Altogether, the

Cheyenne began service in 2016. Ultimately, it
was sold at a fraction of the original cost.

supercomputer around
26,000 pounds.

The gqulf between Cheyenne
and modern  supercomputer
hardware shows how far things
have come since 2016. Cheyenne
used around 1.727 MW of power
fully assembled, or around 2.77
petaflops per megawatt. lts
Derecho replacement delivers
roughly twice the computational
power (10.32 petaflops), though
it also includes 382 Nvidia A100
GPUs. There’s a discrepancy
between what NCAR says about
Derecho and the Top500 result,
however, as it's supposed to be a
19.87 petaflops supercomputer.
With a 40 percent higher power
draw than Cheyenne, that would
yield 8.22 petaflops per megawatt.

Contrast that with the fastest
supercomputer today. The AMD-
based Frontier supercomputer
holds pole position, with 1,206

weighs

petaflops of compute
and a power use of
22.79 MW—nearly
53 petaflops per
megawatt. AMD’s El
Capitan supercomputer
should be finished in the
near future, providing
roughly double the
performance of
Frontier. It'snotallabout
raw compute, however, as the
Green500 list ranks the most
efficient supercomputers. The
current leader, JEDI, isn’t even as
fast as Cheyenne in raw compute,
boasting ‘only’ 4.50 petaflops.
However, its power draw is only
67kW—about four percent of the
power consumption of Cheyenne
for the same level of performance.
These figures use LINPACK
results that focus on FP64
compute, however, and a lot of
supercomputers are  turning
toward Al calculations using
FP16 or FP8 operations. New
supercomputers sporting Nvidia
Grace Hopper superchips will
bring 200 exaflops of Al compute
within the next year. No wonder
Cheyenne got kicked to the curb.

Jarred Walton has been a

PC and gaming enthusiast
for over 30 years.
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GAMING MONITORS

have been getting
pricier, many gaming monitors are cheaper. $250
buys you a lot more than it did five years ago, though
a new class of OLED panels has made things pricier
at the top end. In between, there’s more choice than
ever before, including resolutions, aspect ratios,
panel types, backlight tech and plenty more.

Looking for a slightly

larger alternative to that
LG panel for not much extra cash?
Try this alternative. Gigabyte’'s
more affordable 4K monitors go
down a treat—they're fast and bright,
and you even get a USB-C hub
thrown in. Between the resolution,
144Hz refresh rate, and IPS panel, it's a great
all-rounder for 4K. Even beyond PC gaming, an
HDMI 2.1 port offers 120Hz gaming for consoles, so
it's quite the package. $429, WWw.gigabyte.com

The LG UltraGear 27GR93U is LG’s IPS tech

at its best. It's absolutely gorgeous, with
colors that are accurately calibrated, crispy 4K
visuals, and a zippy refresh
rate. You will need a mighty
graphics card to run this
UltraGear gaming monitor at
its fullest, of course. It runs
up to 144Hz, which is a tough
task even with modern GPUs.
Upscaling will help with that,
meanwhile the 4K precision
makes this a great panel for
getting serious stuff done, too.
Overall, this is a very strong all-rounder, even
if it comes at quite a price. $425,

Don’t know Pixio? Seen the pricing? Don't panic.
Corners haven't been cut where it counts. It
feels a bit cheap, but looks slick enough, and when
it comes to image quality and gaming experience,
there are no horrors. You get a 1440p VA panel, Tms
response, and 165Hz refresh. It's not true HDR, topping
out at 320 nits and lacking local dimming, but that's

fine. $240,/www.pixiogaming.com

Another day, another 32-inch, 4K, 240Hz QD-
OLED stunner. Except this one’s cheaper and
every bit as good as the competition. An easy choice?
For once, yes. This offers the same Samsung-
sourced QD-OLED panel as more expensive
monitors, including
the Asus ROG Swift
OLED PG32UCDM,
the Alienware
32 AW3225QF
and the Gigabyte
Aorus C049DQ,
but it’s hundreds
of dollars cheaper.
As no-brainer
recommendations

A contrasty VA panel, plenty of backlight
punch if you run it in HDR mode, reasonable
pixel response, and high enough refresh for
most gamer’s purposes. $350 barely touches
the sides when it comes to graphics cards
these days, but here it buys you 34 inches of

real estate, 165Hz refresh rate, Tms response, go, thisis as
and even HDR support. Nice for ASRock’s first straightforward as it
gaming panel. $350, Www.asrock.com| gets.$899,www.msi.com
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How to emulate
X86's success -

| touched on the fact that the first official Microsoft Al PCs
would be running a Qualcomm Arm-based CPU. This begs one obvious
question: what about old software? Arm chips tend to be more efficient,
but what good is that if you can't use your favorite apps?

The CPU coresin Apple’s new M4 chip are scary, as
in scary fast. Seriously. The M4 cranks out about
3,800 points in Geekbench 6 single core. That
compares with roughly 3,300 points for an Intel
Core i9-14900K. Remember, that’s an M4 running
in a tablet. It's only in the iPad Pro for now, not in
any Mac computer.

The point is that you can forget about assuming
that Arm chips are efficient but feeble. They
can be competitive and then some for raw
performance. The problem is that you can have all
the performance in the world, but it doesn’t count
for much if there’s no software to run. Historically,
Microsoft hasn’t done a great job of supporting old
x86 software on Windows for Arm chips.

Supposedly, it's going to be different this time.
For starters, some key apps, including Chrome and
Adobe Photoshop, will be available in native Arm
format. For a lot of users, native Chrome alone
is almost enough. For everyone else, emulation,
performance, and efficiency will be key.

Critically, there are two aspects to any attempt
to emulate another CPU architecture, in this
case Arm emulating x86, the software, and the
hardware. The upcoming 24H2 update for Windows
11 has a new translation layer known as ‘Prism’,
which will convert code on the fly from x86 to Arm.

Inevitably, there’'s another comparison to be
made with Apple and its Rosetta 2 emulation
layer, which was introduced when the Mac itself
moved away from Intel x86 CPUs to Apple’s in-

house Arm silicon. But the same
applies to the hardware side of
the equation. Apple’s Arm-based
chips have hardware features and
optimizations designed to improve
x86 emulation.

For instance, the way Arm and
x86 order memory is based on
different models, known as weak
and strong respectively. Apple
silicon incorporates both models,
and that apparently makes a big
difference for performance and
efficiency when emulating. It's
not clear what, if any, hardware
elements the X Elite chip has for
improving emulation.

However, there’s one reason to
think there may be some. The CPU
cores in the X Elite were actually
designed by a startup called Nuvia,
which Qualcomm snapped up in
2021. But here’s the real kicker:
prior to co-founding Nuvia in 2019,
its CEO, Gerard Williams, was none
other than Chief CPU architect
at Apple for nearly a decade. The
company was staffed by other
former Apple engineers involved
in the company’s transition to Arm.
It's safe to say that Nuvia, and
therefore Qualcomm, knows all
about whatitis in Apple silicon that
makes emulation run so well.

Exactly how good the X Elite
will be remains to be proven.
Qualcomm has previously claimed
that even games will “just work”
on the X Elite, and we recently

The 7th Gen Microsoft Surface will
reveal just how well the Snapdragon
X Elite can emulate x86 software.

found that the MacBook Air can
be surprisingly good for gaming
in some narrow scenarios. But
there’'s much to be proven.

Qualcomm can make a fantastic
chip for emulating old code, but
it won't be any good if Microsoft
doesn’t play its part. Put simply,
Qualcomm doesn’t control the
entire stack, and that's a clear
disadvantage compared to Apple.
All that said, as | explained last
month, Microsoft seems to be
pretty tight with Qualcomm right
now. It has chosen the latter to
partner with and promote the first
Al PCs, something that Intel and
AMD can’t be happy with at all.

It certainly seems like Microsoft
is keen to promote the Arm
platform, which implies that it
might have put the work in to get
x86 emulation running well. It
won't be long before we find out. By
the time you read these words, the
first laptops with the X Elite chip
will be out, and the tech community
will be poring over every aspect of
performance. Things are certainly
getting interesting.

Six raw 4K panels for break-
fast, laced with extract

of x86... Jeremy Laird eats
and breathes PC technology.
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Are VPNs toast?
I've been reading a news
story on the TunnelVision
vulnerability for virtual
private networks.
Apparently, this—excuse
the pun—tunnel-sized
hole in VPN security has
existed since 2002. It says
the vulnerability allows
attackers to force VPN apps
to send and receive at least
some of your traffic outside
of the encrypted tunnel. The
claim is that you're only safe
when the VPN runs on an
Android device or Linux PC.
Is this true, and if so, does
it mean the VPN networks
I've been using for all these
years have been utterly
useless in all that time?
—Caitlin H Tracey

THE DOCTOR RESPONDS: The
headline of this vulnerability
does make for grim reading.
That said, in practical terms,
the risk can be minimized
and even eliminated
completely. That's because
this vulnerability targets the
network you're connecting
through. It makes use of

a weakness in how DCHP
servers, which allocate

IP addresses to devices

that aren’t configured

to manually set these
themselves, work.

THIS MONTH THE DOCTOR TACKLES...

> VPN vulnerability
> Application tabs
> Podman acceleration

The weakness is known
as Option 121, and allows
networks to change the
route traffic takes to certain
IP addresses or websites,
basically giving bad actors
the opportunity to reroute
traffic outside of the VPN'’s
encrypted tunnel.

The attack requires
someone to have
administrative control over
whichever local network
you're connecting to, which
is the first piece of good
news. If you connect through
your phone’s cellular
network, or you're using a
VPN at home through your
own local network, then you
should be immune from this
type of attack.

The risk comes when you
connect through third-party
Wi-Fi networks, such as
public hotspots. If you
rely on the DHCP server
to provide you with an IP
address to connect to that
network, you would be
vulnerable if the network
itself has been configured to
use Option 121 to re-route
traffic. There are, however,
workarounds.

First, check your VPN
provider doesn’t offer
protection against this kind
of attack. For example,
ExpressVPN’s Network Lock

switch is designed to protect
against attempts to force
your traffic to bypass the
VPN. Therefore, if the lock
is switched on, you're safe
now—and were in the past,
too. Any attempts to bypass
the VPN would resultin an
error or blank webpage.
Even if your VPN provider
offers such a kill switch,
make sure it’s robust enough
to block the TunnelVision
vulnerability.

A fiddlier workaround
involves connecting to the
local network to obtain an IP
address and other network
details, then switching your
network settings so they're
manually configured. You
can use the same connection
details, but because you've
specified these yourself
instead of using the DHCP
server, you're protected
from any bad actor.

As for Android and
Linux users being safe,
that’s not quite true.

You're certainly protected
against TunnelVision when
connecting through your
Android mobile, because the
platform doesn’t support
DHCP Option 121. However,
while Linux has a setting
that minimizes the effects,
it's notimmune thanks to a
side channel.

One final thing: if you
followed last month’s
feature tosetup a
WireGuard VPN server
to allow you to dial home
into your network, you're
immune too. That’s because
the only way into it is
through your VPN tunnel, so
any traffic re-routed outside
the VPN can’t get to it.

Tabs for any app

| have so many application
windows open it can be a
real pain switching between
them all. Do you have any
tips or tools that could help
me bring a bit of order to the
chaos? —Gerald L. Bromberg

THE DOCTOR RESPONDS:
The Doc’s recommended
solution, which he uses
on a day-to-day basis, is a
program called TidyTabs
(\kww.nurgo-software.com/]
[products/tidytabd). As the
name implies, it basically
lets you merge multiple
application windows into
a single tabbed window.
It's what Microsoft’'s Sets
feature would have offered
in Windows 10 had it not
been canceled back in 2019.
There are two versions
available—one that’s free
for personal use, and a
professional license for $29.

N submit your questions to:
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The big restriction in the
free version is that you can
only group three windows
together at any one time—
once installed and running,
roll your mouse over the
top left-corner of a window
to reveal a small colored
tab. Simply click and drag
this on to another window
to group them together—if
the windows haven’t been
extended to the full height of
the screen, you'll see semi-
translucent tabs appear
above the window when it’s
in focus with the name of
the app or open document
on each one. Just click a tab
to switch toit, or click and
drag the tab to separate the
windows again.

You can combine windows
from different applications,
allowing you to group items
by whatever criteria you
choose. You can also create
whitelists and blacklists to
automatically set up tabs for
certain windows, as well as
exclude certain applications
from working with TidyTabs.

The free version gives
all the core functionality
you need to evaluate
TidyTabs, but upgrading to
the Pro version does more
than simply remove the
three-tab limit. You gain
access to smart grouping
options, which make it
easy to combine windows
from the same application
(great when working on
multiple Word documents,
for example). You also
get to choose a tab color
scheme, rename or reorder
tabs, define hotkeys, and
open a file in a window by
dragging it on to its tab. If
you're juggling lots of open
windows, then TidyTabs is
definitely worth giving a go.

Jellyfin Podman
problem

I've migrated my Jellyfin
media server from a native
instance on my Linux server
to a Podman container.
Everything appears to be
working okay, except | cannot
get it to use hardware
transcoding. Whenever it's

Most decent VPN providers offer a kill switch.

unable to direct play files, it
fails with an error unless |
disable the feature, at which
point it'll transcode using the
CPU. What am | doing wrong?
—Edward Sundberg

THE DOCTOR RESPONDS:
The Doc was able to get
transcoding working in both
Jellyfin and Plex containers
with what can only be
described as a bit of a botch
job. It basically boils down to
giving the container access
to the GPU via the /dev/dri/
renderD128 directory. By
default, your container is
unable to access this folder
because of a combination

of user restrictions on

that folder with the way
user namespace mapping
works in rootless Podman
containers.

Access to the folder is
through the ‘render’ group,
which has the necessary
permissions. On a native
Jellyfin install, a user is
created that’s automatically
added as a member of the
group. Docker users are told
to use the ‘--group-add’ flag
to link Jellyfin, but it had
no effect on either Plex or
Jellyfin in our experiments.

Instead, the Doc
recommends taking some
liberties with security and
widening access to the /dev/
dri/renderD128 directory.
You can test this with the
following command, which
changes user permissions to
allow all users to read and
write to the directory:
sudo chmod -R 666 /dev/dri/
renderD128

Now, as long as your
Jellyfin Podman script has
the following line, you should
be able to enjoy the benefits
of hardware transcoding:
--device=/dev/dri/
renderD128:/dev/dri/
renderD128:rwm \

Test by playing back a
video that requires hardware
transcoding—for example,
by using your mobile phone
and changing the playback
settings to reduce the
bitrate. Confirm transcoding
is taking place from the
Jellyfin server’s web-based
dashboard (click the ‘i’
button under the device’s
entry), then keep an eye
on CPU usage—it should
be 30-40 percent rather
than 95-100 percent when
CPU transcoding is taking
place. Cockpit users can
monitor CPU usage from the
Overview section.

Once you’'ve confirmed
the fix works, you can enjoy
hardware transcoding—until
you restart your server,
as this is one of those
permissions that doesn’t
survive a reboot. You can
either manually run the
‘chmod’ command after
every reboot in future, or you
can make it stick by editing a
single file:
sudo nano /lib/udev/
rules.d/50-udev-default.rules

Locate the following lines:
SUBSYSTEM=="drm",
KERNEL=="renderD*",
GROUP="render",
MODE="0660"
SUBSYSTEM=="kfd",
GROUP="render",
MODE="0660"

Change ‘660’ to 666’ in
both lines, save the file
and exit. The fix is now
permanent, and hardware
transcoding should always
be available going forward.

Remote inspection
Afriend is offering me his old
gaming PC for what he says
is a ‘knock-down’ price. He
lives about 30 miles away, so
| don’t want to travel over to
view it before I've done a bit
of due diligence. He doesn’t
know much about PCs, so
ideally, I'd like to check out
its spec remotely. Any ideas
how this could be done?
—Timothy Ramos

THE DOCTOR RESPONDS: Why
not set up a video conference
with your friend using a tool
that allows desktop sharing?
Most tools support this,
including Microsoft Teams.
Once the meeting is set up,
ask your friend to look for an
option to share his desktop
with you, then walk him
through accessing Settings
> System > About so you can
look. If you like it, ask him
to download and run the
portable version of HWiNFO
(www.hwinfo.com). Get him
to launch the tool and make
sure both Sensors-only
and Summary-only are
unchecked before clicking
Start. This will let you take a
deeper dive into his system.
Alternatively, if you'd
rather be left alone to
check the PC yourself [and
your friend is happy to let
you poke around), suggest
setting up a Quick Assist
session in Windows. Launch
the tool and click ‘Help
someone’. Sign into your
Microsoft account, then
ask your friend to open
Quick Assist on his PC.
Communicate the security
code on your screen to your
friend, who should input it
at his end, and click Submit.
Once connected, request to
take full control. You're now
free to perform whatever
checks you need to learn
what you can about your
prospective purchase.
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TINY TOWER
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RANSPLANT

SUILD

Zak Storey takes the RX 7900 GRE out for a spin in a tiny E-ATX Tower

WHEN IT COMES TO the ITX form factor,
most will end up in one of two camps.
Either you love them because of the
minimalist aesthetic, small footprint, and
that basic concept of absolute power in a
ridiculously small build. Alternatively,
you hate them because of the lack of
connectivity, limited case choices, and
often poor cooling as a result.

It's one of the most controversial
form factors out there. With components
getting larger, more power hungry, and
requiring more cooling to get the most
out of them, it’s becoming increasingly
difficult to find support for it across the
board as we move from generation to
generation.

INGREDIENTS

But what if we were to tell you there
was another way? What if we could mix
the very best of both worlds? A small
form factor case that didn’t compromise
on cooling, with full E-ATX motherboard
support, and an intuitive layout that
allowed you to squeeze in some serious
power, without sacrificing in any one
area? Well, that would be perfect, right?
But surely it doesn’t exist?

Well then, with 24 cores, 32 threads,
32GB of 6,000 MT/s memory, one of the
best value 4K GPUs you can pick up right
now, a super-premium cooling solution,
1200Ws of power delivery, and no less
than 6TB of PCle 4.0 and 5.0 storage, all
cooled via six 120mm fans and a 360mm

radiator, this build here ticks all of the
above boxes and then some. What's
more impressive is that it fits all of that
in a tower chassis that measures, at its
smallest, just 15.6 x 8.5 x 16.1 inches. To
put thatinto perspective, at Maximum PC,
our first ever ITX liquid-cooled PC was
built inside the incredible NZXT Manta,
a case that by contrast measured 16.7 x
9.6 x 17.7 inches—over an inch larger in
every measure.

Well then, ladies, gentlemen,
friends, colleagues, and everyone else
in between, Maximum PC is proud to
present the Tiny Tower Ultimate Power
build. Let’s geodesically weave our way
into the feature, shall we?

PART | PRICE
CPU | Intel Core i9-14900K $549
Motherboard | Asus ROG Maximus Z790 Dark Hero | $595
CPU Cooler Phanteks Glacier One 360D30 White | $170
RAM 32GB (2x16GB) Crucial Pro Overclocking DDR5 @ 6000 C36 $105
SSD1 1TB Crucial T700 M.2 PCle 5.0 x4 $172
SSD2 2TB Kingston Fury Renegade M.2 PCle 4.0 x4 $173
SSD3 2TB Lexar NM790 M.2 PCle 4.0 x4 $147
GPU Sapphire Pulse Radeon RX 7900 GRE 16GB $550
Case Geometric Future M4 Caliburn ATX Mid-Tower $109
PSU 1200W Corsair RM1200x Shift 80+ Gold $206
120mm Fans Phanteks M25-120 PWM D-RGB Fans 3 Pack | $30

PRICES CORRECT AT THE TIME OF PUBLICATION
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POTENT PC
PART PICKS
FOR PREMIUM
PERFORMANCE

ntel Core i9-14900K $549
Time and time again, we keep coming back
to the Intel Core i9-14900K, and with good
reason. At its core, this build is the very
heart of the Maximum PC testbed. It's our
go-to chip for GPU, RAM, and SSD testing,
and delivers incredible performance for
the price. It's effectively the pinnacle of
what Intel has managed to achieve with its
Rocket Lake architecture.

It's not perfect, and if you've kept your
ear to the ground on this one, you've
likely seen news articles regarding
motherboards producing pretty
aggressive overvolts and clock-speed
boosts. However, you can now pick up an
Intel default performance profile in most
mobo BIOSes, and even with that slight
drop in overall potency, the 14900K still
delivers supreme CPU performance,
circumnavigating any potential
bottlenecks you can imagine for any other
component in your build. You're still likely
to see those 100 C running temperatures
and high clock speeds, but it'll at least be
a touch more stable.

Fun news cycle data aside, the 14900K
has some serious hardware at its core (ha,
puns), including eight performance cores,

JUL 2024

with  hyperthreading,
plus 16 efficient-cores,

for all of those low-
priority application processes that need
managing. Combine that with 36MB of
mixed smart-cache, and the 14900K quite
happily dominates any task you throw at it.

Asus ROG Maximus Z790 Dark Hero
$595

|www.asus.com |

It's a bit odd when your motherboard
costs more than your CPU, and this one
has arguably been the cause of a number
of headaches for us lot in the labs over the
last few months.

On the surface, it's an incredible piece
of hardware. One PCle 5.0 M.2 slot, four
PCle 4.0 M.2 slots, a phenomenal amount
of USB connectivity bothin the rear I/0 and
on the board itself. Wi-Fi 7 as standard,
2.5Gb Ethernet, and a seriously hefty 20+1
VRM solution as well. It's given Asus the
opportunity to push these chips to the
nines when it comes to performance,
and that has certainly come with some
drawbacks in terms of system stability
(we're looking at you, Core i7). Still, with
a few tweaks here and there, and some
adjustments to some of the Asus Al auto-

overclocking nonsense in the
BIOS, the Z790 Dark Hero is a great
board for any connectivity aficionado.

The only thing that does look a bit
awkward (for a $595 motherboard) is that
weird ‘Aura Grid’ rear I/0 LED thing. It's
not a display, so don't get your hopes up—
thisisn'ta Formula board, unfortunately—
but you can turn it off in the BIOS, and
leave yourself with a clean mirrored finish
here instead.

Phanteks Glacier One 360D30 $170

www.phanteks.cor

For this build, we wanted to step away
fromall of the crazy display AlOs currently
out there topping $300, complete with
messy cable management systems and
nightmarish surrounds, and instead opt
for something a little more low-key. This
time, we've gone for the Phanteks Glacier
One 360D30 in white.

There’s no pomp or fanfare here—just
simple, clean, elegant design, mixed with
an intuitive mounting system, and one
seriously hardcore backplate. It comes
with support for pretty much every socket
since the LGA115x series and above, and
also includes a set of Phanteks’ daisy-
chainable D-RGB fans.


http://www.intel.com
http://www.asus.com
http://www.phanteks.com

STEP-BY-STEP | ?

It's a fantastic pick, and performance
on those fans in particular is Kkiller,
clocking in 3.01 mmH20 and 64.3 CFM
at full tilt, while still only registering 30.2
dBA at maximum RPM. That's not too
shabby. Impressively, we found that the
pump was actually the noisiest element
once we had it all set up to our fan curves
correctly, and even then, once the system
got a little settled, it soon faded away.
We've gone with white this time to provide
a little contrast against the dark black
of the motherboard and its supporting
components. It's a small change, but
it really gives the build a bit more of a
three-dimensional feel because of it,
particularly when you start illuminating
that interior with a touch of LED lighting.

[RAM S ————— |
32GB (2x16GB) Crucial Pro

Overclocking DDR5 @ 6000 C36 $109

Itwas only the May 2024 issue that we used
this same Crucial kit in another build, that
one featuring the RTX 4080 Super among
other things, and we've turned to it and
Crucial once more for one simple reason:
memory profiles.

Sounds mundane, right? We've got all
these illuminated parts internally, and so

much going on, and yet, somehow we've
gone with a bland low-profile memory
kit that clocks to just 6,000 MT/s? Well, as
this build is more transplant than a fresh
take, and its core is predominantly our
testbed, versatility is key.

A good review, and a good set of
benchmark results, relies on consistency.
Testing CPUs in particular requires every
other component in that loop be of a
similar caliber. GPU, SSD, motherboard
if possible, but the biggest challenge
is memory. If youre using two very
different kits of memory for both Intel
and AMD, youre immediately going to
invalidate your results. Searching around
for two similar or identical kits, with
timings that are parallel to one another,
with the same frequency and capacity,
can be challenging. For a long time,
manufacturers produced kits with only
either Intel’s XMP settings or AMD’s EXPO
settings embedded on them. Got an AMD
system? Buy this kit, but you'll be up a
certain creek without a paddle if you swap
to Intel later down the line.

Excuseswereusedaboutstorage space
on the DIMMs (for timings—can you feel
our frustration there?), but finally, Crucial
broke the mold, and put both Intel and
AMD profiles on a single kit of memory.

That’s why the Crucial Pro Overclocking
kit is so valuable. 32GB of pristine DDR5,
at 6000 MT/s (the sweet spot for AMD and
Intel) plus consistent timings between
both platforms? Consider us sold, and for
only $109 as well.

ssp1__________________
1TB Crucial T700 M.2 PCle 5.0 $172

Sometimes, the fastest parts aren't
the most useful parts when it comes to
building a decent testbed, and nowhere
is this more apparent than with our 0S
SSD. Because we're utilizing that Asus
Dark Hero as our motherboard of choice
for SSD, RAM, GPU, and Intel CPU testing,
we needed an SSD that'd fit comfortably
in that PCle 5.0 slot and one that you could
remove from its heatsink.

With that in mind, we've gone with the
T700 over the T705 with one reason in
mind: you can remove it from its heatsink.
Sadly, although the T705 is significantly
faster than the T700, its lack of an easily
removable heatsink makes it a challenge,
particularly if we want to secure it in place
and take advantage of the Z790 Dark
Hero's gargantuan SSD heatsink.

It's still a good drive, with top-tier
sequential performance, and decent
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random 4K (pretty much in line with the
bulk of that generation of PCle 5.0 drives),
but it's not the quickest. That said, 1TB at
just $172 represents good value right now.

ssp2______________________________|
2TB Kingston Fury Renegade
M.2PCle 4.0 $173

Our second key drive is the Kingston Fury
Renegade M.2 PCle 4.0 SSD. This is where
we store all of our software and games for
the copious amount of benchmark runs
we perform here at the mag and when
testing hardware.

We've waxed lyrical enough about the
Fury Renegade over the last few issues,
but to cut a long story short, its got some
seriously intuitive engineering behind it,
coupled with a significantly chonky full-fat
DDR4 cache, giving it quite the competitive
edge in random 4K performance versus
evensome of the larger PCle 5.0 drives out
there right now. Yes, it's predominantly
designed for consoles like the PS5, but
its pure performance grunt makes it a
surefire pick as our secondary drive.

L ——
2TB Lexar NM790 M.2 PCle 4.0 $147

jvww lexar.com]

Three SSDs? In one build? Impressively,
we've still got space for another two SSDs

JUL 2024

if we wantwith that motherboard. Still, our
third SSD drive (predominantly operating
as a backup drive, and for any tertiary
games we might need to download, or
video content we may need to store), is
the rather impressive 2TB Lexar NM790
PCle 4.0 SSD. For testing purposes, we'll
be reporting on this drive in particular, as
it's a seriously top-spec PCle 4.0 SSD, but
with the caveat that it's currently available
atan incredibly low $147.

That's phenomenally cheap for a drive
of this size on the PCle 4.0 standard, and
given that we know the results as we write
this, you won't be disappointed if you do
pick this up for your primary drive.

bt |
Sapphire Pulse Radeon
RX 7900 GRE 16GB $550

Peak RDNA 3 GPU-—that's how vyou
should see the RX 7900 GRE. Also, we're
starting to wonder if AMD’s going to run
out of suffixes with the rate it's releasing
these GPUs. The RX 7900 GRE is designed
to fit nicely in the power vacuum laying
between the 7900 XT and the 7800 XT. Why
isn'tit called the 79007 Good question.
That said, for its reasonable $550 price
tag, you get access to 80 Compute units,
5,120 shader cores, 160 Tensor cores, and
80 ray tracing cores, as well as a fairly

healthy 2,245 MHz boost clock. It also
packs in 16GB of VRAM to round it all off.
There’s a lot of similarities between
how the 7900 GRE has been handled and
the RTX 4080 Super. On the one hand,
compared to the 7800 XT, there’s a not
insignificant hardware bump, particularly
going from 3,840 shader cores up to 5,120
(25 percent more, if you're counting). Yet,
the clock speeds are actually significantly
lower than the 7900 XT and the 7800
XT, both of which break that 2,400 MHz
barrier, while the GRE slides in at just
2,245 (about an eight percent drop, at least
on reference cards), which will inevitably
mute that hardware bump we've seen.
Either way the GRE looks to be the
perfect entry-level 4K gaming GPU or top-
tier 1440p graphics card, if you've got that
kind of cash, and don’t mind the slightly
less potent ray-tracing performance.

Geometric Future Model 4

Caliburn ATX Tower $109
www.geometricfuture.com

Here, we have that 35L masterpiece,
the Model 4 Caliburn. This isn't the first
chassis we've seen from Geometric
Future, and likely won't be the last either,
as the case manufacturer continues to
impress us with its incredibly innovative
design full of clean, crisp details.
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The Model 4 has an incredibly small
form factor, that much we've already
established, but you may have spotted
we listed ‘in its smallest configuration’
as a caveat, as it can have four separate
configurations, depending on how you
want to manage your build. Simply by
raising the roof and its associated bracket,
or removing a plate here and there,
you can dramatically adjust everything
from SSD placement and PSU support
to vertical GPU mounting and radiator
support, all without losing any of those
beautiful style elements, including the
L-shaped smoked glass window, mirrored
front panel, and perforated ventilation.
Similar to the Model 8 we looked at in
the May 2024 issue, the Model 4 takes
advantage of a similar chimney airflow
design to alleviate heat build-up, leaning
into natural convection rather than
fighting it, as you'd find in other cases.

For top-Lline stats, you get up to E-ATX
motherboard support (although we'd stick
with ATX for optimal cable management],
upto 1x360mm, 1x 240mm, and 1x 120mm
radiator support, mounting locations for
nine fans total, and PSUs (dependent on
install orientation) up to 180mm in length.
It'll also house up to four x 2.5-inch SSDs,

or 2x 2.5-inch and 2x 3.5-inch hard drives
instead, and lastly, GPUs will clock out
at around 405mm long, although slightly
shorter will make your life a little easier if
you're running an AlQ in the floor. It's a lot
of case for $109, that's for sure.

pSU_____________ |
1200W Corsair RM1200x

Shift 80+ Gold $206

Big graphics cards require big power
supplies to support them, and with the
way things are going (bearing in mind
that Nvidia's 12VHPWR connector/cable
and the initial design of the 4090 was to
support up to 600W of power draw before
manufacturers kicked up a fuss), we don't
see that changing any time soon.

For a solid testbed, then, having a big
PSU is key. To that end, we're sticking
with the RMx Shift. It's been a staple in a
number of our builds now, and will likely
remain so. Corsair has built the Shift a
little different, as it's shuffled all of the
modular power connectors to the side of
the unit, rather than the rear. It actually
works rather well in our build here (you'll
see why in a bit], but it can lead to some
compatibility issues with other cases, so

do bear that in mind if you decide to make
the jump to the shift life.

Why the shuffle on the power
connectors? Simply put, in any other
traditional case, with the PSU in the floor,
this will place the connectors right in
front of you as soon as you remove the
rear side panel on your chassis, meaning
you don’t have to fumble around, trying to
disconnect or connect a power cable for
that extra SSD you've just bought.

Phanteks M25-120 PWM D-RGB Fans 3
Pack $30
For our backup fans (or exhaust fans, in
this instance), we've gone with a set of
Phanteks M25-120 PWM D-RGB units in
white. These aren’t the most glamorous
of solutions, but if were honest, they
still look great, and pack plenty of
performance. Here’s the thing, though:
they're still A-RGB, and can daisy-chain
into our D-RGB units on our AlO too, so it's
all controlled off a single RGB header for
ease of access.

On top of that, this triple 120mm kit
here is just $30—a great price for a good
quality fan kit. What's not to love?
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MISFIT TOYS

LENGTH OF TIME: 2-3 hours
DIFFICULTY: Hard

his is probably one of the hardest
—|_builds we've had to create here at

Maximum PC, and that's a heavy
statement for us to make. After all, we're
veteran builders here, with hundreds of
published build logs to our name, and
multiple liquid-cooled rigs under our belt,
including a few in some seriously space-
restricted cases.

Yet, throughout this process, working in
the Model 4 had to be approached with an
open mind. We've always been advocates
of the notion that your build process
should be fluid. Take a look at your chassis
before you start installing anything. Try
to identify where you might hit a snag or
bottleneck. Think about your clearances,
and where your hardware will sit. Would
it be easier to install the fans first? Where
will your cables go? Should you wire
everything earlier or later, or chop off
those front panel headers entirely?

System building at the upper-most
level is an intricate puzzle. That's not to
say that the Model 4 is a bad case, but If
you're installing some seriously insane
componentry, youre going to have to
think like this. Mid-range and entry-level
systems with smaller power supplies,
less chunky GPUs, and smaller coolers
will be easier to work around, but if you
intend to push this chassis to its absolute
limit, then buckle up, because it's going to
take some thought.

Fortunately, whenever we thought a
problem was about to occur, the Model 4
quickly pointed out a way it could adapt to
that problem. More often than not, it was
us overlooking a particular element of the
chassis (and not reading the manuals that
came with it) that led to the issues.

As for the core of this build, it's
effectively a  transplant;  moving
one testbed system over to another.
Downsizing, without compromise, in an
attempt to reclaim a bit of desk space, and
build a kick-ass system that doesn’t quite
dominate the entire workspace.

HEART TRANSPLANT

Unlike our typical build order, with
a transplant build, things are a little
different. You'll likely recognize that
system there in [Image 1]—that's our
feature build from the May 2024 issue,
with a few minor alterations to make it
suitable for our testbed scenario. Yep,
we ditched the NZXT board in favor of the
PCle 5.0-supporting 2790 Dark Hero—
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perfect for SSD testing and beyond. You'll
also notice that we swapped those fans
around on the AlO mounted to the ‘rear’ of
the Model 8 to act as intakes instead, and
shifted the Corsair iCUE Link H150i LCD
block around by 90 degrees. The former
was to help keep our cooling in check, and
help while benchmarking GPUs (a couple
of degrees won't hurt you and your build,
but when benchmarking, consistency
is key). As for the latter, that helped
straighten out those tubes a touch, along
with clearance with our larger GPUs.

Still, first things first: a complete
disassembly of our Model 8 system.
Removing the RTX 4080 Super, along with
the memory, and removing the cooler,
before finally getting the motherboard
and the power supply out as well. We've
left a few components in here, too. The
CPU and the primary and secondary M.2
SSDs can stay put during the transfer.

An interesting snag here was on-
board removal. We'd taken out all the
screws securing it in place, but forgot
the additional motherboard standoff
screw underneath that big bulky PCle 5.0
aluminum M.2 heatsink. Many frustrating
minutes later, it clicked, and we removed
the M.2 heatsink and that final screw.

With all the kit finally retrieved from the
Model 8, we set aside the motherboard for
later, making suretoinstallthe NM790into
the PCle 4.0 M.2 slot below the Kingston
drive [Image 2]. One thing to note: you
can see our motherboard’s M.2 Thermal
pads are getting a little battered. You
can buy replacements from Amazon for
around $10. This is highly recommended
if youre an SSD reviewer, but less so if
you're just changing SSDs now and again.

MAKING LIFE DIFFICULT

“Hey Zak, why don’t you take a chassis
with an incredibly compact internal
layout, and use a bespoke shifted power
supply that wasn't designed for it?” That's
pretty much how you can sum up this next
segment. The Model 4 has a unique side
panel and chassis design. We, of course,
did the usualteardown. The side window is
an L shape of toughened smoked glass—
simply lift that off at the hinges. The rear
panelis afolded perforated structure that
sits on top and slides into notches on the
rear, secured up top with push pins.

You remove thatvia a tab at the top back
of the case (just push it up and off). With
that out of the way, you can then begin
to configure your PSU solution. The PSU
will sit at the front of the Model 4, and
you can mount it in two orientations: one
with the PSU power connector facing up
(requiring you to raise the roof and rear
radiator bracket), or one with the PSU
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power connector facing into the back of
the chassis (to the right in [Image 3] ).
Either way, it'll require you to remove
a number of panels to facilitate that,
including that front mirrored panel. There
are six screws that hold it in place—you
can simply slide it out. It's a right-angled
unit, and it took some manual reading and
investigating to find out how to do that.

If you want to go the top connector
route, you have to then remove a couple of
screws in the rear of the case. Back there,
you'll find a thumbscrew on a sliding
mechanism that will let you lift up that rear
metal housing for the radiator housing
(the bit with the Geometric Future logo on
it). Once that's up, secure it in place, and
that’s your new roof. Then, the L-shaped
roof/rear panel will sit on and attach to
that. It all looks flush, connects perfectly,
and everything fits, but now you’'ll have
that PSU power cable pointing up, ready
to connect to the included passthrough.

Rather interestingly, although it's a
tight squeeze, the RMx Shift is probably
the best PSU for the job for a clean build.
The power connector faces out to the rear
of the case, and the Type 5 modular power
connectors for your internal cables are
facing down, ready to be cable managed
through that rear cable hole. It is snug,
though. [Image 4/5] .

CABLE MANAGEMENT

You'll have noticed at this point that we're
going with the power supply first for this
build. Clearances are going to be tight, so
we know we need to take advantage of this
as best as we can. Our build order will be
power supply, initial cable management,
motherboard in, followed with complete
cable install and routing, then bottom
CPU cooler in (with a test fit of the GPU),
before finishing with the top fans, and
lastly the GPU, before a final round of
cable management.

So on we go [Image 6]. Here, you can
see we're going ahead with that plan and
have plugged in pretty much every cable
we're going to need for our system. We've
then threaded those cables through
the cable management hole below, and
wrapped them up as best we can with
the included velcro straps that Geometric
provides in an attempt to keep them tight
and hidden out of the way. One thing to
note: after this shot, we've actually gone
back and added the 12VHPWR600 cable
as well. We'll be tucking that away around
the back of the chassis. It won't be used in
this build, as the RX 7900 GRE still uses
old faithful PCle power connectors, but if/
when we do swap back to an RTX card, it's
going to help to have that connector there.
But yes, cable management is going

to be your friend big time on this build,
particularly with that mildly awkward
L-shaped back panel.

With our PSU now safely secured in
the chassis, we've gone ahead and re-
attached that front panel, making sure
to get as many smudges on the glass as
possible to annoy the photography team.
It does look super clean though.

Installing the motherboard in the
chassis was next on the list. We've already
got the 14900K installed from our last
system (as we're just transferring the
motherboard), so that’s not a problem.
We're not sure what, but something was
causing clearance issues with the board,
not sitting quite flush with its rear 1/0
panel, and the mount-off screws. With
the chassis laying on its side (admittedly
mildly wedged up by a plethora of cables),
we just couldn’t secure more than three
of the nine screws into it. However, with
those three in, we placed the chassis
upright, the board lined up, and we could
install the other six screws [Image 7].

KEEP ON KEEPING ON

So, motherboard in (sort of—we didn’t
spot that we could install those screws
until later), we got to work installing the
cables. Interestingly, the ROG Dark Hero
has an additional 8-pin PCle power port
located below the 24-pin. This is to help
deliver additional power to the graphics
card if it needs it. Honestly, it's overkill,
so we're going to ignore it for this build.
There’s no discernible difference in
plugging it in when running stock, and
where space is a luxury, extra cables can
make or break a rear panel [Image 8].

The last piece of the puzzle is the
remaining cables, and installing the
final items of motherboard hardware we
need. We've installed the two 8-pin EPS
CPU power cables at the top left, and
taken the opportunity to install the front
I/0 connectors as well. Even the USB
3.2 connectors are installed thanks to a
sneaky 3.2 header on the bottom of the
board. Given the positioning of the USB
Type C header, however (again just below
the 24-pin ATX power), and the lack of any
cutout, we've opted not to install the USB
Type C connector for the time being. HD
audio also bit the bullet [Image 9].

With that sorted, it's time to move on to
the CPU cooling, and boy does it come with
a backplate. Check out [Image 10]—that
thing is colossal for an Intel backplate. Is
it needed? No, it's not a heavy water block
by any means, but we appreciate the extra
metal. There’s just something about it
that’s incredibly reassuring, particularly
with that etched-in diagram showing you
where the threads need to go.
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With that done, we installed the
radiator into the bottom of the case. That
was a fairly painless process—it mostly
involved tilting the case onto its side, then
installing four screws into the bottom of
the radiator through the floor. We could
install the fans on top after that. Given that
they're a set of the D120 daisy chain units,
theyre more finicky than some of the
other daisy chain solutions, so first we're
going to install that CPU block. There’s
not a lot to report on here, though. Take
off the plastic cover, line up the block with
the pre-installed plate with the mounts
you popped in when installing that hefty
backplate, then secure in place with the
pre-springed thumb screws. Do this in a
diagonal pattern, a little at a time by hand
until you can’t turn the thread, and you're
all done. We ran the two slim cables up
by the memory around the VRM heatsink
and into that top cable management hole.
There's just a daisy-chainable D-RGB
cable and a single pump fan header—
that's it [Image 11] .

ONLY FANS

Now onto those D fans. They clip together
seamlessly—the only issue is that they
can be a bit finicky to click in, particularly
the single cable part. However, once in,
we flipped them over and attached them
to the radiator, making sure the cable ran
out into the chassis through that cable
management hole up front.

Make sure you don’t preinstall the
screw covers on the wrong side—they're
annoying to remove. We definitely didn't
do it. Also, rather more impressively,
Phanteks sells a ‘reversed’ version of
these fans, with the blades oriented the
other way around in the housing. This
means that the intake has the guard on
it, and the exhaust is unprotected, so you
can get a really clean look, and avoid that
pesky aesthetic problem where the guard
is facing up into your pristine-looking rig,
with voltage labels and exposed wires.

One other note, because these are
clipped in securely, we installed six
screws: one on the top left and bottom
left, and then three more in the middle
fan, leaving the far right fan with just
one screw in the top left corner. It's
secure enough, but unfortunately, due
to a minor oversight (the power supply
was installed, and we didn’t have a small
enough screwdriver to get underneath it),
we couldn't install the last screws to the
right of the fan [Image 12].

With the AIO fans in place, we moved
on to our budget offerings acting as the
exhausts. These are far more traditional
in their design than the D variants, but
even despite the low price, still support

daisy chaining RGB and fan speeds.
We installed these in the roof with the
included fan screws, then ran the cables
around the back [Image 13].

With the bulk of our cabling now in,
and cooling sorted, it was time to install
the GPU. The Model 4 has an odd vertical
bracket plate that sits over the PCle
slots that you have to remove with a
thumbscrew in the rear of the PCle slot
covers. Once that’'s done, you can remove
your traditional Philips screws to get rid
of the two PCle slot covers to install your
7900 GRE. With that done, it's simply a
case of slotting the GPU into position and
resecuring it in place. We then grabbed
the two PCle power cables, ran them
underneath (where the front panel header
cables are routed), and installed them in
place, before re-attaching that vertical
GPU plate in the rear [Image 14].

ARE WE THERE YET?

Almost, but not quite. So the GPU is in.
Now, it's time to get to some more cable
management done before we pop those
final panels on. This time, it's those fans
again. Fortunately, the vast majority of
it can be daisy-chained together. Sadly,
unlike some fan solutions out there,
Phanteks doesn’t have the dedicated
software suite or bespoke cable solutions
to allow for individual fan control just yet.

We've daisy-chained as much of it
together as we can, certainly on the
lighting front. The three D fans in the floor,
and the M fans acting as exhausts, along
with the pump block are running off a
dRGB header on the Z790 Dark Hero.

We could have run the fan speeds off
a single header, but decided against it.
Instead, all three M fans are running off
the CPU optional header, and the three D
fans are on the CPU fan, with the pump
3-pin cable on the AIO pump header on
the board itself.

We've kept the side panel off while we
do final checks on the system to make
sure all the RGB is working correctly
[Image 15]. We've even taken this build
a step further and left it like this before
grabbing a mouse, monitor and keyboard,
to configure the RGB.

With all that done, it's a case of laying
the case down on its side, and carefully
sliding the rear/roof panel back on. The
best way to do this is to lay the case
down on its side, with the components
side facing down on your desk. Cable
management options in the rear are much
better than that in the Model 8, but you've
still only got a few cable tie-offs to work
with, so getting the extra leverage in
that old-school traditional ‘lean-on-the-
panel’ solution works a treat here.
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THE TERRIFYING TINY TERROR

THERE YOU HAVE IT, FOLKS: one super
pristine, clean, black and white, high-
contrast, powerful testbed transplanted
into aridiculously small chassis, complete
with all the bells and whistles you can
possibly ask for, plus 6TB of delicious PCle
4.0 and above storage. It's not pulling any
punches, that’s for sure.

On the whole, the chassis was a joy
to work in. There’s just something about
it that's massively endearing. We're not
sure if that's because it's not a massive
manufacturer releasing one or two
slightly different mass produced cases
every year, but it's got spirit.

It's not perfect, let’s be clear with that.
airflow could be better, flexibility on how
you build in it (although, of course, that is
limited by the lack of internal space), and
things like the rear cable management
could use some channeling or extra
strapping taken into consideration. That
said, where it flies, it absolutely soars.

The GPU sag on the bottom
rightofthe graphicscardis
mildly annoying. Gettinga

supportbracket to give thisGREa
little boost would help aton.

Phanteks actually sellsa
‘reversed’ D fan solution,
wherethebladesare

oriented the other way around
inthe housing, so the guard protects
theintake, notthe exhaust.
Thiswould give these bottom fans
amuch cleaner look, without
sacrificing performance.

Speaking of thatbottom
radiator, the color matching
withitand the white fans

above isn’t great the problem with
matching plastic to metal) and the
Phanteks logois upside down.
Thisisashame, butthere’s notaton
wecando here.

Obligatory Maximum PC
‘would look better with
acustom cable kit

commentinserted here (that's
ajoke, butstill true).

You cantuck a nice 24-inch
white LED stripin the
roof here to really make

the whole build shine just that
little bitmore.
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The mirrored front panel, L-shaped glass,
and versatile internal chassis design do
wonders.

E-ATX is supported as well. We're
using an ATX board here, but you can
theoretically chuck an E-ATX inside.
However, you'll lose access to some of
the cable management grommets, which
we're not sure is a good choice.

If you're worried about space, though,
we can confirm that it's more than
spacious. Even with that bottom AIO
installed, we've managed to install an
RTX 4080 Super Founder’s Edition in here
without a problem, and there’s a good
three inches of room to the right to allow
for longer cards too, if you so desired.
It would be real cramped, though, and
internal airflow might benefit more
from that rear exhaust being switched to
operate as an intake to help chuck some
cool air over the CPU Block and top most
PCle 5.0 SSD.

We also had some concern over the
12VHPWR cable making contact with the
side panel, but there seems to be just
enough space to avoid that cable-bending
conundrum for the time being.

So, aside from that, is there anything
we'd change about this build? Well,
aside from aiming for something more
premium on the GPU front, changing out
those topmost M fans would certainly be
on the list, or the bottom D fans. They're
not bad by any length, but the color of the
LEDs between the two differ by a small
amount, and it's mildly annoying.

Also, to really break up the internal
color monotony, if you do go with a single-
color solution like we have with that bright
orange on the cover, a white LED strip
hidden around the roof would really help
make the build’s internals pop, without
being too visible either. And of course,
sleeved cables, but that's a Maximum PC
given at this point.




BENCHMARKS

ZERO-POINT
Cinebench R23 o
Single-Core (Index) el Zuzdlly
Cinebench R23 o
Multi-Core (Index) 29 LA )
CrystalDisk QD32 o
Sequential Read (MB/s) Eel 7129 (2%)
CrystalDisk QD32 o
Sequential Write (MB/s) R GGl
3DMark Fire Strike Ultra (Index) | 11,135 13,596 (22%)
Cyberpunk 2077 (fps) 29 72 (45%)
Cyberpunk 2077 RTX (fps) 20 15 (-25%)
Metro Exodus (fps) 46 53 (15%)
Metro Exodus RTX (fps) 34 34 (0%)
Total War: Three Kingdoms (fps) | 48 51 (6%)
Core Price ($) $1,368 $2,329 (70%)

0% 10% 20% 30% 40% 50% 60% 70% 80% 90%  100%

Our zero-point consists of the Hyte Y40 build from our March 2024 issue. Featuring an AMD Ryzen 5 7600X, Nvidia GeForce RTX 4070 Super, Gigabyte X670 Elite AC
motherboard, 32GB of Corsair Vengeance DDR5 @ 5600 MT/s, and a 2TB Crucial T500 PCle 4.0 M.2 SSD. All games tested at 4K “Ultra” graphics presets with DLSS
and V-sync turned off and XMP for RAM speed turned on. No manual CPU overclocking. “Core Price” refers to the key components generating performance (CPU,

GPU, Mobo, 0S SSD, RAM), not accessories.

FALLING DOWN THE RABBIT HOLE

BUILDING THIS THING was a challenge,
with lots of cable management, a ton
of chassis disassembly, and more, but
what was performance like? First things
first, we need to caveat those sequential
scores. We've already extensively tested
the Kingston and Crucial T700 in these
hallowed pages, and if you were after the
best bang for buck, that 2TB Lexar NM790
is challenging to beat. With that in mind,
we decided to test that in our sequentials
instead of the two other drives.

That said, all in all, performance was
pretty consistent across the board. We've
compared our Model 4 build against
the Stealth Hyte Y40 system we built in
our March 2024 issue, so we can take
a closer look at the GPUs at play here.
However, it's worth mentioning just how
much performance has dropped on the
Core i9 14900K since its debut. Again, this

is mostly down to those BIOS changes
and tweaks slowly reeling the voltage
and clock speeds back. A quick glance
at our initial Core i9 build from way back
when and you'll see CineBench R23 has
dropped from 2,204 to 2,094 on single
core, and 36,815 down to 34,869 in multi.
That’s a huge drop, and just goes to show
how aggressively these boards were
overclocking the chips to hit those speeds.

Still, compared to the Ryzen 5 7600X
system, single core wasn't quite as potent
as we'd hoped either, with the i9 only
three percent ahead. Our SSD, however,
performed admirably against the T500,
beating it on sequential reads, and losing
by a similar amount on sequential writes.

That aside, it's with the GPUs where
we see far more interesting results.
The 7900 GRE managed to keep up and
even surpass the 4070 Super in some

scenarios, beating it in Cyberpunk and
Metro comfortably, but falling shy in
the ray-tracing department, which is a
common complaint of AMD cards. At 4K,
it's certainly capable of holding its own,
particularly if you lean into AMD’s FSR 2.2
tech, which is great to see for a $550 card,
and it’s nice that AMD has that competitive
edge on Nvidia, at least for the time being,
although it's worth caveating the core
price difference between these two.
Ultimately, the performance is pretty
much where we'd expect, particularly at
thisprice, althoughalotof thatis leveraged
on the CPU and the motherboard driving
that price up. Arguably, the 4070 Super
should perform much closer if it has
those extra cores to play with. Either way,
if you're after a solid 1440p or entry-level
4K gaming GPU, the 7900 GRE is definitely
a good pick.
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the transplant build

EVOLUTION OF FORM FACTORS HOW DID WE GET FROM

ATX TO ITX, EVERYTHING IN BETWEEN, AND BEYOND™

PC BUILDING is only possible because
of consistency. The entire industry,
the ecosystem, the very hardware, is
dependent on that fact. From the humble
transistor firing on a 1 or a 0 each and
every time to DRAM producing the correct
instruction to a CUDA core completing
a physics calculation correctly,
predictability and consistency is key.
Without those, everything falls apart.

Even the componentry has to abide by
a certain set of criteria, and there are a
number of organizations ensuring that
is the case. Most notably, the JEDEC
conglomeratesetsoutmemorystandards,
PCI-SIG declaring PCle specifications for
the last 20-odd years, and many others
ensure that componentry meets similar
specs, voltages, speeds, and dimensions.
Across the board, this has led to the
industry evolving rather smoothly, and
stopped manufacturers from introducing
all manner of proprietary and bespoke
componentry, connectors, and form
factors as a result.

RELEVANT PC MOTHERBOARD FORM FACTORS

Extended

?Ei_l

JUL 2024

Just take a look at the trouble Intel's
been having with its 14900K, and
motherboard manufacturers bypassing
its recommended specifications for its
chips, and you can see why these limits
and specifications are important.

BUT MOTHERBOARD
FORM FACTORS?

Then there’s motherboard and case form
factors, and oh boy, what a whole mess
that is. Check out the
table below to see just
how many form factors
are out there.

As you can see from
our table, the whole
motherboard form factor
sizing debate has had its
fair share of launches over
the years, and we've seen a
ton of them at Maximum PC,
too. Perhaps unsurprisingly,
IBM launched the form factor
race with its XT, AT, and then

Year Acronym Expanded ; Origin
Introduced

1983 XT Extended Technology IBM
1984 AT Advanced Technology IBM
1987 Baby-AT Baby Advanced Technology IBM
1995 ATX Advanced Technology Extended Intel
1996 Micro-ATX Micro Advanced Technology Extended Intel
1998 WTX Workstation Technology Extended Intel
2001 Mini-ITX Mini Information Technology Extended /A UEEIHEE]ES
2003 Nano-ITX Nano Information Technology Extended Inc
2004 BTX Balanced Technology Extended Intel
2007 DTX N/A AMD
2009-2010 XL-ATX Eﬁ:“lj_:gge Advanced Technology e
2015 Mini-STX Mini Socket Technology Extended Intel
277 E-ATX Extended Advanced Technology Various

VIA Technologies

EVGA, Gigabyte,

Baby-AT form factors, before Intel seized
the reigns in 1995 with the ATX form factor
that we know and love today.

Micro-ATX followed the year after,
with Mini-ITX landing in 2001, although
it wouldn't become popular until the late
2000s, with the likes of Intel's Sandy
Bridge architecture finally starting to
bring down power demands.

Although certain form factors have
stayed with us, a number of them have
been one-hit wonders. EVGA debuted
the HPTX form factor, measuring
in at 13.6 x 15 inches in

2008, but only utilized it
P for two motherboards: the
SR2 and SRX. The SR2
supported dual Intel Xeon

processors on the LGA
1366 socket, with an

The problem with E-ATX
isthatas aform factor,

itsort of doesn’t exist,
at least not consistently.

8.5 x 11 inches
12 x 11/13 inches
8.5 x 10/13 inches
12 x 9.6 inches
9.6 x 9.6 inches

14.0 x 16.75 inches

6.7 x 6.7 inches

4.7 x 4.7 inches

12.8 x 10.5 inches

8.0 x 9.6 inches
13.5/13.6 x 10.3/10.4 inches
5.79 x 5.51 inches

12 x 10/13 inches

© MSI
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Intel 5520 Chipset, and up to 12 sticks of
triple channel DDR3, and came with seven
PCle slots, supporting up to 4-way SLI
or CrossFireX. The SRX supported twin
LGA2011 Intel Xeon’s on the C606 chipset,
with up to 12 DIMMs of quad-channel
DDR3 (for up to 96GB of RAM], and sported
7-PCle 3.0 slots, with capacity to handle
4-way SLI or CrossFireX as well.

THE PROBLEM WITH E-ATX

Thenwegetto E-ATX(Extended, Advanced,
Technology, Extended). This is not really
a form factor, as few manufacturers
stick to any one set of dimensions for
it. It launched as a form factor for rack
mount servers measuring in at around 12
x 13 inches. However, the standoff mount
locations were considerably different to
that of ATX. Eventually, two variants of the
form-factor emerged: one for dual-CPU
systems championed by Supermicro and
Asus, with bespoke mountoff locations
(with a few in the same position as the
ATX form factor), but with others custom
positioned, requiring a specialist case.
Then, a number of other manufacturers
jumped on the wagon, creating larger
ATX boards, and labeling them as E-ATX.
Typically, these range in size, with a
height of 12 inches, followed by a width of
anything from 10.1to 13 inches, depending
on specification and added extras.

Standard ATX

CASE ADVANCEMENT

The development of cases has been fairly
steady. Although the majority of case
modificationsyouseeasthehaloproducts,
or what we'd call glory’ features (such
as vertical GPUs, integrated distribution
plates, and LED strips) have mainly come
from the modding arena, the bulk of
chassis modifications and development
has arrived as hardware has advanced.
However, the biggest change-drivers
have originated from a three-pronged
spear of user cases. Habits have changed
since the early 2000s, as the majority of
the community has moved away from
physical media, no longer requiring 5.25-
inch drives. Then there’s the shrinking of
certain component elements, as 3.5-inch
and even 2.5-inch storage solutions are
superseded by M.2 form factor devices,
and we've lost common use of SLI and
CrossFire graphics solutions. More
pressing than that is the end of Moore’s
‘law’, which has led to an increase in
component waste heat generation, as

IS BTF A FORM FACTOR?

BTF is in away a very unique
form factor. It’s still early
days in its lifecycle to truly
understand how as a form
factor it’s going to develop,
however. The one advantage
ITX, ATX, and Micro-ATX
have had is the fact that
there’s flexibility when it

SATA headers, and more
shuffle about, depending
on the size, PCle slots, and
power design requirements
of the board in question.
Unlike that, BTF by its
nature (still technically based
on the ATX sizing standard),
with power connectors facing

or make larger cutouts.
The issue is that if you
make the cutouts too large,
particularly as we already
have chunky CPU backplate
cutouts, you’ll compromise
the integrity and strength of
the internal structure.

That might be fine on

Pico ITX

Nano ITX

i

Motherboard form
factorsare, let’s be
blunt, a mess.

manufacturers look to circumvent the
difficulties imposed by the limits of our
current silicon lithographies.

This has led to manufacturers having
more wiggle room when it comes to
internal case layout, as they no longer
need to accommodate for 5.25- and 3.5-
inch devices. However, the flipside is
that cooling and aesthetics have become
increasingly dominant in this field.

Internal space and efficiency in design
has increased dramatically, and cooling
and glass windows have become more
important. Tempered glass panels, for
instance, can now be found on chassis as
low as $50, while a decade ago you'd be
lucky to get a perspex window for that.

Interestingly, no other company has
cracked a new form factor that's better
thantheoneswehave.|TX,ATX,and Micro-
ATX, the most dominant motherboard
forms, are all pre-2002. BTF looks
promising, but it's more a connection
standard, rather than something that will
radically alter what our PCs look like. ('}

For BTF to succeed, it
needs to be inflexible in
its design and ratified and
adhered to by motherboard
manufacturers. Whether that
will be the case, however, is
yet to be seen, particularly
given the competitive nature
of the partners behind it.

comes to the placement of
the componentry on the PCB
itself. Yes, the socket needs
to goin the top-left center

of the board, and certain
elements have a rough radial
area they need to be placed
in, but time and time again,
we’ve seen EPS power shift
from the top-left to the top-
right, the 24-pin move up and
down to accommodate other
elements, and USB headers,

backward towards the ‘rear
side’ of the chassis, means
that case manufacturers will
need to provide large cutouts
for these components.
There are two angles
those case manufacturers
can go down when it comes
to this one: abide closely
to the BTF form factors
requirements for where
those cutouts need to be
for the power connectors,

the first batch of products,
but if BTF continues to gain
precedent and we see it
expand into more budget-
friendly componentry and
cases, it could lead to some
rather tentative situations
with structural integrity
failing, particularly if a

system is being transported.

The BTF is technically a form factor,
just notinthe traditional sense.

s | 31
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Nate Drake explores
how tools like 3DMark,
Geekbench 6, UNIGINE,
and Superposition
reveal your device's
true capabilities

IN THEORY, using tools to run ‘synthetic’ benchmarks is a great
way to test specific components like GPUs through carefully
crafted workloads. A whole industry has sprung up around this.
Each developer claims to offer the best kinds of tests. Some, like
Geekbench 6 or 3DMark, even have their own scoring system.

Still, winning 10,000 points and a gold star from any one
benchmark doesn’t necessarily mean your gaming rig will
perform optimally with specific applications. This is particularly
true for resource-intensive games like Cyberpunk 2077, and
precisely what makes titles like these popular with reviewers,
who like to subject devices to ‘real world’ benchmarks.

In this feature, we’ll explore some of the most popular
benchmarking software available, and discuss how to run some
‘real world’ tests of your own.

© CD PROJEKT RED, CD PROJEKT, CDP.PL
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© GEEKBENCH

heEekbench 6

| POSITIVES |

£ Simulates real world scenarios

& Scores Single Core/Multi-core
Performance separately

£* Mobile version

GEEKBENCH is one of the best-known
benchmarking platforms, and a favorite
of hardware review sites.

Speaking to Ars Technica in 2023,
Geekbench creator John Pool explained
the inspiration for creating a new series
of benchmarks came in 2005 when he
purchased a Power Mac G5. Dissatisfied

22 Notideal for benchmarking servers

£ Benchmarks aren’t comparable to
other Geekbench versions

) Free users forced to upload results
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the Lua interpreter to
simulate programmers
building their own code.
The ‘Text Processing’
workload uses Python
and C++ to load multiple
| files, then parses their
contents using regular

with existing tests, which consisted of S P by Miareats Widons 1} Hooa G-on) expressions. It also
running arithmetical operations on small o iy iR stores metadata in an
amounts of data, Poole developed his own. ety it SQLite database, then
When it comes to scoring, Geekbench M HA3GA DR SORAN exports the content to a
uses a baseline of 2500 based on CPY infgirmation different format.
benchmarks run on a Dell Precision Hems AL Rycoen T G500H The ‘machine
3460 with an Intel Core i7-12700. A higher | Processur. § Cares, 16 Thietds learning’ workloads
score indicates better performance. Codename: Rembndt involve detecting
According to Geekbench’s documentation, Peholie: foisheciad and highlighting
theoretically this means that if one device il e I objects in  multiple
has double the score of another, it will e b e Lo photos. Geekbench
perform twice as well. CPU Benchmark also measures
Geekbench 6 provides two composite Rurning CPU Beachmark x CPU performance
scores of both single-core and multi- by separating the
core performance. These are calculated m Running CPLI Benchmark background and
using a weighted average of the KNS Brewsss foreground in a

subsection scores. In turn, these scores
are worked out through using the
geometric mean of workloads contained

D007 slapeed

video stream.
| The final set of CPU
workloads focus on how

in that subsection. [ Corveat your device manages

Although this sounds quite involved, —_— editing and synthesis
the results are easy to interpret, and Berkbench messares GPU compate periormanc e forevenyay tasks, incliding I of images. These again
it's relatively simple to compare the :;‘]{::J:f“nf;,‘ﬂﬁ““”““;‘;fgam"mzﬁm'“ simulate real  world
performance of your device to others. tasks like removing

The only downside is that if you choose to
use the free version of Geekbench 6, your
results will automatically be uploaded to
the main website.

On the plus side, Geekbench is a
truly cross-platform application. Mobile
versions are available, and it can even run
on Linux, albeit from the command line.

If you're running Windows, once the
software has been downloaded from
www.geekbench.com| and installed, it
will automatically display key information
about your OS and hardware. At this
stage, all you need to do is click 'Run
CPU Benchmark'.

Unlike many other benchmarking apps,
there’s no graphics rich video or mini-
game to play, but Geekbench offers some
of the very best workloads for real world
benchmarking.

The software will first attempt to run
‘productivity” workloads. This includes
a test of how your device handles file

Geekbench 6 runs ‘real world’ workloads like simulating

opening multiple web pages.

compression, using a 75 MB Ruby source
archive with LZ4 and ZSTD compression
codecs. There's also a ‘Navigation’
workload that generates directions over
24 routes in two different locations via
OpenStreetMap.

Special mention should also go to
the HTML5 workload, which uses a
‘headless’ browser to simulate typical
internet activity by opening, parsing, and
rendering texts for various web pages like
Instagram and Wikipedia. There’s also a
‘PDF render’ workload, which uses park
maps from the American National Park
service and a ‘Photo Library’ workload
to categorize and tag images based on
objects they contain.

Geekbench next runs a series of
‘Developer Workloads' on your device.
These include using Clang to compile

objects from images and
filling the gap left behind,
as well as correcting the
horizon in crooked photos.

Other workloads include applying
filters to images to improve their
appearance, blending six photos to create
a single HDR (High Dynamic Range]
image, and using a custom ray tracer to
render the Blender BMW Scene.

Upon completion of CPU benchmarks
in the free version of Geekbench 6, your
browser will automatically open and
display the uploaded scores for both
single-core and multi-core performance.

By default, these scores aren’'t shown
in relation to anything else, but you can
use the ‘search’ feature at the top right to
search foryourspecific CPUtocheck other
uploaded scores. You can also visifhttps:7/]
browser.geekbench.comprocessor
to view current CPU scores
from highest to lowest.
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UNIGINE Superposition BeEnchmark

& Useful for measuring overclocking
& GPU temperature/clock monitoring
& Mini-game

IF THE NAME of developers UNIGINE
sounds familiar to readers, it's because
they're the authors of a number of other
excellent benchmarking tools, such as
Heaven, which displays a jaw-dropping
representation of a steampunk village
guarded by an ornate dragon statue.

On downloading the 1.2GB installer for
this benchmarking software fron{hitps://]
Ibenchmark.unigine.com/superposition. |
setup offers three options. This is where
we discovered that the ‘Basic’ version of
Superposition supports running 'Virtual
Reality” benchmarks for Oculus and
SteamVR HMDs (Head-Mounted displays).

Superposition also displays a helpful
bar at the bottom indicating how much
VRAM is required for the next round of
benchmarks. If you try to exceed the
available virtual memory, the program
will display a warning and suggest you
lower the settings or use another ‘preset’.
The default preset is "1080p medium’.

Readers may take exception to the fact
that we've noted this as a disadvantage,
given that any program can crash
your device if it has insufficient virtual
memory. Still, we feel that rather than
display a warning, it would make more
sense for Superposition to default to the
least demanding preset (720p Low), then
allow users to adjust settings upwards
accordingly, eg. the ‘8K Optimized’ preset
requires 6241MB of VRAM by default.

2 Limited customization in Basic version

€4 Cancrash if VRAM limit reached

2 ‘Leaderboards’ submissions denied
for modified preset

You can further customize your
benchmarks by selecting ‘Custom’. From
here, you can switch the Graphics API
between DirectX and OpenGL. You can
also toggle fullscreen, change the video
resolution, and adjust quality for shaders/
textures. Bearin mind, however, thatif you
create a custom preset, you cannot upload
your results to UNIGINE's Leaderboards.

Once the settings are to your liking,
the fun begins. The standard benchmark
in Superposition works by displaying a
detailed video using SSRTGI (Screen-
Space Ray-Traced Global Illumination)
dynamic lighting technology.

Theclipinquestionisa 1950s classroom
filled with the dangerous inventions of a
seemingly mad Professor. The experience
is akin to shooting a film scene in a single
take. As the camera pans and zooms,
Superposition will display key stats at the
top right. These include GPU clock speed,
temperature, and ‘utilization’.

As the scene progresses, the camera
goes from simply displaying high-res
scientific equipment to having objects
levitate and move around the room, which
inour tests caused a big spike in GPU load.

Other wuseful information includes
the minimum, maximum, and average
FPS (frames per second), as well as the
current scene number: 17 in total.

It's clear why Superposition is a favorite
of overclockers. Displaying information
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Superposition displays your GPU score, but you’ll need to upgrade to upload it.

JUL 2024

in a standardized way makes it easy to
measure the effects of modifications like
increasing the GPU power limit.

Once the video finishes playing,
Superposition will display a summary of
your benchmark settings, as well as your
system configuration. Your overall score
will also be displayed, along with key stats
like the minimum and maximum FPS,
GPU temperature, and utilization.

You can also click ‘Compare Results
Online’toviewthe UNIGINE Leaderboards.
However, this won't display your results in
relation to others. Make sure you select
the correct ‘preset’ to be sure you're
looking at the right score set. You can also
use the search box to enter the make and
model of your hardware.

Superposition ‘Advanced’ does,
however, support posting your results
on the Leaderboards, as well as looped
stress testing to check hardware stability.
If you don't want to pay $20 for this, you
can get an approximate idea of how
your hardware would handle graphics-
intensive titles by selecting the ‘Game’
option from Superposition.

Before playing, choose a ‘Preset’ that
your system can handle or ‘Custom’
graphics settings to your needs, then
choose 'RUN’. Doing so will transport you
to the same lone scientist’s classroom/lab
but this time you’ll be able to navigate the
room and interact with over 900 objects.

The controls follow the traditional
WASD format, with the mouse used to
change the view. Objects with which you
can interact have a helpful tag explaining
what you can do, eg. ‘Take".

The main advantage of interacting with
Superposition in this way is that it can give
you a clearer idea of how your system
performs when you're carrying out in-
game activities such as moving from
one area to another. Key information like
FPS, GPU clock speed, temperature, and
utilization is still displayed at the top right.

Unlike the regular benchmark, there’s
no set ending, nor will you see an average
of all results during gameplay, but it's a
way to see how your GPU performs under
specific circumstances. For instance,
to push the graphics performance to its
extreme, you can activate the ‘gravity
vortex’ at the far end of the lab.

© UNIGINE
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© 3DMARK

3DMark

| POSITIVES |

4» Many different types of benchmarks
& Transparent scoring system

& Stress tests available

LIKE GEEKBENCH, 3DMark is an extremely
popular benchmarking platform. Its
scoring system is also similar in that
higher marks mean better performance.

There are ‘Advanced’ and ‘Enterprise’
editions for $34.99 (one-off) and $1,695
(per year), respectively. These contain
the most comprehensive sets of tools, as
well as features like custom benchmark
settings and game  performance
estimates. 3DMark also offers free
demos of three tools. In order to access
these, though, you'll need to have a Steam
account to search for and install the 3D
Mark Demo’ via the Steam Store.

Time Spy is used for testing DirectX
12, so will only work with Windows 10
and 11 platforms. The tests are run at
2560 x 1440 resolution. The demo version
consists of two graphics tests and one
CPU test, which are run in that order.

According to 3DMark, the first
graphics test consists of a great deal of
transparent content, particle shadows,
and tesselation. The second features ray-
marched volumetric illumination, with
hundreds of lights and small particles.

During all three tests, the current
frame, FPS, and video duration are
displayed at the bottom of the screen.
You'll then see an overall score, as well
as one for your GPU and CPU. Unlike
certain popular benchmarking platforms,
3DMark gives you an idea of where your

NEGATIVES

i Limited free demos

£} Free versions must be installed via Steam

£ Scores only apply to specific
3DMark versions

Time Spy (pictured) runs two GPU benchmarks and one CPU benchmark.

hardware stands by displaying both the
average and best score for each tool.
Although the ‘Basic’ edition doesn't
allow you to estimate game performance,
you can scroll down further to see a
detailed view of system performance.
This includes the FPS for individual tests
as well as graphs displaying the same,
along with GPU temperature and load.
The final section contains the 'Run
Details". This is an extremely well-laid out
comparison between the performance of
your device and others, such as a budget
gaming PC or gaming laptop. Your device

is ranked along with a percentage result
of its performance—for instance, our
Acer Nitro laptop only performed better
than 20 percent of all results.

If you have a less modern device, the
3D Mark demo also includes ‘Fire Strike’
for DirectX 11 benchmarking, as well as
‘Night Raid’—a DirectX12 benchmarking
tool for devices with integrated graphics.

If you choose to upgrade to the
‘Advanced’ version, you can access the
‘Extreme’ edition of both Time Spy and
Fire Strike. These raise the rendering
resolution to 3840 x 2160 (4K UHD).

SSD BENCHMARKS

While testing your CPU, RAM,
and GPU performance is
vital, it’s easy to overlook
your storage.

Recent years have seen a
decline in the sale of old-style
magnetic HDDs in favor of
SSDs (Solid State Drives),
which are capable of much
faster read and write speeds.

One of the most popular
SSD-testing tools is
CrystalDiskMark, an
open-source tool designed
for Windows. Based on
Microsoft’s Diskspd, this

can simulate read/write
operations in both sequential
and random positions with
various numbers of both
queues and threads.

Head t

|crysta[mark.|nlo7en7|

to view the downloads. As
readers will see, the ‘Shizuku’
and ‘Kurei Kei’ editions

are 200MB and 120MB
respectively, possibly due

to the themes containing
scantily clad anime girls.
Fortunately, the ‘standard’

version is cleaner, containing
abasic Ul and is just 5SMB.
CrystalDiskMark runs five
tests on the main hard drive.
The first two use sequential 8
MiB blocks of data, while the
remainder use 4 KiB blocks.
Use Ctrl + Q to fine tune
these settings, or access
other batteries of tests
via the ‘Profile’ menu. The
options include ‘Real World
Performance’, which focuses
more on random data blocks.
Inthe “Theme’ menu, you
can choose from a variety of

palettes. You can also enlarge
the window— the default
size makes it difficult to see
individual numbers.

There’s no option to
upload the results to
CrystalDiskMark’s website,
nor does the tool indicate that
your SSD is performing within
acceptable parameters.

You can, however, install
it via the main website. This
provides detailed information
of SSD functions, as well
as the temperature and the
drive’s overall health.
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HWMonitor

& Verysmallinstall footprint
& Clear information
& Free version has excellent features

NEGATIVES

2 Not designed specifically for benchmarking

& Hard to compare stats with other devices
2» Takes time to load

HWMONITOR is developed by CPUID, the  [@imai- so it's unlikely that HWMonitor itself
same people behind the excellent system Ee e s — will contribute significantly to CPU/GPU
profiling/monitoring application CPU-Z. 4. o e L i load. You'll gather the most meaningful
It; gvallable as both a free and a 'Pro & flgr. o N data by running it at the same tlm.e as
edition, though as we've noted, the free o wWe m one of the other benchmarking tools listed
edition is likely to offer all the features bt NER omuwEW in this feature, ideally in windowed mode,
required to monitor your system. e e 1. S0 you can monitor your system stats in
Admittedly, HWMonitor stands out, i THEN real time.
as it's no_t specifically designgd for e o Befor_e running any penchmarks in
benchmarking. There’s no clickable o e HWMonitor, open the View" menu and
button to stress-test your hardware, no e s choose ‘Clear Min/Max" to make sure
scoring system, and no automatic way to P i S - the results only apply to this specific
compare what you see with other devices. ez ity .t b test. From here, you can also enable the
However, if you visit fwww.cpuid.com/] e vk e it ‘dark theme".
[downloads/hwmonitor, lyou will find a free i R o e s When it comes to checking
utility for viewing key information like core o ! : temperatures, HWMonitor defaults to
temperature, power consumption, GPU & e - ' listing these in Centigrade. If you prefer
CPU utilization, and S s to use Fahrenheit, go to ‘Tools’ > ‘Options’
utilization, and so on. ks v o o use Fahrenheit, go to ‘Tools” > ‘Options
This is what. makes HWMonitor .such a An e Lo Fo §w|t§h. 'From here, you can alfso l|rT1|t
popular tool with overclockers, as if your SEMB  SWEy ekl utilization” to 100 percent, though if you're
. . . . - AL e dnad T Sraghins H 1
device is heating and/or shutting down pryoncs overclocking, you may prefer to leave it.
unexpectedly, it can give you some insight Faxce If you need to share your results with

into why this might be happening.
The installer itself is only around
1.5MB and the interface is very simplistic,

Use HWMonitor when running
benchmarks to monitor key system
performance indicators.

others, go to 'File’ > 'Save Monitoring
Data’, or hold Ctrl + S to store the stats as
a plain text file.

BATTERY BENCHMARKS

There used to be various
free dedicated programs for
testing battery endurance.
One example was PCMark10
(aka PowerMark), but sadly
this is no longer available.

If you're running Windows
10 or 11, you can use the
0S’s internal diagnostics.
Type ‘cmd’ into the search
bar to open the command
prompt, then run powercfg
/batteryreport. This will
generate an html battery
report, which will be saved to
your home folder.

Open the html file in your
browser, and you'll see a
record of your active battery
usage over the past few days.
The ‘Installed Batteries’
section lists the ‘design
capacity’—the maximum
charge the battery could hold
when brand new. Contrast
with the ‘full charge’ capacity

to determine how much
charge the battery can hold.
Scroll down to the ‘Recent
Uses’ section to view power
states over the last three
days. This can give you an
insight into how quickly
the battery is draining. By
scrolling down to the ‘Battery
Usage’ section, you can see
the duration your device was
unplugged, as well as energy
drain during that time.
Theoretically, you can use
this to calculate the battery
efficiency, but the report
has a dedicated ‘battery life
estimates’ section. Here,
you can view an aggregate
of all the battery data since
Windows was first installed.
This data will change over
time. Even small changes
can make a difference—for
instance, Microsoft Edge
consumes less power than

other mainstream browsers,
like Chrome and Firefox. This
is why independent review
sites like TechRadar also test
the battery capacity of laptops
by playing a high definition
video in a continuous loop.

To go down this route, try to
find an HD video of sufficient
length, and decide on a media
player. We favor VLC [htips:/]
[get.videolan.ord). Not only
isitfree and open-source, it
can also make use of DirectX
Video Acceleration (DXVA) for
hardware acceleration. Tests
run by Microsoft Program
Manager Pierre LaGarde
found that a GPU-enabled VLC
is 70 percent more energy
efficient than using the CPU.

To run a fair test, you need
to configure your battery
settings. Enter ‘Power and
Battery’ into the Windows
search bar to open the

relevant window. By default,
Windows 11 will hibernate
when the battery reaches a
‘Critical’ level of two percent.
To change, this enter ‘Edit
Power Plan’ into the search
bar to open the relevant
section of the Control Panel.
Choose ‘Change advanced
power settings’. Expand
‘Battery’ > ‘Critical Battery
Level’ and change thisto 0
percent. You can also change
‘Reserve Battery Level’ to 0
percent, if you wish.

Once you've clicked
‘Apply’, we recommend
setting system brightness
and volume to an arbitrary
level, eg. 50 percent. Close all
other apps and disconnect any
external devices. When you
open the video in VLC, before
starting your stopwatch, click
the ‘loop’ button at the bottom
to play it continuously.
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© MSI/RTSS, XONOTIC

DIY BEnchmarking

% No third-party programs required
& Easytoimplement
& Based on ‘real’ performance

THE BENCHMARKING tools that we've
reviewed so far are the best ones we
found for simulating ‘real world’
performance of devices. For instance,
Geekbench 6  actually uses a
headless browser to simulate web
browsing activities.

Additionally, software like 3DMark’s
Time Spy carefully measures metrics
while rednering footage similar to
what you would find in a graphically
rich videogame.

Still, it only takes a quick search
on forums like the /r/overclockers
subreddit in order to see that users are
often baffled by the results. The chief
complaints are that their device will pass
popular benchmarks with flying colors,
but games will still not perform to a
sufficient standard.

This is an excellent demonstration of
the old English adage, ‘The proof of the
pudding is in the eating.” In other words,
the quality of your hardware is best judged
on direct experience.

Sometimes, this is easier to resolve,
as certain games, like Cyberpunk 2077,
contain internal benchmarking tools,
which you can use to assess system
performance, particularly in light of any
modifications you've made.

If you arent fortunate enough

to be using a game that supports
benchmarking and configuration, you
can still perform your own tests by

) Stress tests are harder
£} Less customizable tests
£ Can take more time

installing MSI Afterburner (Www.msil
[com/Landing/afterburner).

Afterburner is best known as a
graphics overclocking utility. However,
during setup, you will be prompted to
install RTSS (RivaTuner Statistics Server),
a performance monitor for graphics
cards and APIs. Once the installation is
complete, open MS| and click the settings
icon on the left. Use the ‘General’ tab to
select your principal GPU from the top
drop-down menu. Next, click into the
‘Monitoring’ tab.

Hover your mouse over the ‘Active
hardware monitoring graphs’, and read
through the tooltip. As you will learn, you
can click the tick mark next to each graph
name, eg. 'CPUT Clock’, then check the
box marked ‘Show in On-Screen Display’
to have it appear in-game. Do this for
other key data like GPU temperature and
CPU usage.

The default polling period is one
second, but you can adjust this from
the top of the window if you wish.
Click ‘Apply’ to save changes. We
noted during our research for this article
that MSI can take a few moments to
do this.

Next, find the RTSS launcher among
the ‘hidden icons’ at the bottom right of
your desktop. First, adjust the ‘On-Screen
Display Zoom’™ slider to make sure the
text is large enough. Click and drag your
mouse on the 60" in the bottom box to

By default, RTSS displays key performance monitorsin a transparent overlay in-game.
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Click the tick mark next to the performance
indicators you want to see.

set where the game data will appear on
screen. You can also click into the ‘On-
Screen Display palette’ to adjust the text
color. By default, the stats appear as a
transparent overlay in-game, but you
can enable ‘On-Screen Display Fill" if
you wish.

RTSS cautions that some anti-cheat
systems in games may detect the
kind of application code hooking/
on-screen display required for
benchmarking, and falsely assume
that youre playing unfairly. If this
happens then we recommend enabling
‘Stealth  Mode, which  supposedly
makes RTSS harder to detect. Once you've
done this, it's simply a matter of firing
up your chosen game to view your
chosen stats.

Unfortunately, MSI is focused on
graphicsand CPU performance, sothere’s
no way to monitor hard drive read/write
speeds while you're playing. However, at
the very least, you can identify actions
and areas in-game that subject your CPU,
RAM, and GPU to the most usage. &
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To Stay 100% Private Online

Don't compromise your privacy by using the same old
tools. Robert Irvine reveals the best new ways to block
web trackers, protect your data, and stay anonymous

Privacy is such an important aspect of
our online lives that it’s often exploited
to promote software that’s not private.
‘Keep your privacy under control’,
says the download page for Chrome,
despite Google being court-ordered to
destroy user data it collected through
the browser’s Incognito mode (tinyurl]
‘Maintain your online
privacy’ promises CCleaner, whose
privacy policy states that it ‘collects
personal data in order to personalize
ads for you’

M | JUL 2024

Popular though these programs are,
they undermine your privacy rather
than boostit, while some lesser-known
tools are more trustworthy. Rather
than collect and share information
about your web activities, they protect
you from companies who engage
in intrusive practices by blocking
trackers, disguising your identity,
and letting you easily delete your
private data.

In this feature, we reveal the best
secret software for staying anonymous

online, as well as highlighting new
features and hidden privacy settings in
programs you may already use.

Unlike Chrome’s Incognito mode,
which doesn’t stop sites collecting
your data—as Google now admits—
these tools work exactly as promised,
allowing you to browse the web
discreetly without being spied on.

We’ve chosen a mix of free Windows
software, browser extensions, and
mobile apps to keep you 100 percent
private on every device.
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© UBLOCK ORIGIN, ZEN, CLEARURLS

BLOCK ALL TOOLS THAT TRACK YOU

Block more trackers in web pages
- = Allthe main web browsers now
include tracking protection,
though some (Brave and
_/ Firefox) do a better job than
others (Chrome and Edge) through their
‘strict’ or ‘aggressive’ settings. However,
to stay completely private online by
blocking every hidden tracker, you need
uBlock Origin [ublockorigin.comll

This extension now has around 55
million users worldwide, but it’s still not
as well known as inferior rivals such as
AdBlock and Adblock Plus. Even if you
already use uBlock Origin to block ads,
trackers, and annoyances, you may not
realize that it has additional options for
blocking further privacy risks.

Right-click the add-on’s toolbar button,
choose Options, and click the ‘Filter lists’
tab. Click the arrow next to Privacy and
tick the AdGuard Tracking Protection
and AdGuard URL Tracking Protection
boxes—as well as Easy Privacy, if it isn’t
enabled ( in our screenshot below).
These augment uBlock Origin’s own
filters with rules from freemium service
AdGuard to provide comprehensive, and
constantly updated protection against the
latest trackers—including those hidden
in web addresses. Click ‘Apply changes’,
then ‘Update now' HA.

Annoyingly, Google's new Manifest V3
system, which it's introducing this year,
will limit content blockers to using 30,000
filtering rules—uBlock Origin currently
uses around 300,000—which will make
them less effective at blocking ads and
trackers. To beat this restriction, uBlock
Origin has created a Lite version for

Manifest V3 (tinyurl.com/mrxZudcp] that
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Boost uBlock Origin’s tracking protection
using additional filters from AdGuard.

0 I - 0 %

T Fibter lists
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Zen sets up a proxy to block tracking
requestsin Windows software.

lets you configure its filters on a site-
by-site basis by choosing from Basic,
Optimal, or Complete filtering modes.

Block trackersin
Windows software
8 % Tools such as uBlock Origin

O make it easy to block trackers

in your browser, but it's more
¥/ difficult to avoid them in other
software on your PC. Many programs now
include tracking elements that connect to
the internet in the background to share
details of your activities with developers,
advertisers, and data brokers—and
potentially criminals.

You can block these using a new
open-source tool called Zen ([{inyur
[com/ycfrfdZpt-go to the Downloads
section under the program description),
not related to Zen Internet. This free ad-
blocker and privacy guard sets up a proxy
that intercepts tracking requests from
internet servers and blocks any containing
ads, tracking scripts, malware, and other
unwanted content. By working at a system
level, Zen protects your PC against threats
that browser extensions miss, such as
trackers embedded in Windows software
and system components.

Download and run either the x64
installer or portable version of Zen,
clicking ‘More info’ then ‘Run anyway’
when you see the Microsoft Defender
SmartScreen warning—it's safe to use.
When you first open the program, click
Start then Yes to install its root certificate,
which allows itto check and modify HTTPS
requests. This certificate is privately
generated and stored on your PC.

Oncethisisdone, Zenwill start showing
blocked requests on its Home tab. To
boost its protection, click the Filter lists’
tab and switch on ‘Peter Lowe's Ad and
tracking server list'—further filters can
be enabled in the drop-down menu. If you
have trouble loading a particular website
or program, click Stop to disconnect from
the proxy.

Although Zen isn’t as powerful as paid-
for solutions, such as AdGuard’'s Windows
app [(tinyurl.com/ZwdcZrkv]] it's easy
to use, and you don’t need to sign up for
an account.

Remove tracking elements
from URLs

r ~yMany URLs on websites—
including Google  search
results, Amazon  product

. * _Jpages, and social-media

posts—contain extra code after the main
web address. This is usually for analytics
purposes, to tell site owners when you
clicked the link, the country vyou're
browsing from and the device you're
using, but the code can also be used to
track you around the web.

To stop this happening, install the
extension ClearURLs in your Chromium
or Firefox
browser [tinyurl.com/22vn%hcn]] This
protects your privacy by removing
tracking elements from URLs, and letting
you click through to pages without being
redirected through a third-party service.

You can see how many elements the
extension has blocked by clicking its
toolbar button and checking the Statistics

Statistics
| R = 5o
Elements
Blocked
1 -
Configs
T " .
i
e
T—
i
i
R bors- Statun.

ClearURLs removes tracking code from
URLs, including Google search results.
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section in the information panel. If
ClearURLs prevents some sites from
loading properly, click the Settings cog
and switch off ‘Allow domain blocking'.

Brave and Firefox let you remove
tracking elements when you copy links. In
the former, right-click the link and choose
‘Copy clean link’; in the latter, select Copy
Link Without Site Tracking.

Don’t get tricked by cookie
consent pop-ups
== Cookie-consent pop-ups are
supposed to give you more
control over the data websites
./ collect about you, but are often
so confusing that you end up agreeing to
be tracked. The popular extension | Don't
Care About Cookies solves the annoyance
of these pop-ups by hiding them, but it
also allows sites to install cookies.
Consent-0-Matic is a lesser-known
but more private alternative, which
rejects all cookies by default and hides
consent banners. Available for Chromium

browsers [tinyurl.com/tdwkdus8]] Firefox
(tinyurl.com/ysp/hkc/]] and Safari on
i0S [tinyurl.com/Z7h67tr5]] it lets you
configure its settings to permit essential
cookies while blocking tracking ones.

Click its toolbar button, choose More
Add-0On Settings, and on the Your Choice
tab, select the categories of cookies
youre happy to allow. For example,
‘Preferences and Functionality’ Ellenables
sites to store data such as your login
details and personalization settings, while
‘Ad selection, delivery, and reporting’ &
gives them permission to track you.
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Ad selection, delivery, and reporting

Consent-0-Maticrejects tracking cookies
while allowing essential ones.
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Decentraleyes replaces web content that
could track you with its own files.

You can add rules to Consent-0-Matic
to improve its detection and blocking.
Click the Rule Lists tab and copy the URL
of arule list into the Add List box—get the
one used by | Don't Care About Cookies
from[tinyurCcom/7xwvjdan]

Stop content-delivery
networks tracking you
‘—?“ Lots of websites rely on third-
[' .)'. party services to provide some
/| content, including images,
“ / videos, and fonts. Known as
content-delivery networks (CDNs), these
services help speed up page-loading
times, but they're also able to track you.
This is because once you've viewed their
content, they can follow you to the next
site that uses their network.

Blocking CDNs may cause sites to
break, but you can stop them tracking
you by installing Decentraleyes in your
Chromium [tinyurl.com/myc2adf%] or
Firefox browser [tinyurl.com/3r74rh3nl|
This cuts out the CDN middle man by
tricking websites into loading its own,
locally stored files to display content. By
doing so, Decentraleyes protects your
privacy without affecting browsing—you
can see how many resources it's replaced
on pages by clicking its toolbar button.

It works in tandem with content
blockers such as uBlock Origin, and
without you needing to configure its
settings. If you have trouble loading a site,
click the power button to disable the add-
on’s protection.

Block hidden trackers in

mobile apps

- ™ Some trackers embedded in
" mobile apps collect data about
& A ) your activities to share with
2 ) advertisers and other

companies, not only within the apps
themselves, but in other apps installed on
your phone or tablet. This is why you often
see ads and sponsored content relating to
things you've looked at in one app
appearing in a completely different tool.

The DuckDuckGo Private Browser for
Android [tinyurl.com/yeyxérzz] prevents
this from happening using its App
Tracking Protection feature. As well as
blocking hidden trackers in sites you visit,
it refuses tracking requests in other apps
on your Android device. This stops them
collecting data about you while allowing
the permissions they require to work.

To activate this, tap the three-dot
menu in DuckDuckGo Private Browser,
select Settings, and enable App Tracking
Protection. Tap ‘0K’ to allow DuckDuckGo
to setup a VPN onyour device. This allows
the browser to block trackers ata network
level. DuckDuckGo will tell you how many
tracking attempts it's blocked in apps
in the past seven days, and the apps and
tracking companies responsible.

The i0S browser
doesn't include this
feature, but your i0OS device has its own
setting for blocking app tracking. Select
‘Privacy & Security’ in the Settings app,
tap Tracking, and switch off ‘Allow Apps
to Request to Track’. All new app tracking
requests will be automatically denied.

DuckDuckGo’s Android browser stops apps
tracking whatyou doin other apps.
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© BRAVE, TOR,

MAKE YOURSELF INVISIBLE ONLINE

Make websites forget
you visited them
It's no secret that the incognito
or private mode in your
browser doesn't keep you
~ anywhere near anonymous
online—as Google was recently forced to
clarify. But Brave [ now
has a secret feature called 'Forget by
Default’, which goes further than standard
private-browsing modes by preventing
websites from identifying you.

‘Forget by Default’ works by logging
you out of a site and deleting all its cookies
and other stored data when you close its
browser tab. This means that next time
you visit that site, it won't automatically
recognize you, and tailor its content—and
ads—accordingly.

To access the feature, click the Shields
(lion head) button on Brave's toolbar,
and switch on the option, ‘Forget me
when | close this site’ (see screenshot
below). This will sign you out and delete
all cookies and other data as soon as you
close the current tab.

To enable ‘Forget by Default’ for
every site you visit, click Brave's three-
line menu button, choose Settings, then
Shields, and switch on ‘Forget me when |
close this site’”. You can disable the option
on specific sites to stop them logging you
out by clicking the Shields button and
switching it off.

Visit lorave://settings/content/alll to
confirm that ‘Forget by Default’ is wiping
stored data when you leave a site (some
unremovable cookies may remain).
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Tor Browser routes your internet connection through a series of global relays.

Browse the web anonymously
using Tor
f Brave also has a private-
browsing mode that uses the
il Tor network to stop websites
L= ./ tracking and identifying you. It
recently improved this mode by
automatically loading the onion address of
sites when available, and by redirecting
you to Tor when you try to visit an onion
address in standard-browsing mode.
However, to stay completely anonymous
online, you should use the dedicated Tor

@oe  woo-

Use Brave’s new ‘Forget by Default’ option to stop websites identifying you.

Browser (forproject.orgl] which works in
permanent private-browsing mode.

Tor Browser redirects your internet
connection through an encrypted circuit
of ‘relays’ around the world, which
prevents websites, hackers, and other
snoopers from seeing where you are
and what you do online. It automatically
deletes cookies, site data, and browsing
history when you close it, leaving no trace
of your activities, and offers a choice of
security levels to disable web features
that compromise your anonymity.

Tor simplified the browser’s circuit
system to make it easier to check which
relays (also called nodes) your connection
is being diverted through to disguise your
IP address. Click the Tor Circuit (squiggly
line icon to the left of the address bar (llin
our screenshot above) to view the nodes’
locations and IP addresses. If you suspect
your anonymity has been compromised,
perhaps because you've entered personal
information on a website, click ‘New Tor
circuit for this site” B to be redirected
through a new series of relays.

Tor recently introduced a powerful
privacy feature called WebTunnel,
which stops anyone—including your
ISP—knowing that youre wusing its
encrypted network.

Although Tor Browser lets you access
the so-called dark web, you need to
enter 56-character onion addresses to
visit such sites, so you won't accidentally
stumble across anything illegal. Besides,
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many reputable websites, including
BBC News and Amnesty International,
have onion versions to help visitors beat
censorship and surveillance. The main
drawback is that loading standard sites
can be slow—especially at the browser’s
Safest security level.

Tor Browser also has an Android
app [tinyurl.com/2tzd8nrj] that lets you
browse the web anonymously on your
phone or tablet. Apple’s restrictions
prevent it from working on an iPhone or
iPad, so Tor recommends you combine
Onion  Browser [onionbrowser.comll
which was “developed by someone who
works closely with the Tor Project”, with

its VPN Orbot [tinyurl.com/583h{847/]}
Hide your online activities

with a free VPN

[ A virtual-private  network

(VPN] is the most reliable way

to access the web
L . anonymously, because it
encrypts your internet connection across
your entire device, not just within your
browser (like Tor Browser does). But VPN
subscriptions can be expensive, and free
services usually have catches—from tight
data limits and poor choice of servers to
dubious privacy policies that let them
collect and share your data.

One of the best options is the free
version of ProtonVPN
[free-vpnl] which offers unlimited monthly
data, with no ads and a strict no-logs
policy. It has a 'kill switch’ that takes
you offline when you lose your encrypted
connection, so your anonymity is never
compromised, and a ‘stealth mode’ that
disguises the fact you're using a VPN.
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OnionShare lets you share and receive files privately over the Tor network.

However, this mode is currently only
available in the mobile and macOS apps,
not the Windows program.

Previously, ProtonVPN's free plan
let you choose from servers in the
Netherlands, Japan, and the US, but it
now randomly assigns one when you
click its Quick Connect or ‘Change server’
buttons (see screenshot below).

This makes it less useful for
unlocking geo-restricted content than
for disguising your online activities,
though it recently added free servers
in Poland and Romania. Upgrading to
ProtonVPN Plus for $9.99 a month gives
you access to over 4,500 servers in more
than 90 countries, and lets you use the
service on up to 10 devices [the free
version limits you to one).

Alternatively, Windscribe's free VPN

m/on8msn offers 10GB of

ProtonVPN is one of the few free VPNSs to offer unlimited monthly data.
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data a month (2GB until you confirm your
email address) and access to serversin 10
countries, including the US, UK, Canada,
France, and Germany. Its stealth mode is
available in its desktop and mobile apps,
and its ‘split tunneling’ feature lets you
exclude programs from its protection.

Share and receive files
anonymously
¢ e YOU can use Tor Browser—or a
VPN—to download files from
websites without revealing
“ ! your identity or location, but
it's less easy to share files without
compromising your privacy. For that, you
need OnionShare [onionshare.orgl] which
lets you send and receive files securely
and anonymously over the Tor network.

Install the OnionShare app on your
PC (it's also available for macOS, Linux,
Android, and i0S), click ‘Connect to Tor’,
and select Start Sharing on the Share
Files tile. Add the files or folders you want
to share, and click ‘Start sharing’. This will
generate an onion address your intended
recipient can enter in Tor Browser to
access the shared items—click Copy
Address to paste it into an encrypted
email or chat message. You also need
to send the other person the private key
generated by OnionShare, so they can
unlock the download. Click ‘Stop sharing’
to remove the files once downloaded.

To allow someone to send you files
through Tor Browser, click Start Receiving
on the Receive Files tab, then Start
Receive Mode to generate another onion
address and private key. They can enter
these in the browser to upload files to you.

It may sound convoluted, but
OnionShare is easy to use, and ensures
that no third parties can intercept the files
you're sharing—or detect where you and
the other person are located.

© PROTONVPN, ONIONSHARE
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PROTECT YOUR PRIVATE DATA

Fake your email address

email services you can use to
your real name and email address. The
retrieve important account information.

using an alias
There are lots of temporary
©4
M sign up with websites, so you
can avoid having to share
trouble is that some don't let you return
to your inbox later when you need to
Free services also tend to be swamped
with trackers, so aren't as private as

Encrypt your private
emails in Thunderbird

™ =% ProtonMail - e

and Tuta

o profonme/mall

et provide free e

encrypted email services, i
but limit you to 1GB of k
storage. To keep your current i
email  address, protect
sensitive messages, and

never run out of space, use
the encryption features in
Mozilla Thunderbird

you'd hope.
One solution is to create email aliases
using  SimpleLogin simplelogin.io]]

which is powered by the Swiss privacy
company Proton. Use an alias to register
with a site or service, and SimpleLogin
will forward all messages sent to the
fake email address to your real one—
without revealing the latter to spammers,
scammers, and snoopers. You can
even reply to emails using your alias, to
maintain your disguise.

SimpleLogin’s free plan lets vyou
create up to 10 aliases, either using
your preferred prefix and domain or by
generating a random one (see screenshot
below). Its browser extensions and
mobile apps let you access your aliases
on the fly, and disable them as required.
SimpleLogin’s Premium plan (to which
you get a seven-day free trial) costs $30
ayear, and includes unlimited aliases and
mailboxes, as well as custom domains.

DuckDuckGo includes a similar
feature, Email Protection
lwy|zbvbs]] in its mobile apps, desktop
browser, and extensions. This lets you
create an unlimited number of [[dduck]
[comladdresses, which forward messages
to your real email account and remove
embedded trackers. It's currently in beta,
but works very well.
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Keep your real email address private by
creating aliases with SimpleLogin.

lthunderbird.net]]

Click  the three-line
menu button in the top-right
corner of the main Thunderbird window,
choose Account Settings, then End-to-
End Encryption (£l in our screenshot).
Click ‘Add Key' H, select ‘Create a new
OpenPGP key" and Continue. Choose
your email address in the Identity menu,
specify how many years your key should
work for, and click ‘Generate key’. Click
‘Confirm’, and Thunderbird will generate
your OpenPGP key, consisting of public
and ‘secret’ parts.

To send someone an encrypted
message, you first need them to send
you their public encryption key. Open the
email that contains this key, double-click
the ".asc’ attachment, and click Import to
save the key to Thunderbird. When you
compose a new message to that person,
click the Encrypt button, then write and
send your email. Your public encryption
key will automatically be attached, so the
recipient—but no one else—can decrypt
and read the message.

To share your public key with people
you haven't privately messaged before,
click the arrow next to Attach and select
My Open PGP Public Key. This sends them
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web vault using passkeys.
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Thunderbird’s built-in encryption tools keep
your emails completely private.

an email attachment containing your key,
so they can reply with their key and you
can exchange encrypted messages.

Protect your online
accounts using passkeys
Passkeys let you log into
websites and apps using your
fingerprint, face, or screen-
lock PIN, in the same way you
unlock your PC or phone. Because this
data is stored on your device rather than
with the respective services, they're more
secure and convenient than passwords.
Our favorite free password manager,
Bitwarden [tinyurl.com/3unukxds]] now
supports passkeys to give you a simpler
way to protect your data. Install the
extension [tinyurl.com/yyj873vr]lsign into
your account, and visit a site that supports
passkeys (see the list at passkeys.
directory). Go into the Security section
of your account settings, find the option
to set up a passkey, and choose a login
method—phone, tablet, Windows Hello,
or security key. Bitwarden will offer to
save the passkey—type Bitwarden when
asked. The next time
you visit, you'll be able
to loginviathe passkey.
Bitwarden recently
introduced the option to
sign into your vault with
a passkey rather than
a master password—
click Turn on” under
‘Log in with passkey’
in its Security settings
(see screenshot left).
has also added
passkey support to
the beta version of its
i0S app
ymfcaZhy]l
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WIPE ALL TRACE OF YOUR WEB ACTIVITIES

Delete all your browsing

datain one click

7~ _ 7 Oneofthe most useful features
in DuckDuckGo's browser is
the Fire button, which closes
L *=/ your open tabs and deletes
your browsing data. This includes details
of the sites you've visited; their cookies,
caches, andfavicons; and any permissions
you granted them. It saves you the hassle
of wiping these elements manually, keeps
your activities private, and allows you to
start your next browsing session with a
clean slate.

You can add a Fire button-style
function to other browsers by installing
Clear Browsing Data for Chromium
(tinyurl.com/2xh7fyré] and Firefox
{tinyurl.com/yeym8im2]J This lets you
delete your cookies, cache, form data,
history, and more by clicking its toolbar
button and choosing the relevant option.
Alternatively, wipe all browsing data in
one go by selecting ‘All data types”.

To specify which data to include, go
into the extension’s Options and tick the
boxes in the left-hand menu. You can
more closely replicate DuckDuckGo's
Fire button by setting Clear Browsing
Data to delete all data types and close all
tabs H from its toolbar button El—switch
off ‘Ask before removing data’ to skip the
confirmation prompt.

Clear data from all
your browsers in one go
(" * If you switch between multiple

?ﬂ % | browsers, it's easy to forget
s il | how you may have
'/ compromised vyour privacy,

such as by failing to sign out of a personal
account or delete details of sensitive
searches. Rather than open each browser
in turn, wipe everything in one go using
BleachBit (vww.bleachbit.org).

This clean-up tool detects which
browsers you have, and lists the types of
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Wipe private data from all your
browsers in one go using BleachBit.
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Clear Browsing Data deletes all your browsing information with a single click.

data you can delete, including cookies,
caches, searches, browsing history, and
site preferences. For additional options,
and to include browsers not identified by
default, click the menu button, choose
Preferences, and tick ‘Download and
update cleaners from community’. Click
‘Save’, and you'll see a list of browser
settings, including  ‘blob  storage’
(unstructured data from online services).

Ticktheboxes nexttotheitemsyouwant
to wipe—or the box next to a browser’s
name—and click Preview. BleachBit will
list the elements to be removed and tell
you how much drive space you'll recover.
Click ‘Clean’ to purge your browsers of
private data and junk files.

Remove private data
from photos and videos
™ Digital cameras and
smartphones record
information about photos you
take in the form of EXIF
metadata. This is stored in the image file,
and includes details of when and where
the shot was taken and the device used.
Although this metadata is useful for
organizing photos by date and location,
it poses a privacy risk. Strangers who
study the EXIF data can identify where you
live and where you've been from the GPS
coordinates. For this reason, it's wise to
remove location data from these images.

The best free tool for thisis ExifCleaner,
which you can download from [fnyurl]
[com/var7niwet-click the ‘ExifCleaner-
3.6.0.exe” link under Assets. Drag
and drop images into the program
window, or click Open in the File menu to
select them manually, and ExifCleaner
will automatically remove EXIF data
from the file, and show ‘before’ and
‘after’ figures.

The program supports all main image
formats, including JPEG, PNG, BMP, GIF,
and TIFF, and can strip metadata from
videos. Although it hasn't been updated
since 2021, it has a clean bill of health on
VirusTotal (tinyurl.com/yc3xf42d]l

You can remove metadata from
photos on your mobile device using free
apps such as Photo Metadata Remover for

Android (tinyurl.com/3epwhé8fll and Exif
Metadata for i0S {tinyurl.com/38mx]jyp7]]
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Use ExifCleaner to remove metadata
from photos before sharing them.
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© COVER YOUR TRACKS, ADBLOCK TEST, MOZILLA MONITOR

TEST YOUR PRIVACY USING ONLINE TOOLS

Test the privacy
of your web browser
~ 0 Dont  assume that your
browser’s own privacy settings
will prevent websites from
identifying and tracking you.
Instead, Electronic Frontier Foundation’s
Cover Your Tracks [coveryourtracks.eff]
[oral]tick the box ‘Test with a real tracking
company’, and click Test Your Browser.
The site will tell you if your browser is
blockingtrackingads,invisibletrackersand
fingerprinting, and how much identifying
info youre leaking—scroll to the Detailed
Results section to learn what they are.
In our tests, only Tor Browser and Brave
(with ‘aggressive’ fingerprinting enabled)
offered complete protection.

Confirm your ad blocker
and VPN are working
- ™ Although we  recommend
uBlock Origin, there are lots of
good alternatives—just make
sure your choice works as
promised. Adblock Test
[wy3nuhac] tests the effectiveness of your
blocker against ads, tracking scripts,
analytics tools, social-media trackers, and
other intrusive elements, and gives it a
protection percentage score. Try carrying
out its test with your ad blocker enabled
and disabled to compare the difference. In
our test, uBlock Origin achieved 99 percent
protection, blocking 139 out of 140
elements, but without it, Chrome scored
only three percent, blocking just four.
Similarly, you can check that your VPN
or other anonymity tool is disguising your
IP address by visiting [[Pleak.nefl [hifps:/]
[ipleakoned. If your real location and ISP are
shown in the ‘IP address details’ box, your
privacy isn’t being properly protected.
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Cover Your Tracks tests your browser’s protection against

tracking and fingerprinting.
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Test your ad blocker to make sureit’s
effectively blocking trackers.

Check if your data
has been breached

r ™ Mozilla  Monitor  [monitor]
| o formerly called
L Firefox Monitor, checks your

email address against the Have
| Been Pwned database to determine if it's
been involved in any data breaches. If so, it
displays ‘Action needed’ warnings, tells
you what info is affected, and lets you click
‘Fix all exposures’ to get advice on securing
your accounts. Mozilla Monitor works in all
browsers, and is integrated with Firefox’s
password manager to alert you when your
details have been compromised. You need
aMozillaaccountto use the free tool. Italso

has a paid-for Plus plan, which removes
your personal info from data-broker sites. ()
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CAN YOU CHAT
PRIVATELY WITH
Al TOOLS?

The rise of Al chatbots, such as
ChatGPT and Microsoft Copilot,
has led to privacy concerns over
the way they collect your data.
Queries and commands you enter
are stored and shared to train

Al models, but they're also
linked to your online identity,
including your location, email,
and phone number.

Last year, ChatGPT’s owner,
OpenAl, addressed privacy
worries by adding the option to
let users switch off ‘Chat History
& Training’. You'll find this in the
Data Controls section of the tool’s
Settings on the ChatGPT website
and its mobile app, where you can
also clear your chat history. But
this merely stops your chats being
used for training purposes—
OpenAl will still store them for 30
days, and link them to you.

Brave’s new Leo chatbot (brave]
[com/Teollis more trustworthy,
because it doesn’t require an
account, collect information
such as your IP address or, store
your chats. You could also try
the Android app ‘Chat with Al -
Incognito’ (tinyurl.com/2tkwc5v9l)
which claims to provide ‘complete
anonymity’ by not requiring an
account, storing your data or
allowing third parties to track you.

Y F

Mozilla Monitor alerts you when your passwords are
involved in data breaches.
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Netgear Orbi 970

NETGEAR WAS QUICK off the mark with
its RS700S, one of the first routers we've
seen supporting the latest Wi-Fi 7 standard.
The Netgear Orbi 970 mesh system was
announced around the same time, and
promised to be one of the best mesh Wi-Fi
systems on the market. It's taken a while
to hit retail, but it’s finally ready to ramp up
your home networking performance.

The Orbi 970 goes further and faster than
the standalone RS700 with a three-piece
‘whole home’ mesh system. Capable of a
top speed of 27Gbps and covering areas of
up to 10,000 square feet, there is one catch:
It's phenomenally expensive, with the three-
piece system coming in at $2,299. Ouch.

The cost of the Orbi 970 will probably
rule it out for most home users, especially
those with domestic broadband services
running at around 150Mbps. However, Wi-
Fi 7 isn’t just about speed; it also brings
improved capacity and reliability, and the
Orbi 970 claims to provide fast, reliable
connections for up to 200 devices on your
home or office network. It also includes
new Wi-Fi 7 features, such as ‘preamble
puncturing’, which helps to reduce outside
interference and improve the reliability of
your Wi-Fi connections.

While there aren’t that many computers
or mobile devices that currently support
Wi-Fi 7, the Orbi 970 will still be backward-
compatible with older devices that are still
using Wi-Fi5or 6, soit’sa good way of future-
proofing the Wi-Fi network in larger homes.
-MAXIMUM PC

3 BUILD YOUR NETWORK

This three-piece system can cover areas of up to 10,000
square feet. However, there’s also a two-piece option available,
which covers up to 6,600 square feet for a still rather hefty $1,699.
If you're a Silicon Valley zillionaire, you can extend coverage even
further with add-on units for a mere $900 each.
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data for free?
Nle Peers has
your safety net

. WE ":AE.:-.':I&NOW how priceless our

. personal datais. You can’trecreate photos
and, hand-crafted documents from thin
. air. Another crucial commodity is time:

“how damaging would it be to spend more
than a few hours (never mind 2-3 days)
recovering your system to a usable state?

Armed with the right backup regimen,
you'll never have to worry about losing
more than a few minutes’ work again.
Over the next seven pages, we’ll reveal
how to protect not just your main Windows
PC and everything on it, but your Linux

machines, too. For good measure, we’ll
help you back up key photos, settings, and
apps on your i0S and Android devices, too.
Better still, for the most part, we’ll
show you how to do all this at no cost to
yourself. We'll even reveal a trick for
swapping backup space with a trusted
friend or family member so you can avoid
monthly fees for securing a copy of your
data offsite. Should the worst happen,
we’ll show you how to get your PC and its
contents up and running, too. Read on to
banish data loss to the annals of history.
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how to back up everything [~ ™=

LET'S START with the most important device of all: your main
Windows PC. What we're looking for is a multi-layered solution.
First, there's the need to protect all your personal files and
folders. You might also want to back up selected apps and
settings, such as email. Finally, you want a fail-safe backup of
your entire system, so you can quickly get up and running again in
the event of disaster.

In the past, all the tools you needed could be found in Windows:
File History for files, and Windows Backup and Restore for the
fail-safe backup. Now, Microsoft has decided to focus exclusively
on its cloud sync to the point where the 'new’ Windows Backup
tool in Settings is little more than a front-end for syncing key
personal folders, Microsoft Store apps, and selected Windows
settings to your OneDrive storage.

The problem is twofold. First, it's not particularly
comprehensive, which might explain why File History still lives
on behind the scenes. Second, it assumes that you want to store
your data on Microsoft’s servers. Even if you have a Microsoft 365
subscription to use, can you trust Microsoft with keeping your
personal data safe?

BACK UP PERSONAL FILES AND FOLDERS

When it comes to protecting your personal data, you have two
choices: a traditional regular backup of specific files or folders to
a local hard drive using a schedule, or a sync-based option that
typically backs up data to the cloud or on a network device in real
time. The latter ensures your critical backups are always virtually
up to date, while also retaining earlier versions for additional
redundancy. Examples of sync-based storage include OneDrive,
Google Drive, and the self-hosted Nextcloud.

We recommend mixing both methods for additional
protection—OneDrive users should consider using the main
client rather than rely exclusively on Windows Backup. Like all
cloud-based clients, you'll need to ensure all data you wish to
be backed up resides in the client’s parent directory, such as C:\
Users\Username\OneDrive or D:\Nextcloud).

When it comes to backing up files locally, you have a choice
of two approaches: Duplicati [https://duplicati.com), or Hasleo
Backup Suite (lvww.easyuefi.com], both of which are free.
Duplicatiinstalls asaweb-based service, sois configured through
your browser—see the May 2023 issue for a complete tutorial on
using it. One compelling reason to choose Duplicati is that you
can store backups both locally and online through many cloud
storage services, including OneDrive, Google Drive, Dropbox, and
[Mega.nz]Better still, these backups can be encrypted separately,
so you don’'t need to trust your cloud provider’s own security.

However, if you don’t want to use your cloud storage in this
way—or you have no cloud storage subscription at all, and would

,Dunllcnu PRI — . v i
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Duplicati can handle local and offsite backups.
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Windows 11’s latest backup toolis intrinsically linked to OneDrive.

like to store your files remotely in a different way, as outlined in
the free remote storage box—then Hasleo Backup Suite could be
a better choice, particularly as you'll be using it to take fail-safe
image backups.

BACK UP FILES WITH HASLEO

Launch Hasleo and choose Backup > File Backup. The folder pane
provides a means of browsing your computer for folders and/or
files to back up. You may wish to create a single all-encompassing
backup job orindividual jobs for certain folders. Whichever option
you choose, select what to back up before giving your task a
suitably descriptive name.

Click the folder icon next to choose where to store these
backups—it goes without saying that this should be a
separate physical drive to your original data. Next, click ‘Backup
options’. Click Edit under ‘Image retention policy’, followed by
‘Add backup schedule’.

Hasleo supports both differential and incremental backups
to save space, so we recommend running three separate tasks:
one monthly full backup, a weekly differential backup, and as
many incremental backups as you need. Start by creating the
monthly backup—be sure to change Backup mode to Full, and
check ‘Run missed schedule at the next system startup’, before
clicking OK. Next, create a weekly differential backup, followed by
a daily incremental backup. With this last backup, you can create
a single daily backup or choose ‘Run at intervals’ to take multiple
backups between two specific points (say, working hours). The
more frequently you back up, the less data you risk losing.

Once your backup schedules are in place, examine the image-
retention policy to determine how many of each type to keep.
Check each box (Full, Incremental, Differential), and choose

Make sure your data is backed up at least once a day.
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Create a searchable (and easy to back up) archive of your email.

whether to keep a select number of backups, or for a specific
period (days, weeks, months or years). Check ‘Always retain the
first backup’ to keep the oldest backup you create. How long you
keep backups is up to you—if youre only interested in having
access to recent versions of files, then 1-3 months for each type
will prevent your backup drive from filling up. Click OK.

Work your way through the other options—your backups will
be stored in compressed files to save more space, which you
can encrypt with a password using AES256 encryption. You can
also receive email notifications if backups succeed (or fail). Most
settings are optional, but do select ‘Check the integrity of the
backup image files on completion’—after all, a corrupt backup
isn’t any better than having no backup at all.

Once done, click OK, click ‘Backup schedules’ to verify that
it's noted your schedule, then click OK, followed by Save. Finally,
click Backup to take your first backup.

BACK UP APPS AND SETTINGS

What about other key data, including personal settings? Don’t
be fooled by the promise that your preferences are backed up in
Settings under Accounts > Windows backup. These cover just a
small selection of Windows settings.

Let’s start with your email. Whether your mail is stored in the
cloud or on your PC, MailStore Home (Www.mailstore.com/en/]
products/mailstore-homé) allows you to archive old emails from
arange of sources, including Outlook and Thunderbird, as well as
Gmail, Yahoo! Mail, or indeed, any POP3 or IMAP account. After
connecting your account, you can also choose to free up space by
deleting any emails after they've been downloaded to your new
archive. However, if you do this, make sure your MailStore Home
archive file is backed up separately—given the potential size of
the file, we recommend using Duplicati or Hasleo rather than
entrusting it to your cloud provider.

Most browser settings can now be backed up by signing into an
account in the browser—Edge is linked to your Microsoft account,
and Chrome to Google, while the likes of Firefox, Opera, and
Vivaldi offer their own proprietary accounts. If you don't trust the
cloud or want the added security of an offline backup, consult your
browser’s documentation or forums for details of locating your
profile folder—for example, Firefox users should visit[https:/]

rt.mozilla.org/en- K k-and-restore-information-
[firefox-profiles]for full step-by-step instructions.

When it comes to other programs, you may be able to quickly
and easily store their settings for free with the help of CloneApp
https://github.com/builtbybel/CloneApp)l, = which  supports
around 250 apps and tools. Failing that, look for an export settings
option or consult its documentation and support forums.
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FREE REMOTE
BACKUP STORAGE

If you don’t trust the cloud or can’t afford to pay for
a cloud storage plan, then one way to get secure
offsite storage is through a mutual arrangement
with a friend or family member. That way, you get
to store your data in a remote location without
having to pay an ongoing fee for the privilege.

From here, you have two choices: you can
agree to trade storage space, with each person
giving up some of their own storage to the other.
Alternatively, you can look into swapping hard
drives—choose a network-attached model for
24-7 access and ease of setting up. This could be
your own self-built server, or a NAS from the likes
of Synology or QNAP, basically one capable of
running Syncthing [https://syncthing.net).

The beauty of Syncthing is that you can set
things up at home, complete the initial sync of your
data over your own network, and then pass on the
drive to your friend. Once powered up at their end,
Syncthing will continue to keep your data in sync
going forward. For a complete guide to setting up
and using Syncthing, check out the July 2023 issue.

What's the best way to set up Syncthing for
this purpose? Ideally, you back up to a local drive
first, then simply use Syncthing to transfer the
compressed backup to your remote storage.

One additional security feature is that Syncthing
allows you to designate this remote storage as
‘untrusted’ in the Sharing tab when setting up

the connection. Choose a strong but memorable
password or passphrase, and your data will be
encrypted making it unreadable at the other end.
For more details on trusted connections, including
the steps you'll need to follow should you ever
have to decrypt this data to recover it, see the
Syncthing manual [https://docs.syncthing.net/
vT-277/users/untrusted.htm.

kS

Fernote Dowioes i5)
B b

EF R FRFFER R [

Syncthing makes it easy to share backups between
friends and family.
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It doesn’t matter how diligent you are—over time,
your Windows installation starts to get bogged

down with leftover files, Registry entries, and other
unwanted elements from long-forgotten program
installations. And then there’s the aftermath of a
Windows Update or driver install gone wrong, leaving
your system in a semi-working state. How can you
avoid the rigmarole of a complete Windows reinstall?
One option is to restore your last drive image, but
if that’s more than a few days old, you could end up
losing more than you bargained for. Windows has one
solution in the form of System Restore, but it’s rarely
switched on by default. To use it going forward, type Lt
‘System Restore’ into the Search menu and choose
‘Create a Restore Point’. Select your system drive
and click Configure to verify it’s switched on, and
thatit's been allocated enough space (typically 5-10
percent, depending on the size of your drive). Going
forward, it should take regular system snapshots, as
well as snapshots before key events like application
installations and updates.

Should you need to roll things back, click the
‘System Restore..." button from the same dialog.
You’ll be shown a recommended (the most recent)
Restore point—click ‘Scan for affected programs’ to
see what changes will be reversed, followed by Close
and Next to undo those changes. If necessary, select
‘Choose a different restore point’ to go further back
in time.

System Restore isn’t comprehensive, so there may
be times where it can’t fix things to your liking—in
those situations, you may be forced to rely on an
older image-based backup. Alternatively, take a look
at RollBackRx (around $100 after free trial[https:/]
|horizondatasys.com/rollback-rx-time-machine)) that
provides you with the ability to roll back your entire
PCin seconds, even when Windows refuses to boot.

System Restore remains a viable way to undo certain
system changes.
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Create a full fail-safe backup of your entire hard drive.

BACK UP YOUR ENTIRE SYSTEM

Our final backup is the fail-safe one. It will create an exact
cloned copy of your Windows system drive and everything on it.
This will allow you to restore Windows to a working state with
minimum disruption—even if your entire installation is lost. You
can even use it to restore Windows to a new hard drive if your
original drive fails.

Once again, we're using Hasleo, and the process is broadly
similar to the folder-based backup you created earlier. This
time, choose System Backup under Backup to pre-select all the
partitions required to run Windows. As before, give it a suitably
descriptive task name and choose a location on your backup
drive. Work through the backup options as before. Again, we
recommend setting up the same three schedules—monthly full,
weekly differential, and daily incremental backups. This means
that you'll never have to roll back more than a single day.

Once the initial backup has completed (and been verified),
switch to the Tools section. Here, you'll see an Emergency Disk
option—click this to set up your emergency boot media. In most
cases, you won't need to add any additional drivers, so simply
check ‘Download WinPE components’ if they're not already on
your PC, and click Next. Hasleo will build the emergency boot
media and then give you the option of writing it to an empty USB
flash drive (8GB or larger), or exporting it as an IS0 file for either
burning to DVD or adding to your Ventoy [hffps://ventoy.nef
bootable flash drive.

Ideally, you won't rely on a single backup location for your drive
images—if you have a second drive, then repeat the above steps
to set up a second backup job pointing to the second drive. Make
sure it runs on a different day or time of day to avoid conflicting
with the other backups that youre performing. If you have
network-attached storage, an easier option might be to set up a
Syncthing job to keep the contents of your backup folder synced
to your network rather than trying to save directly to the network
drive each time.

BACK UP YOUR LINUX PC

If you have Linux installed somewhere—either as a complete
installation with desktop environment, or as a minimal server
install—you’ll be wanting to protect that, too. When it comes to
your personal data, you should find that everything you need
to back up is in your personal home folder (/home/username).
In addition, a system snapshots tool provides you with System
Restore-Llike functionality. When it comes to taking a full drive
image of your system, however, things get a little more involved.

© HASLOE, MICROSOFT
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Back in Time covers your file and folder backup needs in Linux.

Let’s start with file-based backups. If you're running a server,
then we recommend Duplicati, because it provides you with a
web-based interface to simplify backup management. Desktop
users should use Back In Time, which isn't included by default in
either Mint or Ubuntu. Install this through the Synaptic Package
Manager or Terminal (sudo apt install backintime-qt).

Once installed, launch the app and select your backup drive
as the location for your snapshots, plus set a schedule—typically
five minutes to an hour. Once done, switch to the Include tab to
select the folders and/or files you want to back up. Use the Auto-
remove tab to manage backups to prevent your drive filling up.

You can create multiple profiles, too, allowing you to parcel out
your backups so that those folders that change more frequently,
like your Documents folder, are backed up more often.

LINUXSYSTEM SNAPSHOTS

When it comes to system snapshots, TimeShift is our tool of
choice. It comes preinstalled in Mint (look under Applications >
System), while Ubuntu users can install it through the App Store
(search for timeshift under ‘Debian packages’]. Follow the wizard,
selecting RYSNC if prompted. Wait for TimeShift to estimate how
much space is required to back up your system, then choose
where to save your snapshots and how often they should be
run. RSYNC ensures that after your first backup, snapshots only
record the changes to your hard drive to minimize the storage
used. Once done, click Create to set up your first snapshot.

TimeShift can also be used from the command line (sudo apt
install timeshift). Use the --help flag (timeshift --help) to see
how to use it, but start by determining which drive to store your
snapshots on:
sudo timeshift --list-devices

The following example sets up TimeShift to take daily
snapshots of your system and store them on the sdb1 drive:
sudo timeshift --create --comments "Daily backup" --tags D
--snapshot-device /dev/sdbl

LINUX DRIVE IMAGES

If you want to take a complete drive image, you can only do so
safely from outside Linux. This means creating bootable media—
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RECOVER OLDER
FILE VERSIONS

Both our recommended backup regimens for files
and folders come with an added benefit: you're not
just storing the latest version of your files, you're
saving different versions, too. Sometimes, data

loss isn’t the complete loss of a file, but the fact

that you’ve made changes that you regret doing

in hindsight.

If you're backing up files and folders through
Hasleo, rolling back involves clicking Actions next
to your data backup job on the main screen and
choosing Restore. Hasleo will show you the date
and time the backup was taken. To restore an earlier
revision, click ‘Change version’ to reveal a popup
menu showing all previous backups by date and
time. Pick the one you want to restore from, then
use the folder picker to browse to the file you wish
to restore. Once selected, we recommend using
‘Restore to..." to select a different folder, so you
can compare this version with your current one.

If it'’s not what you're looking for, try a different
version. This principle is the same when restoring
individual files through other backup tools offering
multiple versions, including Duplicati and Back in
Time in Linux.

If you're backing up your files to the cloud—
including your own self-hosted Nextcloud instance—
then you’ll have more flexibility over which version
to restore, as more frequent backups result in
more file versions to choose from, particularly with
more recent changes. Restoring these files usually
requires you to log in to your account through your
web browser—in the case of OneDrive, for example,
locate your target file and click ... next to it before
choosing Version History. Depending on the file type,
you'll be able to compare versions on screen, then
choose to either download a copy or restore it as the
current version.
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through your browser.
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The unthinkable has happened: disaster has
struck, and you need to restore your PC to its
previous working state. This is where your backups
prove their worth. If you're restoring your Windows
system and are unable to boot into any flavor of
Windows (including Safe mode), simply boot from
your Hasleo rescue media, pressing any key when
prompted to boot from CD or DVD.

You’'ll see the familiar Hasleo interface appear,
and it should scour your drives looking for backups.
Locate your most recent system backup by its time
and date and click the Actions button, selecting
Restore. By default, all the partitions required to
run Windows should be selected—click Next to
verify that ‘Restore to original location’ is selected,
as well as your Windows drive. Click Next, followed
by Proceed, in order to restore your PCto a
working state.

If you run into problems with your Linux
installation, then your first port of call is TimeShift
to see if you can simply roll back to the last working
state (or indeed, an earlier state, if required) from
within Linux itself. Launch the app, select your last
working snapshot, and then click Restore—make
sure your boot device is selected under / while
/boot, and /home can be left as ‘Keep on Root
Device’ in most cases. You can run TimeShift from
the command line or install it from live Linux media
if necessary:

sudo timeshift --restore

If you plan to restore an entire disk image, then
you'll need to use your Linux live media as before
to access Disks. This time, however, you click the
vertical ellipsis button and choose ‘Restore Disk
Image..." Click the folder button to locate your
latest backup image, and click Open, followed by
‘Start Restoring...”

Hasleo’s rescue media works in the same way
as the main program.
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Use TimeShift to add System Restore-like capabilities to Linux.

one option would be to boot from your Ubuntu installation media
and choose to ‘try’ Linux. Once you're at the familiar desktop,
open the Disks utility, select your boot drive, and click the vertical
ellipsis button above it. From the popup menu that appears,
choose ‘Create Disk Image..." and then select your backup drive
as the destination.

You'll also find that Linux is well stocked for other forms of
backup and sync—Ubuntu users should visit Settings > Online
Accounts, where you'll find options for connecting to Google,
Microsoft 365 (OneDrive), and Nextcloud. Other cloud providers,
including Dropbox (www.dropbox.com/install=linux), may offer
official clients. If yours doesn't, see if an unofficial client has been
developed elsewhere, or consider switching to another provider
who does support Linux.

BACK UP YOUR MOBILE

Both Android and i0OS come with built-in backup tools from Google
and Apple respectively, while some Android manufacturers—
including Samsung—may offer their own proprietary backup
services. These should be treated with care, as while they’ll get
you up and running again, they may not be a good choice if you
plan to change phone (and manufacturer) in the near future.

While it's tempting to assume that all is being taken care of
behind the scenes, it pays to verify what’'s going on, plus where
gaps may need filling with specific apps or data. Apple users
should navigate to Settings, then tap your account name, followed
by iCloud. You'll need to tap iCloud Backup to back up your iPhone
or iPad to the cloud, but you'll almost certainly need to be on a
paid storage plan for this to be effective. It's also not a full backup.

A cheaper—and more comprehensive—option is to use your
PC. Apple recently retired iTunes in favor of separate apps: Apple
Music, Apple TV, and Apple Devices. You'll need to first uninstall
iTunes, then install Apple Music (and Apple TVif you've purchased
movies or shows from it). Once done, install the Apple Devices
app to back up your iPhone or iPad.

Start by connecting your i0OS device to your PC with a USB or
USB-C cable, then open Apple Devices. Select your device in the
sidebar, followed by General. Select ‘Back up all the data on your
iPhone/iPad to this computer’, check ‘Encrypt local backup’, and

© TIMESHIFT
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Back up your iPhone or iPad to your PC.

enter a suitably strong—but memorable—password. Finally,
click Apply, followed by ‘Back Up Now'.

Afullbackup can use hundreds of gigabytes of space, and Apple
Devices doesn’t let you choose where to store those backups.
Instead, it places them in separate folders (one per backup)
inside C:\Users\Username\Apple\MobileSync\Backup. If—like
us—your C drive is relatively small, you'll want to store them
elsewhere, but there’'s no option to do so. The workaround is to
create a junction link to C:\Users\Username\Apple\MobileSync\
Backup. Rather than fiddle around with the command line, use
a user-friendly tool like Symbolic11 [https://github.com/Benisgol
[SymbolicTT) to link that folder to another drive.

Once your first backup is complete, you'll need to remember
to periodically connect your i0OS device to your PC for a fresh
backup. Apple Devices is also where you go to restore backups,
while clicking ‘Manage backups’ allows you to remove older,
redundant backups to free up space.

BACK UP ANDROID

Android users should open Settings > System > Backups to verify
your current settings and schedule. You should see confirmation
that your backup is stored online in your Google One account,
along with a breakdown of how much space it takes—the vast
bulk of this will likely be your photos and videos.

All Google users get 15GB of storage space for free, shared
across your Google services. If youre running out of space, tap
‘Photos and videos’ to see how much your photos take up. If
theyre responsible for the bulk of your storage, you have a couple
of options. Thefirstis to tap Plan Settings to investigate upgrading
your plan: a Basic 100GB plan costs $1.99/month ($19.99/year),
while Premium offers 2TB for $9.99/month or $99.99/year.

Take the time to check—and tweak—your phone backups.

If you can't justify the extra expense, then see if changing
Backup quality to ‘Storage saver’ is enough to free up enough
storage. If not, you can disable photo and video backup from your
device using the switch at the top of the page, then investigate
other options.

BACK UP MEDIA ELSEWHERE

If you're happy with backing up to the cloud, but don’t want to
put more money in the hands of either Apple or Google, then
the good news is that you can upload your device's photos and
videos elsewhere. If you're a Microsoft 365 user, for example,
open the OneDrive app and tap Photos to see a notification that
‘Camera backup is off’. Tap ‘“Turn on’ to back up your photos to
OneDrive instead.

If you've set up your own self-hosted Nextcloud instance
(see the October 2023 issue), then you can back up to here, too.
Another self-hosted option supporting both Android and i0S is
immich [[https://immich.app), which we featured in the Holiday
2023 issue.

Also, remember that initial backups can take some time—
check the app for any additional requirements. You may need to
leave your phone plugged in and the app active for several hours
in order to complete the initial upload, for example.

FILL IN THE GAPS

Not all apps are backed up by default to Google One or iCloud.
If you're not using your phone’s standard calendar, contacts
and email app, check to see if it's backed up elsewhere (or is
otherwise hosted in the cloud, in which case it's not an issue). You
might also want to investigate what happens with your messaging
apps—some, like Messenger, will store your messages in the
cloud, while others require extra steps.

WhatsApp users should navigate to Settings > Chats > Chat
backup to verify backups are on and to choose backup frequency
(weekly by default) and whether to include videos (no by default).
Signal users on Android (but not i0S) can also back up their chats
from within the app, but only to a local folder: tap your profile icon
and select Chats > Chat backups. Flick the switch to on—you’ll
be prompted to select or create a backup folder, then record the
passphrase before enabling backups.

Another option, which can be used to back up any folder onyour
Android device, is FolderSync. The app is free (ad-supported)
through Google Play, or you can purchase a Personal license
covering five devices from its websitd [https://Toldersync.ip) for
around $11. This supports a wide range of popular cloud services,
as well as network protocols, allowing you to set up a fail-safe
backup for just about any file on your phone. 1

Back up any folder on your Android phone to the cloud with FolderSync.
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STEP-BY_-STEP GUIDES TO IMPROVING YOUR PC

Apps + Startup

ZAK STOREY

TEST BED
TWEAKING

It's been a busy year for me, or at
least the last six to eight months.
| left a job that wasn't really
working out and pivoted to being a
freelance writer. It was terrifying
at first—the lack of security, the
piecework lifestyle, and pay. But
as | reflect, it's given me a host of

STARTUP PU RGE opportunities and knowledge that
| wouldn’t have otherwise had.
Want to speed up your login time? Fed up with every app under One of those is now being a
the sun launching within 2.5 seconds of you signing in? Us too. }gfr‘;iﬁipslsgi'f?:iﬁtsfu:fe"tfwer
Fortunately, there’'s a super-quick and simple way of stopping That means from Jan 2024, I've
- ; : been testing Intel's 14th gen,
apps from opening up‘ln .Wmdows. Head' to the start menu, moving on to AMD's Latest X3D
and type Startup Apps’. Hit Enter, and you'll get a list of all the chips, every GPU you could think
programs installed on your machine, with the option to disable of, and too many SSDs to count. |

needed a testbed to get the most
them from loading on Windows launch/login. out of those components without
creating bottlenecks. Enter the
Gigabyte RTX 4080, Dominator
Titanium Memory, Asus Z790 ROG
Maximus, and a host of iCUE stuff.
It worked a treat, but as
Computex approaches, I'm
LS W W s it drune Consadn e starting to rethink things.

I oL There are two approaches: an
approximation of an ‘average’
high-end system, complete with
RGB lighting, and over-the-top
‘gamer’ branding and kit. Or, |
could dump the RGB, pick up the
66 70 best Noctua kit | can find, a decent

Edit your photos in | | Master Use your tablet as AlO, and an open-air test bed.

Luminar Neo LibreOffice 24 a PC monitor "W Likely stick with that Crucial
Pro Overclocking memory. Having

XMP and AMD EXPO timings on a
single kit is a lifesaver.

N editor@maximumpc.com
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THIS MONTH WE DISSECT...

Rabbit R1vs Humane

There’s a lot of empty
space inside the Rabbit
R1, which is surprising,
considering how bad the
battery life is.

The Rabbit’s non-clicky scroll wheel turns
out to be a Hall Effect sensor, and has a
magnet inside a roller wheel.

The R1 runs a low-end smartphone chip,
so it’s not capable of doing any local Al
processing—it’s all running in the cloud.

Humane’s

laser projector
uses a pair of
tiny mirrors to
generate a scan-
lineimage—a
bit like an old
CRTTV.

ww.Iifixit.com

© HUMANE Al PIN
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The mainboard powers all the local hardware, with the LLM being based in
the cloud and only accessible with a Wi-Fi or cellular data connection.

The Humane Al Pin is physically the higher-quality device. Apparently, it
was engineered by ex-Apple engineers, and it shows.

Are Al-powered hardware assistants a gimmick, or the
beginning of the end for smartphones? Let’s find out.

RABBIT R1

¢ 2.3-GHz MediaTek P35 MT6765 eight-core SoC

¢ 2.88-inch touchscreen

¢ 4GB RAM, 128GB storage

¢ 8MP stills camera (3,264 x 2,448) with 1080p 24fps video
e Bluetooth 5.0, Wi-Fi with 2.4 GHz + 5 GHz, 4G LTE, GPS

¢ 1,000mAh battery

¢ 115¢

¢ The battery is lithium-polymer, clocking 1,000mAh. A bigger
one is needed, given how fast it goes through a charge.

e The main housing contains a large motor and gear combo
that powers the swivel mechanism on the R1's camera.
Attached is the camera sensor and Hall Effect sensor.

¢ The camera, LCD panel, and small components run by the
mainboard. Everything Al-based is on the cloud. There isn’t
enough processing power for a local LAM or LLM.

HUMANE AI PIN

® 2.1-GHz Octa-core Qualcomm Snapdragon SoC

® 720p monochrome laser projector, 7cm by 9.6cm display at
30cm projection distance

¢ 4GB RAM, 32GB eMMC storage

» 13MP stills camera (4,160 x 3,120) with 1080p 30fps video

e Bluetooth 5.1, Wi-Fi 5 (802.11ac) with 2.4GHz + 5GHz, MIMO
LTE, plus GPS, GLONASS, Galileo

¢ Ix internal battery, 2x booster batteries

 54.7g (with battery booster)

¢ The back cover is essentially a charging coil wrapped in
plastic, but what really stands out is the level of care that
has gone into beautifying the interior.

® The MEMS laser projector uses two piezoelectric mirrors in
a galvo configuration, reflecting light off two perpendicular
mirrors that rotate slightly. There are two mirrors for the X
or Y dimension, which change the laser location.

¢ The mirrors are nicknamed Castor (Circular] and Pollux
(Rectangular). Castor moves back and forth at a set
frequency, while Pollux is quasi-static and can be precisely
positioned. To display an image, a laser shines and reflects
off the resonant mirror to create horizontal scanlines, then
reflects off the quasi-static mirror.

¢ The mainboard powers the local hardware. The LLM is
based in the cloud and only accessible via Wi-Fi or cellular.

As with any first-generation device category, we don’t have
anything to compare the Rabbit R1 or Humane Al Pin to, so
we're not going to score either of these devices. We hope that
any future iteration of similar devices will provide easier
access to their respective batteries. But for now, let’s just
admire the things that Humane and Rabbit did right, cringe at
its shortcomings (like awful battery life), and wait to see how
this new class of hardware evolves. £
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1N Luminar Neo

YOU'LL NEED THIS

have been jumping on the Al bandwagon, but for Luminar, it was
less of a leap. The app, from Ukraine-founded (but now New York-based) Skylum Software, was
already heavily algorithmic, notable for its ability to easily replace skies in photos, as well as
providing the sharpening and color adjustments you’ll find in many raster image editors.

The app has gone through a few name updates since its inception, and now goes by Luminar
Neo, but things have moved on since we last touched on it in 2022. It's available as a standalone
app, and as a plugin for Adobe Photoshop (including Elements) and Lightroom. One thing it's
very good at is spreading its processing load across all the cores available to it, including the
GPU. This means its performance is excellent, and its non-destructive approach to image
editing means edits can easily be rolled back if necessary.

Some image files

It's easy enough to install, and comes with a free trial if you provide your email address. Here
are some of the things you can do using the newly added features. -IAN EVENDEN

GET THE APP
Luminar is easy to install—it’s just a case of downloading

the installer file fromlhttps://skylum com/luminar-triall for

the free demo version. There are a couple ways to pay for it if
you like it—a one-off lifetime payment or various subscription
plans—but the seven-day trial should be enough for you to work
out if it's an app that you want to pay for.

There's little that Luminar can do that you couldn’t achieve in
Photoshop, but Luminar’s secret sauce is to make it all smoother,
easier to approach, and hides all its technical workings behind a
minimal interface.

GET STARTED

There are a couple of ways to get your images into

Luminar. You can add entire folders, including raw images
from your camera, or one image at a time. Both of these options
are found on the File menu, which is hidden behind the Luminar
star logo in the top left-hand corner of the interface [ 1. As
you work on more images in Luminar, they will be added to the
Catalog section, which is also found at the top of the interface.
You can slip into this at any time, and it's an impressively smooth
and fast transition—your work is automatically saved, so you can
switch between images at any time.

Once you've settled on an image to work with, one of the
first things to look at is the Crop tool. This is a staple of image-
editing apps, and allows you to trim away the edges of your
photo, altering the aspect ratio and the composition. Luminar

62 | wuwmg | JuL 2024

has introduced an ‘Al’ version of the tool that attempts to
choose a pleasing composition for you. In our experience,
[ ]it's capable of doing this, placing the subject in
this image nicely according to the rule of thirds, but in
other image we tried, it seemed to get confused, placing
one subject’s face down into the bottom right corner of
the image, preferring to make the clouds that made up
the background the centerpiece of the composition.

Before you can do any of this, however, you'll need to
find the tools—Luminar likes to open with its Presets to
the fore, encouraging you to enter its marketplace and
spend money. To enter the Edit mode, you’'ll need to click
the Edit button at the top.

ENHANCEMENTS

The Crop tool is at the top of the Edit toolbar,

but there’s plenty underneath. The Al tools are
distinguished by a little ‘Al icon in superscript to their
right, and the first of these on the list is Enhance. It's not
a new tool for Luminar, but the Al implementation brings
a fresh twist. Essentially, it's content-aware sharpening
with contrast and saturation tweaks, and by default
it's applied to the entire image. There's a Masking tab,
however, and thisiswhere the new Al smarts are applied.
You can automatically select the subject or background
of an image just by hovering your mouse pointer over
them, and add and subtract from the selection, too.
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Once you've got your selection, you can move the
Enhancement slider and see what it does—there’s only one, so
you don’t get much control over the changes it makes apart from
how strong they are.

SKIES

One thing Luminar is famous for is its ability to replace

the sky in an image. Photoshop can do it now too, but
for a while this was purely Skylum’s area of expertise. Sky is
the next choice on the Edit sidebar list, and you get a lot more
options. There's a masking tab here too, and while it's generally
fine, we found that, like many automatic tools, it was unable to
cope with fuzzy edges, such as the interface between hair and
the background [ ], so using a manual tool, such as a
brush or gradient, or the refinement sliders, on these will give
you a better result. A new addition to this section is a Luminance
mask, which allows you to select only the bright or dark parts of
an image. This is particularly useful for skies.

Once you've told the app what part of the image is the sky, or
allowed it to make up its own mind, you can select from a list of
new skies or upload your own, and they will be inserted into the
composition. From there, you can move back to the Adjustments
panel and play with the lighting of the scene. The three Scene
Relighting sliders affect the brightness and color in the image.
The first two, Strength and Saturation, affect the whole image,
but mostly the background, while the third, Relight Human, picks
out any people in the photo. There are also adjustments that can
be made to the sky, whether you've replaced it or not, allowing
you to throw the clouds out of focus or add an atmospheric haze
effect, as well as tweaking the brightness and color saturation.

ESSENTIALS

The Essentials section of the toolbar contains

tools that you'll be familiar with from other
image-editing apps. There’s little new here, but the
ability to increase or decrease exposure and contrast
across the whole image, or selectively alter the
highlights and shadows, is always useful when you're
touching up photos.

There is an Al tool here in the form of Structure,
though the Al influence is once again only felt in the
masking, where it can select the photo's subject with
all the usual caveats about soft edges. In our testing,
it couldn’t manage the border between hair and sky,
and even missed a fairly strong boundary between the
side of a face and the background. Structure is a detail-
enhancing tool that will bring out the texture of skin, but
begins with the slider halfway along, so it can be pulled
back to soften details and produce a less harsh—and
often more flattering—look.

THE TWILIGHT ZONE
If your tastes run more toward landscape
images, there’s something for you in Luminar
alongside all the portrait effects. The app’s Al-powered
masking can recognize elements such as trees, water,
or mountains in an image, and select them at the press
of a button, so you can work on them separate from the
rest of the image.
Top of the list is the Twilight Enhancer, which has
the same Al-powered masking that works a bit better
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INSIDE LUMINAR NEO

1. MAIN MENU 3. MODES

5. THETOOLS

Keptvery small and in the corner, thisis This is where you switch between the Alist of tools, each with sub-divisions
where you'll find File, Edit, and all that Presets and the Editing tools, or open and usually multiple sliders. They can be
sort of thing. the Catalog in order to quickly swap to collapsed to keep things tidy.

anotherfile.
2.LAYERS
This is used for putting overlays, 4.EXPORT

6.VIEWS
Two buttons to quickly remind

such as light leaks and other Luminar is non-destructive, so doesn't yourself of the originalimage, or
effects, over yourimages while overwrite your original file. Export your to bring up a divider for before and after

maintaining control. work as a new file from here.

on the sharp delineations between mountains, trees, and skies.
There are plenty of tools—some, such as the Twilight Enhancer,
will add a color cast to your image that can simulate shooting at
sunset (the Golden setting), dawn (Blue), and all sorts of colors
in between, while others are designed to only affect the sky, or
water. There's an Atmosphere slider that adds a haze, and you
can control how it interacts with the objects in your image, while
the Al Water Enhancer [Image D] can pick out the wet bits and
alter their color and brightness, though it sometimes needs a
little help in the parts where water passes across rocks.
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comparisons.

THE CREATIVE ZONE
The next set of tools are merely labeled ‘creative’,

which really should apply to the entire app.
These options are essentially one-shot filters in that
they can be applied to the whole image, or masked, and
their strength adjusted, but there aren’t always lots of
options for changing how they look. A good example of
this is Dramatic, a contrast and saturation boost that
has two sliders: Amount and Local Contrast. The next
tool on the list, Mood, offers more control, as it applies
Look Up Tables [LUTSs) to the image that can change the
appearance of your photo quickly and consistently [Image
E]. From the Mood menus, you can find film simulation
looks, or cross-processing effects that can be applied
with a few clicks to multiple images, speeding up your
workflow if you find yourself making the same changes
regularly. The ability to use your own LUTs makes this
especially powerful if you have a lot of files.

PORTRAITS
The Portrait section of the toolbar offers more

new Al capabilities, but also offers tools that skirt
the boundaries of what's acceptable in photo editing.
There are lighting tools that can make a big difference to



the look of a photo, but also options that can enlarge, reduce, or
‘enhance’ particular body parts, particularly in the face. Editing
photos in this way is nothing new, and many magazine cover
images bear little relation to reality, but tools like this do raise
the question over whether it's right to digitally reshape someone.
The facial tools [Image F] pay particular attention to the eyes,
enabling you to change their colorandincrease thevisibility of the
iris, as well as increasing the size of the whole eye and whitening
them. There are some more general ‘enhancer’ tools, one of
which will sharpen and darken eyebrows, and another that can
brighten and soften skin, plus remove what it calls ‘defects’. Are
they really defects, or do they just make a face more interesting?
That’s a long-running debate. It's worth noting that the Slim Face
slider starts at zero, meaning there’s no option to go backwards
and actually make a face wider, which possibly says something
about modern beauty standards.

» The ability of Luminar to slim and ‘enhance’ a face is also
available for the rest of the body. Under Body you're presented
with two sliders, one for Shape and the other for Abdomen, plus
the usual masking to make sure you're applying the changes to
the right part of the image. Shape is effective across the whole
body, and allows you to widen or narrow it, while Abdomen is
mainly applied around the stomach and hips. It's a very easy tool
with which to make something that looks unnatural and comical,

so is best applied sparingly, if at all.
9 Underneath the Portrait section sits a group of tools

marked as Professional, perhaps suggesting they're not
for casual users. In fact, there are some digital darkroom tools

PRESETS

MORE TOOLS

Luminar’s selection of
presets are one-shot filters
that can be quickly applied
to animage. There are
plenty included with the app,
covering everything from
high-contrast monochrome
portraits to cinematic film
looks, and some appropriate
for soft landscapes. Clicking
through them takes little
time, and they are instantly
applied to your image

as a preview just from
hovering your pointer over
them. Each is applied at

100 percent strength, and
comes with a slider you
can use to back off the
intensity. These presets
are customizable, and you
can create your own from
edits you've made using
the Actions menu at the
bottom Left of the interface.
These can also be shared
with other Luminar users,
or backed up if you're
changing computers.

If you feel that you need
more, there’s a whole store
full of additional skies,

that will be familiar if you've used Photoshop, including
dodge and burn brushesto selectively lightenand darken
sections of your image, as well as contrast sliders and a
Color Harmony section that changes the way the various
colors of your image mix and interact. This section feels
more analog than the rest of the app, but despite this, it
allows you a greater degree of control over the final look
of your image. It's ideal for finishing off when the more
automatic tools above haven't quite produced the look
you want, and thanks to the way Luminar works, this
means you can produce multiple versions of an image
quickly. There’s also a Clone Stamp tool, which you
can use to paint over sections of the image you'd like to
remove in much the same way as Adobe’s version.

LAYERS
1 0 In common with a lot of image-editing apps,

Luminar supports layers, which divide your
image into vertical slices that can be stacked, blended,
and otherwise forced to interact in interesting ways. The
Layers palette is on the other side of the interface from
the Tools, and consists of a number of graphical effects
that can be stacked over the top of your image, including
some that you can add yourself or purchase from the
Luminar store [Image G]. Each layer can have its opacity
and blend mode altered, and masks can be used to
control where it is visible over the main image. They can
also be dragged around so that the order in which they
appear is changed, and it’s possible to flip and stretch
them so they better fit your composition. ¢

sl

filters, layer effects, LUTs,
and extensions such as Al
upscaling, noise removal,
or focus-stacking. Many

of these are available as
bundles, though Luminar is

highly extensible, and
its ability to tie into the
Creative Cloud apps as
a plugin means that it’s
easy to integrate into an
existing workflow.
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Master LibreOffice 24

YOU'LL NEED THIS

A RECENT INSTALL OF
LIBREOFFICE 24.2

Java Runtime Environment
(For certain Base features)

LIBREOFFICE BEGAN its life in 2010 as a fork of[0penOffice.ord, which was itself an open-source
fork of StarOffice. This productivity suite is developed and maintained by TDF (The Document
Foundation), which remains loyal to its open-source roots. This means that unlike Microsoft
Office, LibreOffice is cross platform as ports exist for Windows, mac0S, and Linux.

The suite consists of a word processor (Writer), spreadsheet software (Calc), presentation
program (Impress), a vector graphics editor (Draw), an application for editing mathematical
formulae (Math), and a database management program (Base). LibreOffice defaults to the
OpenDocument Format when saving files, but can also open, edit, and save Microsoft formats
like Microsoft Word (.docx).

The most recent release of LibreOffice (24.2.3) was made available in early May, and comes
with some promising new features. While TDF doesn’t seek to emulate Microsoft Office exactly,
LibreOffice does have very similar functionality, with the exception of offering a free online
version in the vein of Office 365. Self-hosted solutions are available for ‘LibreOffice online’ for

those with the time and patience to set up the suite on their own server.
In this tutorial, we'll discuss the basics of setting up and customizing your LibreOffice install,
as well as becoming familiar with the user interface of the principal apps. -NATE DRAKE
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CUSTOMIZE YOUR INSTALL

1 Setting up LibreOffice is a case of pointing your browser
to [hitps://librecffice.ory and clicking ‘Download’. The

installeris available for both 32-bit and 64-bit Windows systems.

» Sharp-eyed readers will see that there are in fact two
versions for download. LibreOffice 24.2.x is the focus of this
tutorial, and contains all the latest features. However, you can
also download LibreOffice 7.6.7. This version is older, but has the
benefit of being more stable due to the longer testing period.

» The default download is for the US English version of Office.
If you want another language or regional variation, such as
British English, click ‘Need Another Language?’ to download the
relevant installer. [Image Al

» If you need LibreOffice to support multiple languages,
during the install process change the setup type from ‘Typical’
to ‘Custom’. Now, you can install features like language packs.

» The custom install is divided into two main sections:
‘Optional Components’ and ‘User Interface Languages'. If you're
happy with the default interface language and just want to install
extra language dictionaries, expand ‘Optional Components’ >
‘Dictionaries’. By default, LibreOffice installs dictionaries for
English, French, and Spanish.

» Take the time to explore other optional features by clicking
on each and reading the feature description. If it's not enabled
already, as a minimum we recommend installing the ‘Windows
Explorer Extension’, which enables File Explorer to display key
information about LibreOffice documents, display thumbnails,
and make the text searchable.
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» If you require the LibreOffice interface itself to be
available in multiple languages, expand ‘User Interface
Language’ to install the packs of your choice. By default,
the English version of LibreOffice supports US, British,

and South African English.
2 Once the install process is complete, open
LibreOffice via the shortcut on the desktop.

» The main window works in a similar way to Microsoft
365’s App Launcherin that you can use it to open existing
files or create new LibreOffice apps.

» This is a good chance to get used to the naming
conventions for LibreOffice apps. 'Writer’ is used
for word processing, while ‘Calc’ is an excellent
spreadsheet program. ‘Impress’ can be used to create
presentations in the vein of Powerpoint, while Base is
broadly equivalent to Microsoft Access in that it can be
used to create and edit databases.

» Click on ‘Templates’ [Image B] to view some sample
LibreOffice documents. Use the ‘filter’ drop-down menu
at the top left to narrow templates down to specific apps
like Writer.

» Double-click to open the very first of these, which is
a template for a business letter. Once Writer launches,
choose ‘Release Notes’ at the top right. This will launch
your default browser, allowing you to learn all that’s new
in the latest version of LibreOffice.

LAUNCH YOUR LIBREOFFICE APPS

© LIBREOFFICE


https://libreoffice.org
http://OpenOffice.org
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» Once you've done this, click ‘File’ > ‘Save As’ from the top left
menu. Once the save dialog opens, you'll note that under ‘Save As
Type’, Writer defaults to its native OpenDocument Format (.odt).
Using this format means your documents will have the best level
of compatibility with LibreOffice features.

» However, sending documents in LibreOffice format can
sometimes cause issues for Microsoft Office users. While Office
nominally supports the OpenDocument Format, files that you
send to users may not display correctly.

» Fortunately, there's an easy fix. Just click the ‘Save as Type’
drop-down menu, and choose ‘Word 2010-365 document’. This
will save the document in .docx format.

» If you want LibreOffice to default to saving in Microsoft
Formats, go to ‘Tools’ > ‘Options’. In the new window, expand the
‘Load/Save’ section, and select ‘General’.

» In the section on the right, choose the drop-down menu
‘Always Save As’, and select your chosen format. Change
‘Document Type’ to do this for other LibreOffice apps.

3 LibreOffice Writer is the suite’s answer to Microsoft Word
inthat you can create and edit text documents of all kinds.

» Although the interface has received online criticism for
being ‘traditional’, it's very simple to navigate.

» If you're starting out with Writer, first make sure to visit the
dedicated help page [hitps://help.libreoffice.ora/latest/en-U3/
text/swriter/main0000.html) for a full rundown of all features.

» The current document spelling/grammar language is
displayed in the bottom pane, e.g. English (USA). To change this,
right-click and select ‘More’. In the new ‘Character’” window,
select the ‘Language’ drop-down menu to switch to a different

LIBREOFFICE ONLINE

The existence of online office suites
like Google Docs and Office365, can
make offline software seem quaint. Of
course, this can also be a strength if
you're in an area with patchy internet

WORKING WITH WRITER

connection, but there’s something to

be said for knowing all your documents

are stored safely in the cloud.
LibreOffice online offers a solution

in the form of server software built

using the suite’s source code. Bad news

first: LibreOffice don’t offer the online

version on their own servers, so you’ll
need to self-host to make use of it.

On its website, The Document
Foundation explains that LibreOffice
Online doesn’tinclude a file system,
which is necessary for accessing files
and authorizing users. It’s also missing
any load balancing tools or features
that would need to be developed for a
viable online version of the suite.

At the time of writing, TDF
has frozen the LibreOffice online
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dictionary, then choose 'OK’. Your chosen language
will appear on the bottom pane. You can also manually
initiate a spell check by choosing F7.

» Unlike Microsoft Office, LibreOffice documents
aren’t automatically saved with your personal details.
To change this, go to ‘Tools" > ‘Options’. From here,
expand ‘LibreOffice’, and choose ‘User Data’. Enter your
personal details in the right hand pane, then click ‘Apply’.

» Entering your personal information in this way lets
you make full use of the ‘Comments’ feature. Simply
highlight any section of text and use Ctrl + Shift + C to
add a comment. Writer will display your name and the
timestamp for each one. In LibreOffice 24.2, comments
can also now use Styles. Access the ‘Styles’ menu to
view options to edit font, size, and formatting.

» Press F5 at any time to open the Navigator window.
This allows you to easily navigate different sections of
the Writer document. The best way to see this in action
is to click the ‘Default Paragraph Style’ drop-down
menu at the top left of the Writer window [Image C], then
choose one of the headings.

» As you add more sections, they will appear in the
Navigator window, along with objects like hyperlinks.

BE CRAFTY WITH CALC

4 As with Writer, Calc has a help page on the main
LibreOffice website (https://help.libreoffice.oraf

. 7 =

with an introductory video and a list of all Calc features.
» We do recommend reading through this. While

Writer can be picked up easily by anyone with a passing

repository, though the code is freely
available. The current version is
designed for personal use only, so
you'll see an ‘unsupported’ notification
if you open 10 concurrent documents
and/or 20 simultaneous connections.

Compiled LibreOffice online
packages are available via Collabora
and the suite can also be installed via
Docker Images. Visit

to discover more.
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familiarity with Microsoft Word, Calc is less intuitive. Although it
can replicate most Excel features, these are usually accessed in
a slightly different way.

LibreOffice 24's Calc now includes a new search field in the
‘Functions’ sidebar. To access this, click the dedicated button in
the right-hand pane, or hold down Alt + 5.

From here, you can enter a function into the search bar at
the top, eg. 'SUM’ [ 1, then double-click the corresponding
function in the pane below to enter the full formula.

As with most spreadsheet programs, when you click on a
cell, the corresponding row number, e.g. 9, and column, eg F, are
highlighted. If you still find this hard to follow, the latest version
of LibreOffice also now supports highlighting the entire row or
column each time you click on a cell. To enable this feature from
Calc, go to View’' > ‘Column/Row Highlighting'.

You can also use the View menu to choose ‘Show Formula'.
As the name suggests, this will display actual formulae used in
sheets. LibreOffice 24 now supports copy and pasting of formula
directly. In other words, once ‘Show Formula’ is enabled, if a
cell’s contents are pasted into a plain text editor, the formula will
appear, not its result. You can also paste formulae into Writer via
‘Edit’ > 'Paste Special’ > Unformatted Text.

If you're working with multiple spreadsheet tabs, Calc now
handles cycling through them a little more intuitively by going
from last to first. Use Ctrl + Tab to switch sheets.

INNOVATE WITH IMPRESS

Although you can go to[https://help.libreoffice.ofdg to

view the comprehensive help guide for Impress, we feel
readers may not need this, as the interface is very intuitive.

Upon loading, Impress shows the current slide in the main
pane. The sidebar on the left lists all available slides. You can
click into these [ 1 or right click inside the sidebar to add
a ‘New Slide'.

The right-hand pane displays slide ‘Properties’. From here,
you can make changes to fonts, text color, spacing, and so on.

If you're fond of adding ‘clipart’ to slides, you can view
Impress’s offline offerings at ‘Insert’ > ‘Media’ > ‘Gallery’. There
are some shapes andicons, but if you want more, click the button
at the bottom right to ‘Add More Galleries by Extension’.

Scrollthrough the gallery sets, then click ‘Install’ next to any
you want made available when using Impress. During our tests,
we found that in order to view the newly installed Clipart, users
must close and reopen Impress after installing extensions.

Aligning slide objects works in a very similar way to
Powerpoint: simply click and drag or hold shift to select multiple
objects, then right-click. From here, you can access the ‘Align’
option, e.g. to align the centers of text boxes and images.

If you want to use animation when switching between slides,
choose View’ > ‘Slide Transitions’. Various transitions will now
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appear in the right-hand pane. Click on each of these to
preview the effect. Click the button at the bottom of the
pane to ‘Apply [this] Transition to All Slides'".

To configure more global options, go to ‘Slide Show’
> ‘Slide Show Settings’. This allows to enable options
like animated images, remote control support and the
presentation mode, e.g. fullscreen.

DOWN WITH DRAW

Draw is a vector graphics editor. It's particularly

good for making flowcharts and technical
drawings, though it can also be used to design media
like posters and brochures. It’s also an excellent tool for
editing PDFs. [ ]

Thisappisnotableinthatithasnoobviousequivalent
Microsoft Office app, though Draw can open Microsoft
Publisher (.pub] files. By default, files are saved in the
Open Document Format (.odg).

If you've never used ‘Draw’, repeat the instructions
in Step 1 to access the LibreOffice App launcher and
open the template flowchart. As you'll see, the current
page is always featured in the center of the window.

The left-hand pane allows you to scroll through
current ‘Pages’. Use right-click to add ‘New’ or ‘Delete’.

By default, the right-hand pane shows the current
page properties, such as the font and spacing, though as
with Impress, this can change depending on the specific
feature you're using. For instance, if you wish to add
images from the media gallery via ‘Insert’, the pane will
change accordingly.

The current version of Draw hasn’t changed much,
though the release notes mention that multi-page TIFF
images are now supported. If you add a picture in this
format (via ‘Insert’ > ‘Image’), Draw will place one image

on each page.
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1.OPEN FILES

Click here to locate office documents on
your system. LibreOffice supports both
the OpenDocument Format (ODF) files
and Microsoft Office documents. Choose
‘Remote Files’ to open documents
stored onservers.

2.FILTER APPLICATIONS

If you're working with a large number of
documents, use this drop-down menu
to display only files of a specific type, eg.
Presentations. This also works when
browsing templates.

3. ECENT DOCUMENTS

Click here to view all files (both local
and remote) that you've opened recently
in the main pane. You can also click the
settings (three bars) at the top right to
clear the log of recent documents.

4. TEMPLATES
LibreOffice comes with a small number
of templates for Writer, Draw, and
Impress. If you can’t find what you need,
visit

.and click into the ‘Templates’
subcategory to download more.

5. CREATE DOCUMENT

Use this section to create a new, blank
document in the LibreOffice app. By
default, the document will save to
ODF format, but you can configure
applications to save in Office formats.

6. EXTENSIONS

Click here to explore LibreOffice

extensions in your browser from
.Youcan

also install extensions from within the

apps. Forinstance, Impress supports

downloading additional image galleries.

ADDICTED TO BASE
In theory, Base is an excellent app for opening, viewing,

and editing databases. Users can work with tables,
queries, forms, and reports, much like Microsoft Access.

» In practice, it's best to check the online documentation first
to make sure it's compatible with your existing database[https:7/
lhelp.libreoftice.org/latest/en-US/text/sdatabase/main.htmll]

» We say this, as some database types are read-only in Base,
such as spreadsheet files, text files, and address book data.

» If you don’t have any existing files then upon opening, Base
will launch its ‘Database Wizard'. From here, you can create a
new embedded database in HSQLDB format. Base also supports
acting as a frontend to a variety of external types of database
like MySQL/MariaDB, PostgreSQL, Microsoft Access, and JDBC.

» Assuming you proceed to create a new embedded database,
you have the option of choosing to register it with LibreOffice.
By default, once you click ‘Finish’, the database can be
opened for editing, though you can check ‘Create Tables using
the Table Wizard".

» This is an excellent and intuitive way to create
database tables, but in order for this feature to work,
you'll need to have JRE (Java Runtime Environment)
installed. Make sure to choose the correct JRE for your
architecture, e.g. 64-bit.

» Once this is done, the Table Wizard allows you to
choose from two broad categories [Image G]: ‘Business’
or ‘Personal’. You can also choose from a number
of ‘Sample Tables’, such as ‘Tasks’, 'Events’, and
‘Employees’.

» Each of these have their own sample ‘Available
Fields', e.g. ‘StartDate’. You can add these to your own
table by clicking on the corresponding entry, then on the
relevant button to list under ‘Selected Fields".

» You can use the View’ menu to switch between
tables, queries, forms, and reports, or just click on the
corresponding icon in the left-hand pane. In each case,
you can use a wizard or ‘design view’ to create your
data set. (2
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second PC monitor

YOU'LL NEED THIS

feels a bit cramped, but you don’t want to pay for a bigger

one? Or need to keep an eye on a website or video stream? Fortunately, if you have a tablet or
smartphone going spare, you can expand your desktop space without spending a penny.

Download the PC software
from[spacedesk.nef]

Spacedesk can turn your unused phone or tablet into an extension of your computer screen.
It does this with two programs: one that sends images to your tablet or phone from Windows,

and one on your mobile device that makes it behave like a connected monitor.

It works by making Windows think the remote device has a physical connection. That way, you
can drag program windows on to your device’s screen and work on them as you would on your
primary display. We'll refer to tablets in these instructions because the bigger screen makes
them more suitable as monitors, but our steps work the same for phones. -NIK RAWLINSON
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INSTALL SPACEDESK ON YOUR PC

Start by downloading Spacedesk’'s PC software from

[Spacedesk.net]where you'll find options for 64-bit and 32-
bit Windows in the section called ‘Spacedesk Driver Software for
Windows Primary PC (server)’. Most modern PCs will need the
64-bit version, but if you're not sure, open Settings by pressing
Windows key+l, then click System followed by About, and check
the version beside ‘System type’".

Click through the installation instructions and, when you
reach the Firewall Configuration page, leave the box ticked
beside ‘Add an exception to the Windows firewall for spacedesk’
[ 1. If you disable this, connections between your PC and
your tablet will be blocked, and you won't be able to use the
device as an extension of your main PC screen.

When you've completed the last screen of the instructions, it
will proceed with the installation. This throws up a User Account
Control alert asking if you're happy for the program to make
changes to your PC. On our machine, this alert was minimized
in the taskbar, so it wasn’t easy to spot, and gave the impression
that the process had stalled. Keep an eye on your taskbar in case
this happens. Once installation has completed, click Finish.

INSTALL SPACEDESK ON YOUR TABLET

Download the app on your tablet
from tinyurl.com/3td8cc8Y (Android);

tinyurCcom/327psded (i0S, iPad0S); or [finyurl.com/wZ3dbad
(Kindle Fire), then launch it. If you've installed the program on
your PC, dismiss the message telling you to download it.

The app will now start searching your local network for your
PC and, when it recognizes it, display its IP address. It's made up
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of four sets of digits, with the first three generally being
the same across the whole network, while the final set
will be anything between 0 and 254 (to accommodate a
maximum of 255 devices on your network).

Our tablet found a PC using the IP address 10.0.0.68.
We checked this was correct by comparing it to the
information shown in the Spacedesk Driver Console
software that we installed on Windows. You can launch
this from the Start menu and, when it appears, check
the address in the Communication Interfaces section. In
[ 1, we can see the same IP address: 10.0.0.68 L.

To double-check, we make sure our computer’s
name (GOGOL #) is displayed at the top of the right-
hand column in Driver Console, as well as at the top of
the home screen on the Spacedesk app on our tablet.

MOVE WINDOWS TO YOUR TABLET
Tap the computer’s address in the app, and
the devices will connect, your tablet’s display
behaving like a touch-sensitive extension of your screen.
You can now drag windows from your PC to your
tablet. However, because Spacedesk can’t automatically
work out where your tablet is sitting in relation to your
computer screen, you may need a little trial and error.
We found that dragging windows to the right of our main

spacedesk Driver Console
ON
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display, slightly above halfway, transferred them to the tablet’s
screen, even though our tablet was to our left, flat on its back.

» Once the window is on your tablet’'s screen, control it by
clicking with the mouse or tapping it with your finger. If you want
to use your fingers on the tablet and your mouse and keyboard to
control your computer, you don’t need to make more changes, as
long as you're happy with how the screens are configured.

RECONFIGURE YOUR SCREENS
4 If you want to move your cursor off the edge
of the main screen nearest to your tablet
screen so that it travels toward it, tell Windows where
they sit in relation to one another. This makes working easier
when sweeping the cursor off your PC’s screen and back again.

» To do this, click the up-arrow on your Windows taskbar to
reveal your hidden icons, then right-click the Spacedesk driver
icon, followed by ‘'Windows Display Control Panel'.

» This will take you to the Display pages of the Windows
Settings program, where you'll see a graphic of your screens.
The larger one, [Image C] labeled 1, il is your PC screen. The
smaller screen Fin the top-right corner (labeled 2) is your tablet.

» If this is less clear in your setup, you can ask Windows to
identify each one. Click the Identify button, & and it will display
the relevant numbers in the corner of each display.

» Use your mouse to click and hold the number 2 (tablet) box
in the Settings window, then drag it around the number 1 box.
Let go when its location roughly equates to your tablet’s position
relative to your PC screen. When you've finished, close Settings.

» You're not restricted to just one external tablet, nor to
working with tablets. We installed Spacedesk on an iPad Pro,
Kindle Fire 8 tablet, Google Pixel 5 phone, and iPhone 15 Pro,
and set them all running simultaneously.

» You can see the result in [Image D], where our primary
monitor is surrounded by four smaller screens. This allowed us
to move our cursor and program windows from one to the other.

Now that you're set up, you can use your second screen as
a place to put programs that might get in your way.

» If you prefer not to use your finger to control a program on
your tablet screen, you can use your mouse. Your PC’s keyboard
will work just as well in any program on the second screen—just
make sure the program is active and selected.

» Spacedesk also has its own on-screen keyboard—you’ll find
it by tapping the three-line menu button on the tablet screen,
followed by Keyboard (you can move this menu around by tapping,
holding, and dragging it to any position you want). However, using
the on-screen keyboard in wireless mode is a premium-only
feature, which requires an upgrade to the commercial business
licence on an Android device for an additional fee.

5 USE PROGRAMS ON YOUR SECOND SCREEN
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» Spacedesk hasn't yet added this licence to the iPad,
iPhone, or Kindle Fire editions of the software, although
you can use the keyboard for free on Android or Kindle
Fire by connecting via USB rather than wirelessly.

» If you do connect with USB, open the
Spacedesk Driver Console software on your PC and
click the Communication Interfaces header. Now, untick
the box beside Local Area Network, and click in the box
below it.

» When the connection has refreshed, tap the three-
line menu button on your device, then tap Keyboard. Tap
within the window of your active program, and you can
use the on-screen keyboard in place of the keyboard
attached to your PC. 0

USE AN OLD LAPTOP
AS YOUR SECOND

At the start of this feature, we downloaded Spacedesk
toour primary PC (or ‘server’ in Spacedesk terms). This
handles the sharing of the virtual display connection with
asecondary device (called the ‘client’). So far, we've only
used a phone and tablet as the client, but you could use an
old laptop. Rather than download another copy of the server
software to the laptop, go to the Microsoft Store at

and install the client software.

Once launched, it should spot your main PC across
your wireless network. Click the primary PC’s IP address
in the Spacedesk client on your laptop, and the two will
connect, with the Windows desktop of your main machine
extending into the window now shown on your laptop (Ki
in our screenshot). Hover over that window, and click the
Fullscreen button Eso it fills the whole display.
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tested. reviewed. verdictized.

JEREMY LAIRD, CONTRIBUTOR

FIRST, A TERRIBLE confession. My daily
driver is not a PC. It's a Mac. But before
you gather the pitchforks, hear me out. For
starters, my main fun rig is, of course, a
powerful desktop PC. | also use a laptop PC
to drive my home cinema.

The Mac really only gets used for web
browsing and text editing, plus some casual
content creation. But the main reason it's
a Mac is because it needs to be portable.
| want to be able to pick it off my desk and
take it into the office while maintaining its
working state. Right now, only Apple offers
a truly solid state laptop, or at least one that
offers good performance and features as
opposed to a glorified tablet PC running
Atom cores or something similarly hideous.

| speak, of course, of the MacBook Air
with Apple silicon. Once you've lived with
a truly solid state laptop, one with not only
solid state storage—which has long been

Portable PCs with moving parts

Solid state

the norm—but also no active cooling, fans,
or pumps, every other portable seems
awfully clunky. It actually makes you
wonder how anyone thought it was a good
idea to have laptops that screamed under
load while they cooked their innards. It's all
a little bit silly.

Well, for most mainstream laptops, that
could all soon be history. The first Windows
laptops using Qualcomm’s new Snapdragon
X Elite CPU have been released. You'll no
doubt see coverage of them in these pages
over the coming months. It’s yet to be seen
just how good the X Elite is, but critically, it
uses the same basic Arm CPU architecture
that allows Apple silicon laptops to be so
efficient.

As far as | know, all of the first X Elite
laptops do actually have active cooling.
But then, so does a MacBook Pro—it’s just
it barely ever activates. In any case, the X

Want to experience the future of PC laptops?
Try a MacBook Air.

Elite is just the first of what you might call
a new generation of proper’ Arm chips for
PCs. Several other companies, including
Nvidiaand AMD, are rumored to be working
on their own Arm chips for the PC. I'd be
amazed if you couldn’t buy a totally solid
state PC laptop with excellent performance
very soon.

Of course, the absolute highest
performing portables are always going
to use active cooling. My Razer Blade 15
gets so hot just above the keyboard that it
can actually burn skin, but that’s mostly
because of its powerful GPU, something
that can't be solved with Arm CPU cores.
But | fully expect to be able to have a solid
state daily driver PC to replace my MacBook
pretty soon.

Editor-in-Chief

The upside of building your

resident building expert, Zak

GUY COCKER

Frustrated, |

looked at

H7 Elite case, thanks to its
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own PC is the flexibility to
create a system to your
specifications. The downside
is that there’s no one to call
when things go wrong, which
in my experience, they do.

For the last two months,
my vyear-old rig had been
crashing about twice a day,
and it was impossible to play
a game without it stalling. Our

JUL 2024

Storey, suggested it was down
to either my NZXT C1000
power supply or Gigabyte Z790
GAMING X AX motherboard.

In our photo studio, |
grabbed a few spare parts to
try and diagnose the problem.
First, a replacement C1000
PSU was installed into the
existing system, but my PC
refused to boot.

motherboard options. Sadly,
all | had were older 7690
boards, which would require
BIOS updates to support my
Intel Core i5-13600K CPU.
Firstly, an Asus ROG STRIX
2690-E Gaming WiFi seemed
like an easy swap, but it didn't
boot either. Next, an EVGA
7690 DARK KINGPIN, which
wouldn’t even fit in my NZXT

larger E-ATX form factor.

My final option was
an NZXT N7 Z690 mobo,
which worked like a charm.
True, | had to pair it with
older DDR4 RAM, but this
has little impact on gaming
performance. The main thing
is | have a working desktop
again, and one | can play
games on. Such luxury!

© APPLE CORP



The Eufy L60 Robot
Vacuum is a potential

life-changer.

© EUFY, GEARBOX PUBLISHING, THE BROWSER COMPANY

Editor's Pick:

Eufy L60 Robot Vacuum

The cleaning revolution is here

AS YOU MAY know from
my many ramblings on
these pages, | nowwork
as a barista during the
day for a local coffee
shop,and asafreelance
journalistinthe evening
and on days off (terrible work-Life balance,
would not recommend). When | started
doing this, it took quite a toll. Not only on
my fitness and health, but on my home life
as well. I'm a massive contributor in the
Storey household when it comes to chores.
Cooking, cleaning—I do the bulk of it.

Changing jobs and how you work is
never easy, and adjusting to that new way
of living takes time. | knew this was going
to be the case—going into freelance, in fact,
it usually takes around six months to really
get settled.

Anyway, in late January this year, | was
still very much adjusting to the new flow. |
have a heavy shift at the coffee shop of 6am
to 3pm on weekdays. It's busy, and I'm very
tired. My bosses are kind enough to let me
get parcels delivered directly to the store,
which is really helpful, as I'm only home
one day a week. Generally, | walk to work
aswell. It's only about 10 minutes each way,
but going home requires me to climb up a
massive hill. On this particular day, | got
three parcels delivered—all of them brand-
new Super graphics cards.

Because | have so many parcels, out
of kindness, a close colleague of mine,
Lauren, offers me a lift home. | knew at this
point that a) my dog has been home for five
hours on her own, and b) the house is in a
bit of a state. I've got far too many parcels,
packaging, cardboard, and washing. It's
all over the place. Still, it's three heavy
boxes, Lauren is adamant that | accept, and
wants to see the dog (she’s the best kind of
person: a dog person). So reluctantly | say

yes, but pre-warn her that the house is a bit
of a state and not to judge me.

Lauren gives me a lift home and comes
in to see the dog, who gets overly excited
because she loves people, and decides
to accidentally urinate on Lauren’s foot.
Great. Real swell time for me. | apologize
profusely, clean up, keep apologizing [still
to this day), and Lauren goes on her way
(we're still friends, don't worry).

So at this point, | am wracked with guilt
and shame. My other half rings me up on
her way home, | explain the situation, she
calls me an idiot because | knew the house
was a mess, and then promptly takes me
to McDonald’s to alleviate my suffering. At
this point, | go out and buy a Eufy L60 Robot
Vacuum with Self Emptying Station.

Aside from getting my life in order, and
the work-Life balance being a lot smoother,
this thing has changed everything. | used to
vacuum once a week on my day off—now,
Hugh (my L60) does it daily at 5pm, and it is
incredible. It doesn't always get everything,
but the fact that it goes around once a day
means it picks up pretty much everything
dog hair-related, and just takes the
stress away from it. Every day | get
home, take an hour or two to relax, and
at 5pm like clockwork, me and the dog
sit on the couch and watch as Hugh does
his rounds, vacuuming up my Labrador’s
double-layer coat from the floor.

It wasn't cheap, but chit is eaper than a
lot of similar options. It's quiet, although
you can ramp up the suction speed. It
detects obstacles, scans the room, has
LIDAR, and does a pretty good job on both
wood flooring and on carpet. | always
wanted a Roomba, but they're so expensive.
Honestly, if you have a dog, and you've not
got arobotvacuum, you definitely need one.
| guarantee it will change your life. 28
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Like other 4K OLEDs, this
Alienware is an elusive angstrom
or three away from perfection.
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ALL NEW TECHNOLOGIES come with a
learning curve. With the cataclysmically
desirable Alienware 32 AW3225QF, we're
taking some lessons about OLED as a
display solution for PC gaming. Yes, this
is another of the brave new 4K monitors
running a Samsung QD-OLED panel.

We've cast our eyes across several of
these now, and the wow factor remains.
But with familiarity comes a slightly more
grounded sense of what these monitors
offer gamers. However, let's kick off
with the basic speeds and feeds. Again,
we're talking 32 inches of 4K QD-OLED
glory. Response is rated at 0.03 ms, peak
HDR brightness at 1,000 nits, full screen
brightness at 250 nits, and color coverage
comes in at 99 percent coverage of the
DCI-P3 gamut. The subpixel structure
also remains the same. In other words,
it's still not a conventional RGB stripe, but
a triangular RGB arrangement.

That mattered in the past for
sharpness and font rendering, because
Windows addresses monitors under the
assumption of the RGB stripe. But with
the increased 140 DPI density of this new
32-inch 4K class of OLEDs, it’s no longer
an issue. Fonts look nice and crisp.

The other headline feature is the
240Hz refresh, of course. Obviously
you’ll need one heck of a GPU to feed all
those pixels at 240Hz. Other highlights
include DisplayPort 1.4 plus two HDMI
2.1 connections and a USB hub. What you
don’t get is USB upstream for video input
or laptop charging. Nor is there an audio
out for headphones or speakers, which is
a slightly odd omission.

Rounding things out is Alienware’s
signature aesthetic, with the familiar
white cladding on the rear of the chassis.
I'm not a huge fan of the look, but it's well
put together. But what about the image
quality itself? No surprise, it's a stunner.
The triple whammy of perfect per-pixel
OLED lighting with 4K pixel density and a
glossy panel coating is to die for.

In SDR mode, there’s no brightness
variability. You can move or resize
windows as much as you want—the
brightness stays at the same 250-
nit level. That said, the Alienware 32
AW3225QF has even more pop in HDR,
and that applies to SDR content, too.

As for HDR, the Alienware 32
AW3225QF gives very different results
depending on which of the nine HDR

Alienware 32 AW3225QF

Demanding but stunning 4K OLED gaming

modes you choose. Making matters
worse, when switching between some,
but not all, of the HDR modes, the display
may resync with your PC.

Then there’s the fact that the HDR 400
mode looks best for outdoor scenes, but
crushes details for darker indoor and
night-time game scenes, while HDR 1000
looks spectacular for the latter, but dull
for brighter images.

If that wasn’t enough, you also have to
contend with OLED burn-in. Alienware
covers the panel for three years, but you
still have to put up with burn-in mitigation
measure prompts popping up, and
generally stress over whether you should
toggle the ‘Pixel Refresh’ or ‘Panel
Refresh’ protection algorithms. Life was
a lot simpler with an SDR LCD monitor.

The upside, of course, are visuals
that no LCD display can match, not even
the latest and greatest IPS models with
full-array local dimming. The contrast
this Alienware delivers is awesome.
Then there’s the very fast pixel response.
There’s a clarity to movement on these
OLED screens that no LCD panels can get
close to, so this is undoubtedly a seminal
gaming experience. Despite the slight
complications, this is as good as OLED
gaming gets. -JEREMY LAIRD

Alienware 32 AW3225QF

VERDICT
9 B SCREEN QUEEN
Stunning QD-OLED panel;
4K pixel density.

= DRAMA QUEEN Not exactly cheap;
Complicated to use.

$1,199,[www.dell.com]

SPECIFICATIONS

Screen size

Resolution | 3,840x2,160

Brightness | 250 nits full screen,

i 1,000 nits max HDR

Color coverage | 99% DCI-P3

Responsetime | 0.03ms

Refreshrate ' 240Hz

DisplayHDR 400 True

HOR { Black, Dolby Vision

| Samsung QD-OLED 3rd
i Gen panel, Adaptive Sync,
! 1x DisplayPort 1.4,

| 2x HDMI 2.1

Features

© UNSPLASH
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Lexar's NM790 not only
looks the part, it's an
absolute value king.
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2TB Lexar NM790
PCle 4.0 M.2 SSD

Flawless pricing gives this
drive a competitive edge

THIS MIGHT be the best-value PCle 4.0
SSD we've found to date. Usually, when
we say something like that, there’s a
massive trade-off to be had at the same
time. Like, “Oh wow, this GPU drives
some seriously impressive frames and
is super affordable, but by the way, it's
louder than ajet engine”. With the NM790,
though, that’s not the case—for a PCle 4.0
SSD, it’s seriously impressive. Not only
are the performance metrics up there
with some of the best PCle 4.0 drives
we've tested, but it trounces some of our
favorite drives from a value perspective,
both for gigabytes per $ and sequential
read performance per $ as well.

Let’s talk numbers and what you get—
top-line specs. 2TB of total capacity on
the PCle 4.0 standard, with an M.2 2280
form factor. It's utilizing 232-layer YMTC
TLC NAND flash memory. YMTC (Yangtze
Memory Technologies) is a relatively
new Chinese semiconductor company
that’s just been launched onto the scene
with its own 232-layer TLC. Lexar’s
combining that with the Maxio MAP1602
controller, and impressively no DRAM
or cache whatsoever. The drive is also
entirely single-sided, even in its 4TB
configuration, making it perfect for use

BENCHMARKS

i 2TB Lexar NM790
‘ PCle 4.0 M.2SSD

AS SSD Sequential Read / Write (MB/s)

| 5,955/5,152

in consoles or similar devices where the
bulk of your cooling is situated on top.

The drive is available in capacities
ranging from 512GB all the way up to 4TB
respectively, and our variant comes with
a 1500 TBW endurance rating and a five-
year warranty. Advertised specs top out
at 7,400 MB/s read 6,500 MB/s write, and
I0Ps at 1000K and 900K.

But stats only get you so far, and
fortunately, we can report that the
NM790 doesn’t exactly disappoint
when it comes to testing performance,
either. CrystalDiskMark saw sequential
reads and writes at 7,092/6,621 MB/s
respectively, with random 4K topping
out at 70 and 263 MB/s as well. That puts
it on par, at least in terms of sequential
performance, with the likes of our
tried and true favorite, the Kingston
Fury Renegade. However, it also pulls
ahead when it comes to the random 4K
performance as well.

Crucial's T500 is also an intriguing
comparison, as similarly, it pulls away
significantly on the sequential read
front, and on random 4K performance as
well. This is likely due to a lack of cache
and DRAM, hindering the Lexar NM790,
although that reduces power draw and

2TB Kingston Fury
i Renegade PCle 4.0
| M.2ssD

i 2TB Crucial T500
ProPCle 4.0
| M.2sSD

5,631/ 4,455

AS SSD Random 4K Read / Write (MB/s)
AS SSD Access Time (ms)

CrystalDiskMark Sequential QD32
Read / Write (MB/s)

CrystalDiskMark Random 4KQ1

Read / Write (MB/s) £d02es

Max Temp Under Load (C) i 75

Gigabyte per $ (GB) | 16.53

| 77.18/144.08
| 0.016/0.045

I 7,092/ 6,621

81.37/2717.75 . 85.21/281.32

0.018/0.017 | 0.062/0.016

| 7,879/ 6,783 6,979 / 6,874

92/331 | 88/357
L 72 | 55

| 14.39 11.56

Sequential Read MB/s per $ (MB/s) | 58.61 | 56.68 40.34
] (§

Best scores in bold. Our test bed consists of an Intel Core i9-14900K, 32GB of Corsair Dominator Titanium @ 7200,
an Nvidia GeForce RTX 4080, Corsair H150i AlO, and an Asus 2790 Dark Hero. Max Temp recorded via HWMonitor
during benchmarking process. Prices correct at time of writing (Lexar NM790 pricing metrics listed at $121).

sustained temperature peaks as a result,
certainly over longer file transfers. In our
testing, the NM790 topped out at around
75 C during our benchmarking process,
which is well within healthy parameters.

However, it's when you start to dig into
the pricing for this beautiful little thing
that the coin drops, and that’s for one
reason: the value is insane. Okay, when
we picked this up for our feature build,
it was available for $147. At time of
writing, it has fallen to $121. That's
cheaper than the Kingston Fury
Renegade ($187) and T500 ($139), in no
small part thanks to YMTC’s TLC NAND
being somewhat cheaper.

It's that $121 that really swings the
needle. That said, even at $147, it's
still phenomenally good value. At that
price, gigabyte per $ hits 13.61, close
to the T500’s 14.39 and higher than the
Kingston’s 11.56, and sequentials clock
in at 48.25 versus the T500's 56.68 and
the Kingston's 40.34 respectively. Drop
the price to that $121 mark, though,
and gigabyte per $ shoots up to 16.53
(surpassing the T500), and sequentials to
58.61 MB/s, making this by far the best-
value SSD we've tested to date, as long as
it holds its price lower than the T500.

The Lexar NM790m then, is the
whole package. Performance? Check.
Hardware? Check. Endurance? Check.
Price? Near perfect. What’s not to love?
-ZAK STOREY

Ml 2TB Lexar NM790 PCle 4.0

9 M.2 SSD

3 NATURALLY MAGNIFICENT
HI:H Flawless price point if it holds;
AS5I

Strong PCle 4.0 performance;
Solid endurance rating;
Decent temperatures and power draw.

= NEVERMIND Unproven TLC NAND;
Lower 4K performance.

$121 - $147,fwww.Texar.cor

SPECIFICATIONS

Variants
Form Factor | M.22280

Interface / i
Protocol i PCle 4.0/ NVMe

Flash Memory I 232-Layer TLC NAND Flash

Sequential Read 7,400 MB/s

Random Read | 1000K IOPS

Random Write | 900K OPS
. L

Endurance (TBW) | 1500

Warranty

, 5-year limited warranty
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The thin screen means

the inputs are a long way

from the edge. The screen .
is blacker than its bezel

when switched off.
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Acer
Predator
X27U

The latest in a long line
of gaming monitors
embraces the OLED

© UNSPLASH

WE LIKE OLED monitors, their thinness
and brightness appearing contradictory
yet strangely alluring. Add the 240Hz
refresh rate of this Acer Predator, and
you have a winning combination.

The resolution of 1440p looks like a
wise choice, even though it's a step down
from the old Quantum Dot Predator X27’s
2160p. By showing restraint and dialing
it back a bit, Acer is able to increase the
chances that today’s GPUs will be able to
supply the high frame rates a screen like
this deserves. It'll display them without
tearing, too, thanks to Freesync Premium
and VRR support, though it drops the
G-Sync certification of its predecessor.

You also get plenty of ways to feed it
those frames. At the back of the X27U,
there’s an array of ports that includes
a useful USB hub, alongside the usual
HDMI and DisplayPort options. They're
not particularly easy to get to, as while
there’s a thicker part of the monitor inset
from the extremely thin edge, it’s a long
way up, and the ports are quite close
together. It's best to plug some cables in
and leave them there, especially as you've
got a USB-C port for compatible laptops
(it provides 90W of power to charge them,
making a tidy single-cable solution),
which can switch USB data—perhaps a
flash drive, wireless keyboard receiver,
or webcam—with the Type-B/A hub. Hook
your desktop PC up to the DisplayPort,
use the HDMIs for a streaming stick and
your Nintendo Switch dock, and you've
got a complete media hub.

Audio is taken care of by 5W speakers,
which are surprisingly clear considering
how slender the edge of the monitor is.
You'll still be better off using headphones
or external speakers, but they’re good
enough foravideo call. Ahandyaccessory
screw socket at the top of the monitor
stand allows the attachment of cameras
or ring lights, so you can look your best.

That stand allows for a decent degree
of adjustment, though there’s a six-inch
VESA mount at the back if you want to
connect it to an arm. There’s almost six
inches of vertical adjustment, as well
as the ability to swivel the screen into a
portrait orientation. The foot features
widely splayed supports, which take up
a chunk of desk space, but the rear leg
is small enough that you're not forced to
place it too far from the edge.

The screen is the main draw. Switched
off, it appears as a pure black portal to
another dimension where the stars never
ignited, but feed it the requisite signal,
and you're treated to some excellent
color saturation, with up to 400 nits of
brightness if you've got HDR switched on.
The blacks are deep, too, offering the kind
of contrast LCD screens can’t manage.
It can display 93 percent of the P3 color
gamut (in our tests—Acer’s claim is for 99
percent), which is very respectable.

All 3.68 million of those OLED cells
combine to produce a picture that’s
sharp and responsive, the benefits of
the technology making themselves clear
behind the anti-glare matte coating. The
only real problem is its price. At close to
$1,000, you need to really want it to buy it,
and the eye is easily drawn by LED-backlit
IPS screens that offer 90 percent of the
OLED’s performance for half the price.
Acer’s screen is the complete package,
offering size, resolution, and speed, but it
sure does cost a lot. -IAN EVENDEN

Acer Predator X27U

VERDICT
9 &I PREDATOR Excellent
OLED display; USB hub;
Plenty of inputs.

B PREY Very expensive; Only’ 1440p;
External power brick.
$999, [www.acer.corm

SPECIFICATIONS

£ 27in

Screen size

Panel | OLED

Resolution 2560 x 1440
— e

Brightness | 400 nits (DisplayHDR 400)

Refresh rate | 240Hz

Audio I 2x 5W speakers

Connectivity { 2x HDMI 2.0,

i 1x DisplayPort 1.4,

i USB Type-C (90W PD),
| 1x USB 3 Type-B,

{ 2x USB 3 Type-A

22.4 x 23.8 x 2.2in
| (with stand)

Dimensions

Weight 13.45 b (with stand)



http://www.acer.com

in the lab

HP Spectre Foldable

All the gear, no idea

FOLDABLE SCREENS are everywhere
now. We first saw them pop up in the
mobile world, then they made their way
to monitors with the likes of Corsair’s
Xeneon Flex, and now we have them in
laptops, too [if this can even be called a
laptop). You see, the HP Spectre Foldable
is technically a laptop, an all-in-one, and
a tablet. Its downfall is that it's a $5,000
tablet with sub-$1,000 performance.

Yeah, that’s kind of the problem with
the HP Spectre Foldable. On the surface,
it is an incredibly versatile device. You've
got a crisp, beautiful OLED panel with
some solid pixel density, that is entirely
foldable, with a detachable, magnetic
wireless keyboard and mouse combo.
That allows you to do a few things: first,
you can just use it as a full-on display
plus a wireless media keyboard. There’s
a kickstand embedded into the back of
the product—pop that out, and you get a
full-size 17-inch 2560x1920 16:10 display.
Alternatively, flatten it out entirely, turn
the keyboard off, and you've got a chunky
17-inch tablet instead.

The real party trick comes when
you bend the screen in half, however.
Fold that into a laptop shape, and you
can attach the keyboard in a number of
different ways: either on the bottom half
of the screen entirely to turn it into a
remarkably compact laptop, or pull that
keyboard down a touch, and you can give
yourself a bottom half display as well. HP
has included a bit of software wizardry
here, too, that will shift the resolution
and Windows display to compensate,
accurately detecting the keyboard on

BENCHMARKS

HP Spectre Foldable

top, which also simultaneously charges
wirelessly when in position.

Overall, the design is solid. The
materials are great, and that display
is crisp and vibrant— exactly what
you'd expect from an OLED. It's a little
disappointing that it's only 60Hz, but
that’s not the end of the world. There
are two USB Type-C connectors on the
Foldable, both supporting Thunderbolt
and charging. HP alsoincludes aUSB Hub,
so you can connect additional devices and
displays to it if you need to. That said,
the ports are a bit oddly placed. If you do
decide to use it as a laptop, there’s only
one ‘portrait’ orientation you can use the
screen in (the device does automatically
rotate the screen, depending on how
youre holding it), and in laptop mode,
you get one USB-C port at the top left of
the primary display, and one on the right-
hand side of the screen, making it a bit
awkward to plug things into.

Those are minor foibles that really
don’t detract from the overall device.
There’s a problem, however, and it's the
internal spec. As standard, there’s only
one SKU for the foldable. You get 16GB
of LPDDR5 RAM soldered onto the unit,
an Intel Core i7-1250U CPU (theoretically
capable of 4.7 GHz with 12 threads), and
a 1TB PCle 4.0 SSD, and, well, that’s it.
On the one hand, this is great, as it does
extend the battery life fairly comfortably
(which changes, depending on how much
of the screen youre usingl—on the
other, performance is poor; very poor.
We won’t go too deep into the numbers
here, but compared to a $1,200 entry-

i Huawei MateBook D 16 2024
i (EU Only)

| 1,405

Crossmark Aggregate (Index)

GeekBench 6.2.1 Single-Core / Multi-
Core (Index)

| 2,210/6,635

i 1,938

| 2,605/12,568

p e L

Blender (Index)
CrystalDiskMark 8 Read/Write (MB/s)
3D Mark Wildlife Extreme i DNC

Total War: Warhammer 3 Low @ Native |
. | DNC
Resolution (avg fps) |

Borderlands 3 Ultra @ Native

Resolution (avg fps) | oNe

| 26.81/17.14/11.69
| 6,739/4,52%

| 70.22/40.94/ 28.38
| 4,905/3,952

All benchmarks performed with a clean install of Windows 11, with the latest updates, chipset and drivers
installed. Best scores in bold. Games tested at device's native resolution. Borderlands 3 tested at Ultra,

Total War: Warhammer 3 tested at Low.

JUL 2024

level laptop, outside of CrystalDiskMark,
it consistently performed worse across
pretty much every benchmark we ran it
on. For our gaming benchmarks, it failed
every single one, often loading the game
menu, but crashing when attempting to
run it, even on the lowest settings.

Here’s the thing: it's not designed for
that, and we kind of forgive it. If light
desktop work is your thing, and internet
browsing and some Netflix streaming is
your aim, then it’s perfect. The problem,
however, is that Asus actually has an
almost identical model to this (spec,
foldable panel, internals—the lot) for
$2,000 less (yes, you did read that right)
called the Asus Zenbook 17 Fold OLED.
What we're left with is a very impressive
tech demo that costs far more than it
should, and performs worse than most
$1,000 laptops. It may be cool, but that’s
not really good enough. -zZAK STOREY

AL HP Spectre Foldable
FOLDINGRHOME Intriguing
tech demo; Beautiful screen;

Solid design.

& FOLDING LIKE A LEAF Price is way too high;
Performance is massively underwhelming;
$2,000 cheaper options.

$5,000, fwww.hp.cor

SPECIFICATIONS

CPU i Intel Core i7-1250U

— oy
GPU i Intel Iris Xe Graphics
RAM | 16GB LPDDR5-5200

Storage | 1TB PCle 4.0 M.2 SSD

Screen 17-in 2560x1920 OLED
Connectivity 2x USB Type-C

! Thunderbolt, WiFi 6E,
Bluetooth 5.3

| 10.9x 14.80 x 0.33 in

Dimensions

Weight I 3.57 lbs

© UNSPLASH


http://www.hp.com
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If only HP could fold that
price in half. They might
be on to something.
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GAMING LAPTOPS come and go, but some
things stay the same. The combination of
a hot CPU and capable GPU, along with
plenty of RAM and some fast storage,
always adds up to a potent gaming
experience that can’t last long away from
a wall socket, and so it is with Acer’s
latest, the Predator Helios Neo 16.

It's packing a 14th-gen Raptor Lake
Refresh CPU, rather than one of the
Meteor Lake Core Ultra chips, which
means 20 cores (eight of them P cores), a
maximum boost frequency of 5.5GHz, and
a TDP of as much as 157W. Add to that the
140W that the RTX 4070 GPU is capable of
slurping, and this doesn’t go well on the
battery, which in our tests can scrape just
three hours and 19 minutes, even in our
relatively gentle test, which keeps the
screen on and subjects it to a series of
office tasks.

Still, once you get it plugged in and
actually start gaming on it, the Helios
Neo is pretty good to use. It’s fairly heavy,
which grounds it on your desktop and, as
a 16-inch laptop should, it takes over the
space you put it in more than a smaller
model would. The weight means it’s sub-
optimal when you put it on your lap, but
there’s another reason that it belongs on
a hard surface: it gets hot. The fans spin
up just from the Windows login page,
and it gets warm even when sitting idle.
Start pushing up the processors, and the
cooling system is called upon to dissipate
a lot of heat, leading to plenty of fan noise.

You'll no doubt have a headset or
pair of Bluetooth headphones attached,
however, or even use the built-in speakers
which, like a lot of their kind, are fine, but
not great. The keyboardis RGB backlitand
feels somewhat cramped, as a nhumpad
has been squeezed in alongside it, but
the keys have plenty of travel. It's notable
as one of the first devices we've seen to
sport Microsoft's new Copilot button on
the keyboard between the spacebar and
the arrow keys, which is alongside the
Predator button at the top of the numpad.
This didn’t seem to do anything in our
tests, but we suspect this may be meant
to launch the PredatorSense software
that controls performance profiles, RGB
lighting, and other personal settings.

The screen is an IPS with a 240Hz
refresh rate and 1600p 16:10 resolution,
which is going to attract fans of esports
and online shooters, where quick
reactions are paramount. To make a
connection, you have the choice of Wi-Fi
6E and a 2.5Gbps Ethernet port, although
you’ll need compatible equipment all the
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Acer Predator
Helios Neo 16

With the latest tech comes
the same old problems

way along the network chain to make the
most of this. It also has an array of USB
ports, including two Thunderbolt 4s with
lightning bolt logos next to them. We
couldn’t get it to charge through them,
although Acer says it should be possible,
and the power brick that comes in the box
is very large—even the flex that attaches
to the laptop’s charging port seems
thicker than others. You'll need that
power adapter, as the battery life isn’t
great. Start gaming, and it will only get
worse: we saw it run out in just over an
hour after one session.

The Acer Predator Helios Neo is a
well-specced gaming laptop that’s been
released into a competitive marketplace
in which there are a lot of other options at
the same price. Its performance is good,
but it doesn’t always look like a bargain.
-IAN EVENDEN

LUl Acer Predator Helios Neo 16

8 E2 HELIOS Good processor
choices; Nice screen; Keyboard
has great feel.

B HEINOUS Poor battery life; Heavy; Gets h/"‘

hot underneath.

$1,699, eww.acer.con] o
:.'-':‘. " iy

o . =
SPECIFICATIONS o o~

CPU | Intel Core i7-14700HX (20 cores)

GPU Nvidia GeForce RTX 4070
_—
RAM | 32068

Storage | 1TB SSD
Screen i 16in IPS, 25601600 pixels
| (16:10), 240Hz
Connectivity : Wi-Fi 6E, 2.5G Ethernet,
| Bluetooth 5.3, 1x USB 3.2
: Gen 1 Type-A, 2x USB 3.2 Gen
| 2Type-A, 2x USB 3.2 Gen
i 2 Type-C, HDMI, Micro SD,
3.5mm (0.13in) headset

Dimensions | 1.1x14.2 x 11in

Weight | 6.1lbs

© UNSPLASH


http://www.acer.com

The black plastic casing picks
up fingerprints easily, so you
might need to carry a cloth.
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PROJECTORS ARE STILL difficult to justify
on so many levels. The biggest reason
is what kind of screen tech we have
available to us. No matter how you spin it,
a 4K gaming projector’s main advantage
is screen size. Everything else, from color
accuracy and latency to image clarity, is
superseded by the monitor tech we have,
typically at far lower prices, too.

If you're looking at a projection unit
like this to replace your desktop monitor,
we'd say that it’s not worth considering.
If you want a beefy 42-inch monitor, then
you can grab something like Asus’s ROG
Swift OLED PG42UQ, complete with 137
Hz refresh rate, 0.Ims response time,
and 4K 41.5-inch panel for less than
$950. If you want something ultrawide,
then Alienware’s AW3423DW, complete
with 34-inch form factor, 3440x1440
resolution, 0.1 ms response, and 175 Hz
refreshrate, comesinatjustshyof $1,100,
and you can find even cheaper solutions
from Samsung and other manufacturers.
No matter how you spin it, the humble
monitor is better if you want the absolute
best experience on your PC on your own.

But that’s the twist—a projector isn’t
really designed for that kind of use. It's
not meant to be a desktop replacement,
nor is it best enjoyed alone. No, this is a
product that really makes itself at home
in a dedicated gaming den, man cave,
home theater, or family room. When it
comes to getting a top-tier 4K gaming
experience, very few projectors come
close to what the X500i can achieve.

We've been using the X500i for a
few weeks now, and out of all of Benq's
projector product stack, were not
sure why you'd go with anything else.
Admittedly, out of the three brand new
projectors from the company, there’s not
a lot to choose from—just the X3100i, with
its vast $2,400 price tag, the X500i, or the
portable X300G 4K gaming projector at
$1,800. The X500i sits in comfortably at
$1,700, but in our opinion, is far superior
to its X3100i counterpart.

Why? It comes down to a mixture of
features, price, and form factor. Out of
the box, the X500i’s image quality is top-
tier. One of our tests involve shining our
projectors against a dark gray wall to
see how they handle the color difference
compared to awhite screen, and the X500i
dominated that test. Colors are crisp,
vibrant, and accurate. On a relatively
short 18-foot throw, the X500i produced
a fantastically clear image, and latency
was almost non-existent. Benq has also
included some serious connectivity
(we’ll let the spec box do the talking),
and Google TV is built in for a super-
smooth setup. The chef’s kiss, however,
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is the configuration menu. There’s a lot
on offer, including everything from high-
altitude mode to keystone adjustments,
game modes, and HDR tweaking. It also
packs some impressive audio, certainly
in contrast to some of the competition.

The best thing about the X500i, though,
is the form factor. It's sleek, slender, and
more traditionally rectangle-shaped,
rather than the cuboid that the X3100i and
X500G offer. That allows you to mount
it to the ceiling without worrying about
walking into it at night. Build quality is
solid, and the remote is slick.

It's not flawless, however. Fan noise
is an issue, particularly if you're on
Netflix or YouTube, and the Google TV
implementation feels flimsy (it's a dongle
that you insert into the back, hidden
behind a plastic cover, with a bendy
Micro-USB cable, and HDMI connector).

Still, the X500i easily contends with
the likes of the X3100i for image quality
and then some, and that’s what makes
this thing so impressive. If you're after a
4K gaming projector to dabble in some
casual gaming with your friends and
family on a long weekend, then the X500i
more than fits the bill. -zAK sTOREY

VERDICT

9 E2 XCEPTIONAL Solid image
clarity and color accuracy; Easy setup;
Decent form factor; Good pricing.

Benq X500i 4K
Short Throw Projector

B XCREMENT Noisy fans; Janky Google TV
implementation; Bigger screens may need
the X3100i.

$1,700, www.beng.com|

SPECIFICATIONS

: 640x480 up to 3840x2160.
4K@60 Hz, 2K@120Hz,

; 1080p(@240Hz. 60Hz limited

! to 16.7 ms, 120Hz 8.3ms,

240Hz 4.2ms.
Display Colors + 1.07 billion

00,000:1

Resolutions

Contrast Ratio

Brightness I 2,200 Lumens

Light Source Life { 20,000 - 30,000 hrs
Zoom Ratio 1.2x

Throw Ratio 0.69 - 0.83

Projection Offset | 102.5%

Connectivity | 2x HDMI 2.0b, 1x USB

+ Type A, 1x USB Type C
| (DisplayPort), 1x RS232 In,

1x TOSLink Optical Audio
Out, 3.5mm Analog Audio
Weight | 7.9 b

| 46X 144 x9.6 inches

Dimensions

Beng

X500i
4K Short
Throw

Projector

4K gaming
projection just
got cheaper...
sort of

The X500i really makes
us question why the
X3100i exists.



http://www.benq.com
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Phanteks
XT Pro

S50 goes a long
way these days

THERE'S NO DOUBT that we here at
Maximum PC spend a lot of time looking
at expensive products. Whether that's a
$400 chassis with screens in it, or $2,000
graphics cards, a lot of them really have
no right to be as expensive as they are.
Often, budget options are by far the
more interesting products. Discovering
the best-value chassis, CPU, or SSD
is far more challenging than seeing
that fps number climb ever higher [this
journalist’s discerning eyes aren’t as
sharp as they used to be). Still, Phanteks’
XT Pro is one such product.

Straight out of the gate, this thing
comes in at $50. That is incredibly low for
a case. It's been a very long time since
we've seen a chassis at that price that
wasn’t covered in fingerprint-inducing
plastics, "gamer” design choices, or bare
steel panels. The XT Pro is a nice change
of pace in that regard, and really does
go to show how far case manufacturers
have come in terms of design and
manufacturing in the last decade or so.

On the surface, the XT Pro is a
sleek, smooth, crisp black tower, with
a tempered glass side panel and plenty
of support for your componentry inside.
It can house up to an 11-inch E-ATX
motherboard, and has some serious
cooling support baked in as well.

It's that cooling potential that really
tips the scales in its favor. By default,
you can fit it out with a 4.7-inch rad in
the rear, a 14-inch in the roof, and a 9.5-
inch up front. In fact, you can do that and
still have a ton of clearance both top and
bottom. It gets even more impressive
when you look at the number of fans you
can stick in this thing, as there’s support
for up to 10 4.7-inch fans total, including
three on top of the PSU shroud, to draw
cool(ish) air up from that compartment
directly into your GPU and above
componentry. Couple that with a decent-
sized 5.5-inch up front, drawing cool air
into that compartment, and it gives you
an incredibly potent cooling solution.

Alternatively, you could run three
4.7-inches on that PSU shroud, an AIO
with three 4.7-inches in the roof, one

5.5-inch in the rear as an exhaust, and
three 5.5-inches up front as an intake
to really maximize on that potential.
It's just glorious, and a real nice touch,
particularly when most cases at this
price point really don’t support anywhere
near as much cooling.

The XT Pro is somewhat limited
on what you get with it as standard,
however—there is only one fan included,
although you can pay $20 extra for the
XT Pro Ultra (available in either black or
white), and that comes with a total of four
M25-140mm D-RGB fans as standard
too. This is an impressive saving (we
actually included the triple 4.7-inch kit in
our feature build this issue on[page 18).

Otherwise, it's not entirely dissimilar
to something like the Corsair 4000D
Airflow. The internal layout is very
similar. There’'s a huge amount of
compatibility here for GPUs, CPU towers,
and more, but all at a super-low price.

You can tell where corners are cut—
some of the materials are on the lower-
quality end—but it's not distracting by
any means. If Phanteks had pitched this
case in its standard config as $70, we'd
have thought this was a good deal. At
$50, it's outstanding. -zAK STOREY

VERDICT

Phanteks XT Pro
B XENEPHON OF GREECE Strong
pricing; Easy to build in; Insane

cooling potential; Excellent compatibility.

B XYLOPHONE OF KINDERGARTEN Materials

do feel cheap; Could use one extra fanin

$50 config.

$50, www.phanteks.com

SPECIFICATIONS

Motherboard Support
. E-ATX (12 x 11 inches)

ITX, Micro-ATX, ATX,

2.5-inch / 3.5-inch
Support

- 2x2.5inch, 1x3.5
- inch/2 x 3.5 inch

Max Radiator
Support

| 4.7 inch rear, 14 inch
i roof, 9.5 inch front

Fan Support

. 3x4.7inch/2x5.5
| inch roof, 3 x 4.7/5.5

inch front, 3 x 4.7 inch

© PSU cover, 1 x 4.7/5.5

inch rear

L 17.7x19.7x 9.1 inches

Graphics Card
Clearance

: 16.33 inches

CPU Tower Clearance

¢ 7.24inches

Warranty

: Syears limited

JUL 2024 | LR
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Cherry Xtrfy K5V2

New switches, who dis?

CHERRY'S SWITCHES are dependable,
unwavering, and the standard by which
many of us judge all other switches. So
what happens when Cherry changes
them? You get the MX2A Red switches
inside the Cherry-made Xtrfy K5V2—a
new and improved version of the Cherry
MX Reds we've come to know and love.

The MX2A Reds are an improvement
in a number of ways. First and foremost,
they're factory lubed. If you're a regular
reader of our keyboard coverage, you'll
know that lube makes for smoother
switches with a satisfying clack. That's
certainly true of the MX2A Reds, too.
Each key glides effortlessly with each
strike from my fingers.

The MX2A switches come with ‘pin
point ring lubrication’ applied to the new
‘socket dome’ in the bottom housing. If
that sounds like jargon, it sort of is, but
in effect means each switch leaves the
factory floor with a big dollop of grease in
it, and which should stick around for the
lifetime of the switch.

Other wupgrades with the MX2A
switches factor into the more consistent
key press, including a new barrel spring,
housing socket dome, guidance ribs,
and stem geometry. That last one is
important, as the MX2A are significantly
less wobbly than older MX Reds.

All of those changes make for a much
smoother key press than with previous
Cherry MX Red switches. Overall it's a
much better switch than the original MX
Reds. That's good news for gamers, as
we're likely to see a lot of them end up in
gaming keyboards from multiple brands.

But how does the typing experience
on the Cherry Xtrfy K5V2 compare to our
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favorite keyboard of the moment, the ROG
Strix Scope Il 96 Wireless? Put simply, we
prefer the Scope Il 96 for typing. The lack
of wobble in the PBT keycaps through the
ROG NX Snow switches is as impressive
now as the day we first tried it.

Onward to the keyboard itself. This is
a compact slab with a 65 percent layout.
That means it's only 12.8 x 4.4 inches,
and doesn’'t come with a numpad or the
usual cluster above the arrow keys. It
does retain arrow keys, however, along
with Page Down, Page Up, and Delete
keys. The rest of the missing keys can be
accessed via the many, many shortcuts
on this keyboard.

End, Home, and the F1-F12 keys are
accessed with a press of the Function key.
To make up for the lack of physical media
keys, there are some shortcuts thrown in
along the top alphabet row. What | find a
little overwhelming are the many more
shortcut keys for functions with unclear
intentions. There’s one key of mysterious
machination with a fingerprint blazoned
on it, another says K-LED. BG Color,
K-Slow, K-Fast, K-Mask, E-speed+, the
list goes on. All those we've mentioned
control the RGB lighting on the board,
and the reason why there are so many
pre-programmed keys to do so is due to
the lack of dedicated Cherry software to
control this keyboard. That may appeal to
some, though if you want simplicity, we'd
look elsewhere.

The keycaps are made from ABS
plastic, which feels like a bit of a miss for
the money, but they're easily replaceable
thanks to MX cross stems. The switches
themselves are also hot-swappable,
and the USB Type-C to Type-A cable

removable. All of this should see this
keyboard last a long time—at least until
those switches wear out around the 100
millionth click mark.

You'll have to part with $140 to get
yourself in on the Xtrfy action. It's a
neatly packaged gaming keyboard with
plenty of functionality for its lack of
software, which for some may be all they
need to hear, but nevertheless feels like
a lot of money for fewer keys than most.
There are nicer-feeling—and cheaper—
compact keyboards. Nothing about the
Xtrfy makes it sing for us.

VAL Cherry Xtrfy K5V2

B XTRFY Steady switch; Good
B typing experience; Great for
gaming; Software free; Hot-swappable.

BEIXTNCT RGB lighting controls are finicky;
Cheaper wired compact boards available.

$140, www.cherryamericas.com

SPECIFICATIONS

Size | 65%

Connectivity USB Type-C to Type-A

! ABS

Keycaps
Switches Cherry MX2A Red
Hot-swappable } Yes

Shortcuts via Function

Media controls ]
key

Lighting | RGB lighting modes
- +onboard control
Software None
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HyperX Cloud Il

Wireless

These are not the
headphones you're

looking for...

LET'S BE GENEROUS and start with the
positives. The Cloud Ill Wireless offers
a sturdy build that didn't creak, bend, or
break during two weeks of regular usage.
The headset's earcups are held in place
by a robust metal frame bathed in red,
and the surrounds are all plastic. The ear
and head cushioning is an initially comfy
and uniform leatherette.

A volume wheel with a smooth, tactile
action sits on the right earcup, with a
microphone mute button, power button,
and USB Type-C charging port on the
left. The removable microphone extends
out from the left earcup, connected via
a slotted 3.5mm jack. This particular
microphone comes with a small red light
on the tip of the boom arm to indicate
when it's muted—a handy visual cue and
a good way to avoid talking to yourself.

It captures a tone favoring the
upper ranges and with a subdued bass
response. It's not a particularly natural-
sounding microphone, but it is extremely
clear. For gaming over Discord or in-
game voice chat, boosting the higher
frequencies is not a bad thing—the Cloud
[II's mic cuts through game audio like
a knife through butter. However, if you
want a headset that's better suited to
streaming or recording your voice, you'll
want to look elsewhere.

The 120-hour battery life brandished
by the Cloud Il Wireless is good
compared to the wider market, and in a
few weeks of testing it barely required
charging at all. The dedicated wireless
dongle, meanwhile, will work across PC,
PlayStation, and Nintendo Switch thanks
to an adapter in the box to change it from
a native Type-C connection into a Type-A.

If that sounds useful, the dongleis also
where the worm begins to turn. It seems
to suffer interference issues with other
wireless peripherals, including mice,
causing repeated rogue disconnections
and lost or distorted audio. That was
solved by relocating the dongle into a port
further from other wireless dongles, but
it remains a concern.

Then there are the ergonomics. We
weighed the Cloud Il Wireless at 0.75
pounds, but four hours of usage left us
desperate to get the things off. The same
can't be said about, say, the AceZone
A-Spire, over a similar period of usage.
They're much more comfortable.

This leaves us with the final and most
important factor: sound quality. The bass
feels more pronounced on this headset
than some more neutral headsets, yet
lacks precision and definition. It's really
trying to highlight the lower frequencies,
yet the drivers just aren’t capable of it.
As a result, when the bass is kicking, it
detracts from the rest of the mids and
highs. Without any bass thumping, the
high-end is better, and for a closed-
back headset, it doesn’t sound pointy or
harsh. But the high-end response, too, is
nothing to write home about.

The Cloud Il is certainly better suited
to gaming than music. It's reasonably
easy to hone in on individual cues in-
game, and while the soundstage isn't
terriblyimpressive, this headset provides
a decent enough gaming experience.
But if you want to mix in some music
listening, there are definitely headsets
that do a better job of that broad remit.

All told, the Cloud Ill Wireless
highlights an uncomfortable truth with
wireless gaming headsets: you can pick
up a fantastic-sounding pair of wired
headphones for less than $100, but it

costs a lot more for similar cable-free
headphones. I've not been blown away by
any wireless headset beneath the $150
mark. In that sense, and compared to
similarly priced competition, such as the
Corsair HS80 Max, the HyperX Cloud IlI
Wireless is decent enough. Yet, it doesn't
feel anything close to a legend in the
making, like its more expensive sibling,
the HyperX Cloud Alpha Wireless.

VLU The HyperX Cloud Ill Wireless
B IN THE CAN Good battery life;
Decent build; Okay for gaming.

B CANIT Connection issues; Tinny
microphone; Muddy sound.

$150, www.hyperx.com

SPECIFICATIONS
Connection | 2.4 GHz wireless [via
- USB Type-C dongle
- with Type-A adapter)
Type - Closed back
Frequencyresponse . 10 Hz - 21 kHz
Drivers Dynamic, 53mm with
neodymium magnets
Connector - USB Type-C
Microphone Electret condenser
microphone
Weight = 0.75lbs (with mic]
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in the lab

Sleek, indomitable mothership
jetting off into the unknown?
It must be Homeworld.

———

Homeworld 3

The Hiigaran fleet returns for a third outing

THE SIGHT OF THE SLEEK, indomitable
mothership preparing to jet off into
the unknown, accompanied by radio
chatter and a moody score, feels like a
homecoming. For newbies, it's a striking
scene. For veterans, it calls to mind the
original mothership getting ready to
leave Kharak and the beginning of one
of the best strategy games ever created.
Welcome to Homeworld 3. It's enough to
make you tingle.

Homeworld 3 wants to remind you
of its legacy, a lot. After the events
of Homeworld 2, Karan S'jet, the
mothership’s navigator, was sent on a
mission to deal with a looming crisis,
but never returned. 20 years later, her
protege, Imogen S'jet, is following in her
footsteps, with a new mothership and a
new fleet that must strike out on their
own, once again without support.

But where the original Homeworld
often took a minimalist approach,
Homeworld 3 is comparatively busier,
with maps full of debris and terrain,
and a story that constantly breaks from
the fun stuff to boring conversations in
hideous cutscenes that look ripped from
a bad '90s sci-fi game. The plot is mostly
forgettable nonsense, so thank goodness
the missions are largely brilliant.

90 | wumE | JuL 2024

Each puts the fleet in a new kind of
peril. You'll be hiding from enemies in
nebulae, commandeering gargantuan,
monolithic space complexes, setting up
elaborate blockades, using turrets and
mines to create corridors of death, or
sabotaging factories in kamikaze strikes.

The original Homeworld felt
revolutionary thanks to its truly 3D
battles, but Homeworld 3 makes you
appreciate the cosmic conflicts so much
more thanks to space terrain. Every
single mission is laden with screen-
filling structures and asteroids, creating
defensible positions, chokepoints, and
ambush spots. How you approach a fight
matters much more because while you
have this complete freedom of movement,
you also have maps that give you both
advantages and limitations.

The complexity of the terrain-
dense maps makes it harder
to control your fleet, but it's
easy enough to hop around,
focusing on specific ships
and groups. The attack move
order means you can keep up
the aggression, and being able
to select groups of enemies to |
attack gives you room to deal
with the big picture.

Still, some maps simply set in deep
space would have been welcome. Full
3D movement already gives you plenty to
deal with, and its predecessors’ purity of
space combat is missing. Sometimes, it
feels like Homeworld 3is trying too hard.

There's also a new mode: War Games.
It'san RTS take onroguelikes, where each
run gives you only a specific ship loadout
which can be buffed by artifacts you earn
along the way. Every mission sees you
bombarded by enemy incursions, which
only grow in intensity. It punishes you for
taking your time. The Al isn't any more
reactive than the campaign’'s, but it's
certainly more unrelenting.

Despite ostensibly allowing you to play
solo, it just doesn't make sense without a
co-op buddy. But even with a co-pilot in
tow, the appeal is limited. You get fewer
options, less time and more threats. None

of this really plays to Homeworld 3's
strengths. It's good that developer BBI
has tried something new, it shouldn’t
be entirely beholden to the past, but
this ain't it, unfortunately.
Homeworld was such a
formative title for gamers
of a certain generation
that it's hard to imagine
anything knocking it

© GEARBOX PUBLISHING



New play mode War
Games is a spacefaring
take on roguelikes.

Clunky cutscenes and a
forgettable plot are offset
by thrilling missions.

While playing solo is possible, The terrain-dense maps are
we definitely recommend complex, but it's easy to zoom
buddying up with someone. in on ships and groups.

off its pedestal, but Homeworld 3 does
make it wobble—a bit. Watching dogfights
in the canyons of a frozen moon or a
formation of bombers boosting up the
wall of an industrial complex, while
praying some of them survive the turret
fire, is undeniably thrilling stuff. But then
you sit through another terrible cutscene,
babysit your capital ships or do another
run of War Games, the wobbling passes.
This isn't quite the Homeworld 3 we
dreamed of, then. But there are times

where it gets pretty close. -FRASER BROWN Homeworld 3 is busier, with

maps full of debris, terrain,

VERDICT huge structures and asteroids.

Homeworld 3

B BRAVE NEW WORLDS
Intoxicating nostalgia hit;
Brilliant missions; Intriguing space terrain.

B HIGHLY ILLOGICAL Terrible cut scenes;

A bit too complicated; Unsatisfying

new play modes.

TS RECOMMENDED SPECS CPU, Intel i5-9600K
or AMD Ryzen 5 3600X. GPU, Nvidia GTX
1080 TI, AMD RX5700, or Intel ARC A580. ,"
MU IR L This sequel is a notable How you choose to

$59.9 https://www.homeworlduniverse.comj step up on the original approach a fight is more
[games/homeworld3, Rated 10+ s incarnation. important than ever.
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Arc vs Chrome

A new challenger enters the battle of the browsers

THINGS HAVE BEEN relatively quiet in the
world of web browsers for a while, if you
overlook Microsoft's constant pressure
on Windows users to switch to Edge.
The MS browser has greatly improved
since the switch to Google's rendering
engine, Blink, itself a fork of Apple’s older
Webkit engine used in Safari. Microsoft
also has Trident (Internet Explorer] and
EdgeHTML (older versions of Edge),
while Firefox runs on Gecko. There are
others, too.

These engines affect the way websites,
which exist as lines of code and image files
on a server somewhere, are displayed on
your computer. The differences between
them mean they don't always render web
content identically, especially in these
days of embedded content, multiple
coding languages, and plugins that mean
a browser may be pulling information
from many different sources to create the
site you see.

What this means is that despite there
being lots of different browsers, many
of them are running on the same engine,
and may not be as different under the
hood as you expect. While this is good
for consistency, and makes it easier to
create standards-compliant web pages
that will load well in any browser (cross-

JUL 2024

browser testing is an artform in itself), it
does mean that there has been a distinct
lack of innovation in the browser market,
with things like chatbots being the biggest
step forward since online accounts and
syncing of bookmarks across computers.

There’s a new browser on the block,
though: Arc, and it attempts to shake up
the web despite using the same Blink
rendering engine as many of the other big
players. What's different about it, though,
is the way it changes the interface of the
browser, which has remained largely the
same since Windows 95.

ARC

Arc comes from The Browser Company,
a startup founded by former White
House director of product Josh Miller
and software developer Hursh Agrawal.
It differs from other browsers, which
usually have a similar layout with an
address bar at the top of the screen, by
moving things to a sidebar on the left. This
makes a lot of sense on our 16:9 or 16:10
screens, which have more space in the
horizontal plane.

It's easy to install—just download the
installer from[arc.net] run it, and let it do
its thing. Once the app is installed and you
open it up, you'll be prompted to create

an account, which means putting in an
email address and creating a password.
That sadly means signing up to marketing
communications, but theyre easy to
unsubscribe from.

Arc’s use of the Blink engine also
means that all your Chrome plugins are
compatible, and if you choose to transfer
your bookmarks into the new browser,
they’'ll come along, too. Once up and
running, Arc added large buttons in its
sidebar for Gmail and Google Calendar,
bundled all our imported Chrome
bookmarks into a folder, and provided a
folder of tutorials for the browser itself.
Under the bookmarks sit your tabs, each
of which runs in a separate instance of
the browser, meaning Windows' Task
Manager shows a lot of running processes
for the app—we spotted 16 with two tabs
open, using about 650MB of RAM.

If, like us, you've been using browsersin
largely the same way since the days when
modems wailed and screeched to connect
us to the web, doing things another way
can come as a shock. Arc looks different
to Chrome, Edge, and Firefox, butit brings
with it some good ideas that are surely
destined to be absorbed by its rivals.

One of the first that strikes us is the
way you can snhap tabs side by side in a

© THE BROWSER COMPANY
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similar way to app snapping in Windows
11. If you want to change one of those
tabs by typing a web address rather than
following a link, you click on the title bar,
and a pop-up appears into which you type,
which is also how new tabs are dealt with.
It can feel a bit clunky, but makes sense
if your browsing is more mouse-driven.

With bookmark folders driven to the
left-hand bar, there’'s more vertical space
in Arc—you don’t even get the familiar File
or Edit menus, and just small forward,
back, and refresh buttons, so there’s
often more of a web page on the screen at
once, while tiling two side by side makes
text-based pages easier to read.

Elsewhere, there are built-in mini-
apps, Note and Easel, which in the
case of the former, simply let you write
things and share them, while Easel is
a digital whiteboard through which you
can collaborate with others, embedding
videos and even whole web pages into
your creations.

CHROME

Old favorite Chrome has 65 percent of
the desktop browser market, and comes
backed by a web store that hosts over
123,000 extensions and another 30,000
themes. It may be a traditional browser
that can trace its Ul back to the beginning
of Internet Explorer and beyond, but it's
highly customizable and runs extremely
smoothly. The way it works with Google
services such as Gmail and Drive is a
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boon for those who like to work in the
web apps.

Chrome’s reputation as a RAM hog is
fading, as Google added a memory saver
option back in 2023 that puts tabs to sleep
when theyre not being used—hovering
your pointer over the inactive tab tells you
how much has been saved. Edge does a
similar thing, but you'll still see memory
gobbled up in all browsers if you have lots
of resource-hungry tabs open.

Despite strong competition from
Microsoft and Mozilla, Chrome remains
oneofthebestgeneral-purposebrowsers.
It's secure, with a built-in password
manager that will suggest strong
passwords and remember them for you,
syncing them across all the devices you're
signed into with your Google account. It
has other tricks, too, such as advising you
if your passwords are likely to have been
compromised in a data breach, the reader
mode that strips a page of distractions so
you can concentrate on the text, or tab
management features that allow you to
pin, close, reopen and remember whole
windows’ worth that can be reopened
from the History listing after you've
closed them.

What it lacks are features such as Arc’s
sidebar or Edge’s vertical tab layout—
Chrome keeps things very traditional,
with the tabs and address bar at the top—
but for those who like to keep a lot open at
once, there’s a drop-down menu that lists
your tabs and allows you to search them.

Chrome remains the most popular
browser thanks to its ease of use and
reputation for speed and security, and
the fact it's the de facto browser on a lot
of mobile devices probably doesn’t hurt,
either. Despite Microsoft baking begging
messages into Windows to try out Edge,
Chrome is one of the first things many
new PC owners install.

Switching browsers is a bit like moving
house—you sometimes have to do it,
but you'd rather not, and it can take a
lot of time and effort, so it's no wonder
many users stay with Chrome or Edge.
Trying something new, however, costs
you nothing, and with Arc, we may have
seen a little glimpse of the future of
web browsing. -IAN EVENDEN

VERDICT Arc

8 B CHORD Exciting new kid on the
block; Bursting with new ideas.

B TANGENT Inertia may work against it; Yet
to prove itself regarding security.

Free [arc.net

Google Chrome

E2 CHROMIUM Incredibly popular;
Fast; Secure and easy to use.

B 0DIUM Complicated; Starting to look
left behind.
Free /[google.com/chrome]
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Comments | vou write, we respond

Gaming for $1,000

I really enjoyed your $800
Gaming PC cover feature in
the June 2024 issue. While
| wasn’t surprised to see
that a PC without a GPU
wasn’t great for playing
games, it did get me
thinking about what | might
be able to build myself on
the budget end of things.
I’'m about to start my first
year of college, and | think
| can just about convince
my parents to give me the
money to build a PC if |

can keep it under $1,000!
What can | reasonably
expect in terms of gaming
performance for that
money, and what are the
key components | should be
looking at? -B. Duggan

EDITOR-IN-CHIEF,

GUY COCKER, RESPONDS:
Thanks for the feedback on
last issue’s cover build—
while we are '‘Maximum
PC’, we do try to keep
things balanced with a
few value builds per year.
When AMD’s 8600G CPU
arrived promising basic
gaming performance
without the need for a
GPU, we were intrigued,
to say the least. However,
as you remark, its real-
world gaming frame rates

| Nsubmit your questions to:
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WE TACKLE TOUGH READER QUESTIONS ON...

> Budget gaming

> Stealthy office builds
> Modern benchmarking

were passable at best in
the major titles we use for
benchmarking. It really
shouldn’t be thought of as a
GPU replacement—rather
something you can use

to play casual or eSports
titles now and again, if for
some reason you can’t have
a dedicated graphics card
in your system.

The good news is that
it's very possible to meet
your request and build
agaming PC on a $1,000
budget. This would also
be a system capable of
running modern titles at
playable frame rates—
even graphically intensive
ones like Cyberpunk 2077.
You can obviously look at
the alternative builds Zak
featured in last month’s
cover feature, as well as
the blueprints he compiles
at the back of each issue.
The key component for
you to look at is obviously
the GPU. Zak recommends
you look at an Intel Arc
A750 ($200), AMD RX
7600 ($260), or RX 7600XT
($330) at this budget, and
just this week, I've seen the
RTX 4060 Ti hit around the
$300 mark, so | would add
that to your list.

From there, I'd suggest
looking at the components

from his cover build last
issue, particularly the
Phanteks XT Pro case
($50). | have a slight
preference for Intel CPUs
at the moment, given how
cheaply you could then
pair it with a Z690 or Z790
motherboard—the Intel
Core i5-14400F is $200,
a mobo the same price or
less, plus you can choose
between DDR4 or DDR5
memory. Get a decent air
cooler (no more than $50),
power supply like
the models Zak suggests
($60), and SSD storage
($70-100, depending on
capacity) and you should
just about come under
that $1,000 sweet spot.

The caveat here is that
with these components,
you shouldn’t expect to be
gaming at 4K—I'd suggest
either a 1080p or 1440p
monitor, but the good news
is that there are plenty of
decent screens that don’t
break the bank. Again, the
Nvidia GPU option might
help you here thanks to
its upscaling tech. And
of course, don’t forget
to budget in a keyboard,
mouse, and maybe even a
gamepad, too.

If you want more
discussion of the current

state of the budget market,
be sure to watch Zak and |
discuss it in our 'Story of
the Build' video, a link to
which you can find on page
17 of last issue.

Oh, and good luck in your
studies!

Dark future
| don’t know about you,
but I've gotten weary of
the whole RGB thing. It's
actually quite difficult
to find case fans that
possess both good cooling
performance and good
lighting performance.

| wonder what you think
of the idea of doing a
compact ATX workstation
build (not HTPC build,
but mini ATX for ease of
build and maintenance)
that is high-powered for
standard needs, but is
dark, and maybe even
skips the tempered glass
for a closed side panel,
going old school? I've been
thinking that this may well
be my next build if  don’t go
with a laptop and docking
station. -R. Matlow

EDITOR-IN-CHIEF,

GUY COCKER, RESPONDS:
Thanks for another build
request—I always love
hearing what sort of

editor@maximumpc.com
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machines you want to see
us turn our hand to next.

I'm slightly confused by
the first paragraph in your
email—it sounds like the
fans you're buying at the
moment are indeed RGB,
but neither the lighting
nor performance are up
to scratch. From personal
experience, the fans
I've used from NZXT and
Corsair have offered both
good airflow and lighting,
although they’'re not cheap.

On the other hand, if you
want great fans, but
without the lighting, I'd
personally be looking at
those from Noctua. They're
famous for their brown-
colored products, but you
can get nearly everything
in their chromax black
colorway, if you prefer a
stealthier look.

In terms of the compact
ATX workstation, | think
this is a great theme for an
upcoming build. | also think
a compact size is a good
idea, as if it's for an office,
no one wants something
that's going to completely
take over what might be a
small amount of space. |
love NZXT’s H1 case (which
| builtin for the August
2022 cover feature), but
| suspect that’s maybe a
little small—I found it quite
fiddly, so it might not tick
your boxes there, although
it did have a large 3070Ti
GPU in there.

NZXT’s H5 Flow might
be a better choice, as it’s
a compact mid-tower that
comes with a quiet non-
RGB fan, and is available in
black, as you’'ve specified.
It's also pretty good value
at $95.

Of all your requests,
the most difficult is the
case that doesn’t feature
a tempered glass panel!
You're definitely going
against the current fashion
in PC case design there.

I'd suggest looking at the
Fractal North case, which

Non-glass side panels are hard
to find, but the Fractal North
comes with a mesh option.

can be specified with a
mesh panelinstead, or
the Corsair 2000D Airflow
Mini-ITX, although the
latter might be too small
for your needs. If you find
anything suitable, be sure
to let us know!

Make my PC sweat

| recently received a

bonus at work, and decided
to spend it on that high-end
gaming PC I've always
wanted. It boasts an Intel
Core i9-14900K

and an Nvidia RTX 4090,

so it's as advanced as it
gets right now.

However, I've been out
of the PC gaming world
for a few years, and I'm
interested in what titles
the Maximum PC team
uses to push their
machines hard. Of course,
| see the games you use
for benchmarking, like
Cyberpunk 2077, Metro
Exodus, and Total War:
Warhammer I, but
they're all a couple of
years old now!

Basically, what can | use
from the last year or so to
make my system sweat and
my console-owning friends
green with envy?

-S. Baxter

EDITOR-IN-CHIEF,

GUY COCKER, RESPONDS:
You make a fair point about
our benchmark titles. It
was our July 2022 issue,
when we built three PCs

at three different budgets,
that we last took the
opportunity to overhaul our
benchmarking software.

The truth is, though,
that most of those games
would remain the same
even today. It feels to me
like a truly revolutionary
PC game only comes
around once every few
years or so. I'm sure many
of you remember how
long the original Crysis
remained the leading
benchmark for PC gamers,
with the question of, “Can
it run Crysis?” remaining
relevant for years after its
release.

To me, Cyberpunk 2077
feels like the current
generation’s equivalent—
it’s graphically intensive,
has an incredible visual
style, and thanks to all the
post-release support that
developer CD Projekt Red
has put into it, it's a really
enjoyable game to play
as well.

I think the game that's
been released since we
last updated our test suite
that we'd definitely add
to the list today is Alan
Wake 2. 1t fulfils all the
same criteria | listed for
Cyberpunk above, but it
also has the most absurd
system requirements if
you want to run it at 4K
with high settings and ray
tracing. You'll need an
RTX 4080 or higher, and
even then, you'll need to
enable DLSS to keep things
running smoothly. The
resulting visual spectacle
is a joy to behold, however,
and is probably the best
justification for splashing
the cash on a high-end PC
as you've done.

| also recently played
Senua’s Saga: Hellblade 2
on my personal RTX 4090,
and as our sister title PC
Gamer noted, it's visually
spectacular—the closest
I've seen a playable game
come to recreating those
amazing Unreal Engine 5
tech demos that have been
around for a few years
now. Sadly, as PC Gamer
also notes, as good as the
visuals are, it's narratively
limp. Still, it’s a short
game, and you can play it
on Xbox Game Pass if you
don’t want to pay full price.

Dragon’s Dogma 2 has
also become a popular title
for PC users wanting to
benchmark their systems,
although I've not played
it personally. It got a
positive review in our May
2024 issue though, so it’s
worth playing!

Other than that, my two
personal favorites are Red
Dead Redemption 2 and
Metro Exodus Enhanced
Edition. They're not the
brand new titles you
requested, but they both
look spectacular. Red Dead
features the most beautiful
open world I've ever
experienced, and Metro
comes with all the Nvidia
ray tracing and DLSS
features you want to
try when you get a new
GPU. Enjoy! (1
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WE'RE BEING very aggressive with our budget builds this issue.
There have been a number of tweaks and changes to really try
and make the most out of the budget we have, and see if we can’t
drop the price to sub-$900 without compromising too heavily on
performance while we do it.

AMD INGREDIENTS

a part-by-part guide to building a better pc

THIS MONTH'S STREET PRICES...

Our AMD build had a few subtle changes in price, with
last month’s spec dropping by $2. Still, we've swapped the
motherboard for the ASRock B650 PG Lightning to save even
more. It's still a full-fat ATX board, with suitable power solutions,
plenty of connectivity, and decent memory support, too.

Also, after seeing how aggressively prices have fallen on the
DDR front, we've upgraded to a 32GB kit of DDR5 as our minimum
budget spec moving forward. Admittedly, 5600 C46 isn’t the best
specout there, butit's $12 extra for double the capacity. The final
tweak comes in the form of our secondary 1TB PCle SSD, where
we've gone for the Crucial P3 SSD, as it’s slightly cheaper (by $4)
than the MSI Spatium from last issue.

You might also be tempted by AMD’s latest 8400F chip. Six
cores, 12 threads, no iGPU, and a full PCle complement sounds
tempting, but clock speeds are lower, and the cache has been
halved compared to the 7600.

As for Intel, the memory bump pushed our price up by around
$20, and the RX 7600 is still more costly than the A750, so we've
dropped down to the cheapest B760 board we could find. PCle
support is solid (with 4.0 as standard), but you only get two DDR5
slots, and I/0 is a bit slim, so you might need a USB hub.

You could also swap the 14400F for something like the 12400F
for a $76 saving, or even grab a 12600K for $175 instead. Of
course, the biggest saving would be to swap out the chassis for
something like Phanteks’ XT Pro (reviewed on[page 87), which
would save you another $45 on each of these builds.

INTEL INGREDIENTS

' PRICE

PART PART PRICE
Case Corsair 4000D Airflow $95 Case ,I Corsair 4000D Airflow $95
PSU i 600W Thermaltake Toughpower i PSU © 600W Thermaltake Toughpower

! GX2 80+ Gold $60 GX2 80+ Gold $60
Mobo ASRock B650 PG Lightning ATXAM5 NEW $150 Mobo - ASRock B760M-HDV/M.2 Micro-ATX NEW $95
CPU AMD Ryzen 5 7600 $189 CPU Intel Core i5-14400F NEW $200
GPU ASRock Challenger D Arc A750 8GB $200 GPU 1 ASRock Challenger OC RX 7600 8GB $260
RAM 32GB (2x16GB) TeamGroup T-Create RAM J 32GB (2x16GB]) Silicon Power

! Classic [@ 5600 C4é NEW | $84 DDR5 @ 5600 C46 NEW @ $76
SSD 1 512GB ADATA Legend 840 PCle 4.0 M.2 I $45 SSD 1 512GB ADATA Legend 840 PCle 4.0 M.2 : $45
ssD2 i 1TBCrucial P3PCle 3.0 M.2 NEW © $61 SSD 2 1TB Crucial P3 PCle 3.0 M.2 NEW | $61
0S Windows 10 Home 64-bit OEM | 0sS 4 Windows 10 Home 64-bit OEM

¢ (Windows 11 Compatible] | $32 : | $32

Approximate Price: $916
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i [Windows 11 Compatible)

Approximate Price: $924
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TAKETLT FROM A GEEK™

BOUNCING PRICES are wreaking havoc with our mid-range builds.
Just take a look at our AMD build, with the componentry we had
lastissue. The GPU went up by $40, the RAM by $35, and the SSD
by $10. The price drops were $3-5 at most. That’s frustrating,
which is why we've gone aggressive on the parts swap this time.

AMD INGREDIENTS

For our AMD rig, we've swapped to a new GPU, the best-value
RX 7800 XT we could get in the form of the Asus Dual OC. That
alone shaves $20 off last month’s price.

We couldn't skimp on memory, particularly as our
requirements for the mid-range are a minimum of 6,000 MT/s
and a decent CAS latency. Still, for only $15 extra, we managed
to hit that frequency and tighten up the CAS to C30, versus last
month’s 34 (it's still $20 cheaper than the Vengeance kit). Lastly,
our SSDs also got a revamp, swapping out to the Lexar NM790
(which you can read about more on [page 78, and the Patriot
P400 Lite as our back-up 2TB drive. The heatsink variant for the
NM790is cheaper than the non-heatsink version, so grab it while
you can. All that has helped us shave $36 off the AMD build.

Our Intel build has also been hit hard. We didn’t feel that it was
right to have the same CPU in both budget and mid-range builds,
so have gone for the 14600K with its higher clocks and more
cores. That bumps up the price by $95, so to offset that we've
dropped the motherboard down to the Z790-S, and switched out
the GPU to a PNY Verto edition, saving $35 here. The build is $46
more than last month’s, but that's only $5 a thread, and you get
tighter memory timings.

Right now, that H7 Flow is incredible value, and a bit of a
beauty for a build like this. There are a number of cheaper
options, but you give up a bit of build quality, so we’ll stick with
the H7, although the Hyte Y40 is also a nice alternative if you're
looking for something a little more bespoke.

INTEL INGREDIENTS

: PRICE

i PRICE

PART PART
Case  NZXTH7Flow : $97 Case  NZXTH7 Flow L g97
PSU . 850W Thermaltake Toughpower PSU | 850W Thermaltake Toughpower

: GF12024 80+ Gold : $95 : GF12024 80+ Gold : $95
Mobo | Gigabyte X670 Gaming X AX V2 - AM5 ! $205 Mobo | MSIZ790-S Wifi ATX NEW | $170
CPU AMD Ryzen 7 7700 i $277 CPU | Intel Core i5-14600K NEW | $306
Cooler | Noctua NH-D12L Chromax.Black NEW $100 Cooler { Enermax Ligmax I11 360 ARGB $80

1 2 1 =2
GPU i Asus Dual OC Radeon RX 7800 XT NEW $460 GPU i ZPNY Verto OC RTX 4070 Super NEW $565
RAM | 32GB (2x16GB) Silicon Power Xpower RAM  32GB (2x16GB) Silicon Power Xpower [

Zenith Gaming @ 6000 C30 NEW $95 i Zenith Gaming @ 6000 C30 NEW ; $95
SSD1 1TB Lexar NM790 w/Heatsink f SSD 1 1TB Lexar NM790 w/Heatsink

i M.2PCle 4.0SSD NEW $85 i M.2PCle 4.0SSD NEW : $85
ssD2 | 2TB Patriot P400 Lite ssD2 | 2TB Patriot P40 Lite }

| M.2PCle 4.0SSD NEW $105 : M.2 PCle 4.0 SSD NEW : $105
0s © Windows 10 Home 64-bit OEM i 0s © Windows 10 Home 64-bit OEM

(Windows 11 Compatible) i $32 © (Windows 11 Compatible) i $32

Approximate Price: $1,551 Approximate Price: $1,630
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IT'S S0 CRAZY how different the marketplaces are depending on
your budget. If you take a look at our mid-range and entry-level
builds, it's so aggressively priced, and there are these huge
pricing swings—it's hard to keep up. Yet, if you have $3,000,
there’'s a constant deluge of deals, savings, and price drops.
There’s depreciation occurring on all the hardware.

AMD INGREDIENTS

Take our AMD build in this issue. The CPU received a $50 price
drop, and the GPU we swapped out to the same model of graphics
card from a different partner (complete with insane cooling
and RGB), saving $130. Then there’s the Intel build, where we
changed very little. The SSD was $10 cheaper, the CPU $20, the
GPU $30, and the cooler fell by $10. It was a constant stream of
deals and offers that added up to some big savings. For instance,
our AMD build, with an identical spec, dropped in price compared
to last issue by $179. Our Intel build, even with one slight tweak
to the PSU and SSD, dropped by $90. That’s close to 10 percent of
the budget we have for the entry-level builds.

The biggest shuffle came in the form of the power supply,
as that had a price increase of around $30 (pretty much every
1200W PSU and above seems to be at the $180 mark), so we
switched that for its 1000W cousin instead. You still get that 80+
Platinum efficiency rating, and it's still enough for both builds,
with the AMD build topping out at around 685W and the Intel
hitting around 720W, so you'll be more than comfortable.

There is one caveat—as we write this, Computex is occurring,
and there are rumors of Nvidia launching a new barrage of GPUs,
and AMD with a set of 9000 series CPUs. If the former does
decide to leverage the might of the 172VHPWR600 connector, we
could finally see 5000 series cards with a 600W TDP. That would
boost power requirements if you do want to upgrade in future.

On that note, you may be better off holding fire for a moment.
If the big three do launch new platforms and processors, we’ll
see a deluge of performance boosts, and older part deals land
with us around September or just before it, which will be an ideal
time for any budding system builder looking to revamp their rig.

INTEL INGREDIENTS

PART | * PRICE

PART © PRICE

Case Phanteks Enthoo Pro 2 Tempered Glass i $150 Case Phanteks Enthoo Pro 2 Tempered Glass $150
PSU | Super Flower Leadex Platinum . PSU . Super Flower Leadex Platinum SE

i SE 1000W - 80+ Platinum NEW | $140 . 1000W - 80+ Platinum NEW = $140
Mobo | Asus Prime X670E Pro WiFi - AM5 L1 $300 Mobo | Gigabyte Z790 Aorus Elite AX-W ATX | $366
CPU ' AMD Ryzen 9 7950X | $500 CPU Intel Core i9-14900KF $512
Cooler & Asus ROG Ryua Il 36D ARGE 360mm Al 15190 Cooler : Phanteks Glacier One 360D30 360mm A0 | §170
GPU | ASRock Phantom Gaming OC Radeon j GPU - PNY Verto Overclocked RTX 4080 Super 16GB | $970

i RX 7900 XTX 24GB NEW | $900 ;

1 RAM | .Skill Ripj :
RAM | 64GB (2x326B) TeamGroup T-Create ; } 4868 [2x 2468) .Skl Ripjaws e

| Expert@6000 C34 £ $185 _
ssD1 | 2TB Crucial T700 PCle 5.0 M.2 NEW | $240 SSDIRN H2TBIChUEitTIONRCISSOINE2 NEW | $240
$SD2  © 2TB Crucial T500 PCle 4.0 M.2 L $139 $SD2  : 2TB Crucial TS00 PCle 4.0 M.2 $139
0s Windows 10 Home 64-bit OEM i 0s Windows 10 Home 64-bit OEM

; (Windows 11 Compatible) L $32 (Windows 11 Compatible) $32

Approximate Price: $2,776

Maximum PC (ISSN 1522-4279) is published 13 times a year,
monthly plus a Holiday issue following the December issue, by
Future US LLC, 130 West 42nd Street, 7th Floor, New York, NY
10036. USA. Websitf;_www.futureus.com] Future US LLC also

publishes Mac/Life, and PC Gamer. Entire contents copyright
2023, Future US LLC. All rights reserved. Reproduction in
whole or in part is prohibited. Future US LLC. is not affiliated
with the companies or products covered in Maximum PC.

Approximate Price: $2,869

Reproduction on the Internet of the articles and pictures in
this magazine is illegal without the prior written consent of
Maximum PC. Products named in the pages of Maximum PC are
trademarks of their respective companies.

PRODUCED IN THE UNITED STATES OF AMERICA.

JUL 2024



http://www.futureus.com

UNEARTH THE FULL STORY
BEHIND THE LEGEND OF ZELDA

Explore every game in the series and what makes each one so great. If you're a fan, you'll
enjoy the trip throughn time. If you're a newcomer, we offer you this sage advice: "It's
dangerous to go alone, take this!"
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We build the world's most advanced PCs.

Experience a new level of performance with an award-winning Digital Storm PC.
Built with the latest technology, highest quality components and backed by lifetime
support. Visit our website and build your dream PC today.

f; DIGITALSTORM LEARN MORE: WWW.UiGITALSTI['.‘IRhT'I: CDM

Digital Ytorm PLs featuring Intel® Core BrocEss

9000




